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Chapter 1.About this Guide

This chapter contains the following topics:
Objectives
Audience
How to Use This Manual
Document Conventions
MapuSoft Technologies and Related Documentation
Requesting Support

Documentation Feedback
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Objectives

This manual describes about AppCOE IDE and offers information on porting your
application to different toolsets and platforms, and information on how to use our
functionality and learn our user interface (Ul). AppCOE provides a multiple OS interface
host environment with provisions to generate optimized code for a wide variety of target OS
platforms.

Topics in this manual also apply to the other MapuSoft’s interfaces supported by OS
Changer which allows you to re-use a wide variety of legacy code such as VxWorks, pSOS,
Nucleus PLUS, POSIX/LINUX, Windows, ulTRON, ThreadX.

Audience

This manual is designed for anyone who wants to port applications to different operating
systems, create projects, and run applications. This manual is intended for the following
audiences:

e Customers with technical knowledge and experience with the Embedded Systems
e Application developers who want to migrate their application to different RTOSs
e Managers who want to minimize the cost and leverage on their existing code

How to Use This Manual

This manual and the other MapuSoft Technologies manuals explain how to port and
migrate applications to different operating systems.

The organization of this document is as described below:

Using these documents, you can
o Develop & Port legacy applications.
e Generate code optimization & target code generation.
e Generate Full Library Package OS Abstractor/OS Changer Packages
e Enable Application profiling and platform profiling
e Convert Ada 83/95 applications to C/C++
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Document Conventions

Table 1_1 defines the notice icons used in this manual.

Table 1 1: Notice Icons

Icon Meaning Description
O Informational note Indicates important features
or icons.
& Caution Indicates a situation that
might result in loss of data or
software damage.

Table 1_2defines the Text and Syntax conventions used in this manual.

Table 1_2: Text and Syntax Conventions

Convention Description

Courier New Identifies Program listings and
Program examples.

Italic text like this Introduces important new terms.

o |dentifies book names

o |dentifies Internet draft titles.
COURIER NEW,ALL CAPS Identifies File names.

Courier New, Bold Identifies Interactive Command lines




\ \‘ F
. = S@ FTApplication Common Operating Environment User Manual

MapuSoft Technologies and Related Documentation

Reference manuals can be provided under NDA. Click http://mapusoft.com/contact/to
request for a reference manual. The document description table lists MapuSoft Technologies

manuals.

Table 1_3: Document Description Table

User Guides

Description

System Configuration Guide

Provides detailed description on the system

configuration to work with MapuSoft products. This

guide:

e Describes the system requirements and
configurations to get started with MapuSoft
Technologies products

AppCOE Quick Start Guide

Provides detailed description on how to become familiar
with AppCOE product and use it with ease. This guide:

e Explains how to quickly set-up AppCOE on
Windows/Linux Host and run the demos that came
along AppCOE

OS Abstractor Interface

Reference Manual

Provides detailed description of how to use OS

Abstraction. This guide:

e Explains how to develop code independent of the
underlying OS

e Explains how to make your software easily support
multiple OS platforms

VxWorks Interface Reference
Manual

Provides detailed description of how to get started

with VxWorks interface support that MapuSoft

provides. This guide:

e Explains how to use VxWorks
applications

interface, port

POSIX Interface Reference
manual

Provides detailed description of how to get started

with POSIX interface support that MapuSoft provides.

This guide:

e Explains how to use
applications

POSIX interface, port

Reference Manual

pSOS Interface Reference | Provides detailed description of how to get started
Manual with pSOS interface support that MapuSoft provides.
This guide:
e Explains how to wuse pSOS interface, port
applications
pSOS Classic  Interface | Provides detailed description of how to get started

with pSOS Classic interface support that MapuSoft

provides. This guide

e Explains how to use pSOS Classic interface, port
applications

Nucleus Interface Reference
Manual

Provides detailed description of how to get started

with Nucleus interface support that MapuSoft
provides. This guide:
e Explains how to wuse Nucleus interface, port

applications

Micro-ITRON
Reference Manual

Interface

Provides detailed description of how to get started

with ulTRON interface support that MapuSoft
provides. This guide:
e Explains how to wuse ulTRON interface, port

applications

14
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User Guides

Description

ThreadX Interface Reference

Provides detailed description of how to get started

Manual with ThreadX interface support that MapuSoft
provides. This guide:
Explains how to wuse ThreadX interface, port
applications

uC/0S Interference
Reference Manual

Provides detailed description of how to get started

with uC/OS interface support that MapuSoft provides.

This guide:

e Explains how
applications

to use uC/OS interface, port

FreeRTOS Interference
Reference Manual

Provides detailed description of how to get started

with FreeRTOS interface support that MapuSoft

provides. This guide:

e Explains how to use FreeRTOS
applications

interface, port

Windows Interface Reference
Manual

Provides detailed description of how to get started

with Windows interface support that MapuSoft

provides. This guide:

e Explains how to use Windows
applications

interface, port

RTLinux Interface Reference
Manual

Provides detailed description of how to get started with

RTLinux interface support that MapuSoft provides.

This guide:

e Explains how to use RTLinux
applications

interface, port

VRTX Interface Reference | Provides detailed description of how to get started with
Manual VRTX interface support that MapuSoft provides. This
guide:
e Explains how to wuse VRTX interface, port
applications
QONX Interface Reference | Provides detailed description of how to get started with
Manual QNX interface support that MapuSoft provides. This
guide:
e Explains how to wuse QNX interface, port
applications

Release Notes

Provides the updated release information about

MapuSoft Technologies new products and features for

the latest release.

This document:

e Gives detailed information of the new products

e Gives detailed information of the new features added
into this release and their limitations, if required

15
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Requesting Support

Technical support is available through the MapuSoft Technologies Support Centre. If you
are a customer with an active MapuSoft support contract, or covered under warranty, and
need post sales technical support, you can access our tools and resources online or open a
conversation/ticket at http:/ /www.mapusoft.com/support

Anyone can initially contact sales/admin/tech via the above mechanism, however tech
support is offered to only registered users or evaluation customers.

Registering a New Account

If you are a customer with valid tech support contract or a trial user, please request an
account be created by providing your email address, company address, telephone number
etc by contacting sales@mapusoft.com. You will be provided via account name (your email)
and also password to sign-in

Submitting a Ticket

1. To submit a ticket, simple sign-in into your account
http://www.mapusoft.com/supportand open a conversation.

2. To submit a ticket from within AppCOE IDE

From AppCOE main menu, Select Help > Create a Support Ticket as shown in below Figure

Figure 1_1: Create a Support Ticket from AppCOE

File Edit Source Refactor Navigate Search Project Tools Run Window
- B BB S 45 Help Contents & | [ Projects )
5 | semects =
TR C/C+ Projects 52 =0 % D“" . a
ynamic Help
EE
I3 demo_cross_os Key Assist.. Crl+Shift+L
I demo_freerttos Tips and Tricks...
T2 demo_nucleus Cheat Sheets.
I demo_posic
P> demo_psos Create A Support Ticket
T2 demo_threadx Check for Updates
Install New Software..
I demo_vworks About Application Commen Operating Environment (AppCOE)
= Problems | Bl Console 5% | =1 Properties ol ~f>=08
To submit a ticket, simple sign-in into your account

http://www.mapusoft.com/supportand open a conversation.

MapuSoft Support personnel will get back to you within 48 hours with a valid response.

U

SLDFT
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Live Support

Chat: MapuSoft Technologies also provides technical support through Live Chat from
www.mapusoft.com website. If Chat is offline, please leave a detailed message including
your email address, telephone number and company name so that MapuSoft personnel's
can quickly respond to either responding to your chat by calling you on the number that
you have provided

Telephone: You can also reach us at our toll free number: 1-877-627-8763 and press
the tech support option to contact MapuSoft tech support team for any urgent
assistance.

Documentation Feedback

We greatly appreciate your feedback. Simple sign-in or just start a conversation and let us
know via:http:/ /www.mapusoft.com/support/



http://www.mapusoft.com/support/

PATAE N S@ F.I:Application Common Operating Environment User Manual

Chapter 2.Introduction to AppCOE

This chapter contains the following topics:

About AppCOE

Installing AppCOE
Uninstalling AppCOE
Supported Host Platforms
Getting a License for AppCOE
Installing License for AppCOE
Updating APPCOE
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About AppCOE

AppCOE is an Eclipse based IDE. AppCOE integrates software interoperability & reuse tools
like OS Changer and OS Abstractor with Eclipse’s CDT to offer an IDE for developing and
porting embedded applications on many host/target platforms.

With AppCOE you can perform the following actions:

Creation of C and C++ AppCOE projects

Porting of legacy applications

Host development with simulation for many OS applications
Converting Ada source code to C/C++ code

Platform and Application profiling

Automatic configuration of any OS Changer and OS Abstractor APIs needed by the
application

Custom configuration of OS& OS Abstractor resources needed by the application

Custom configuration of OS Abstractor for single or multi-application development
(Process Feature support)

Optimized source code generation
Full Source Library Package generation

Contact MapuSoft to receive the components needed for using AppCOE. The steps for using
AppCOE are comprehensively described in the following pages.

19
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Installing AppCOE

You can download an evaluation copy from our website or install AppCOE via the
evaluation CD given by MapuSoft Technologies.
To install AppCOE:
1. Click on the exe or tar file from CD/download and run it. A welcome html page will
be auto run
2. SelectHost
ForWindows Host,
1. For Ada-C/C++ Changer™Product, download appcoe_x32.exe or
appcoe_x64.exeinto the local drive
2. For OS Changer® Porting Kit, Cross-OS Development Platform™, Cross-OS
Hypervisor™, Linux OK™, OS Simulator™, App/Platform Profiler™, OS Version
UpKit™products, download either appcoe_x32.exe or
appcoe_x64.exedepending on the host machine CPU architecture
3. Installer will ask for a directory to install AppCOE release. Browse to the
directory or provide a directory name when prompted
4. Once AppCOE is installed, reboot the system. AppCOE will not run properly
without re-boot
S. Now, Run the AppCOE.exe in AppCOE <installdir> or launch the AppCOE
application from the windows shortcut in desktop

For Linux Host,

1. For Ada-C/C++ Changer™Product, download app-coe-linux_x32.tar.gz into the
local drive

2. For OS Changer® Porting Kit, Cross-OS Development Platform™, Cross-OS
Hypervisor™, Linux OK™ OS Simulator™, App/Platform Profiler™, OS Version
UpKit™products, download either app-coe-linux x32.tar.gz or app-coe-
linux x64.tar.gzdepending on the host machine CPU architecture

3. Extract the tar file app-coe-linux _x32.tar.gz or app-coe-linux_x64.tar.gz. You
will get install.sh&app-coe-linux.bin

4. Run the install.sh program, it will check for dependency needed for installing
AppCOE, Install the missing dependencies and try running this script again, If
no dependencies is found, AppCOE installer will start

S. Installer will ask for a directory to install AppCOE release, Browse to the
directory <installdir> or provide a directory name when prompted (ensure that
the logged-in user has full read/write/execute privileges to in this install
directory)

6. After AppCOE gets installed, install.sh will check for AppCOE dependencies.

Install the missing dependencies if any

Then run app-coe-linux.bin to launch theAppCOE installer.

8. Repeat steps 2-4 as in the Linux host

NOTE:

For Windows Host:

By default, it is c:\MapuSoft\AppCOE.
For Linux Host:

By default path is /usr/local/AppCOE

Do not provide special characters to the <installdir> as you will get java run-time
errors.AppCOE may have problems with paths containing spaces, and if not, usually other
programs used with AppCOE will experience problems with such paths.

U SQ‘ FT 20
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Uninstalling AppCOE

To uninstall AppCOE:

1. Browse to the installed AppCOE directory and start the Uninstall application.

2. For Windows only,you can also uninstall AppCOE by selecting Control Panel>
Add/Remove Programs. Select AppCOE and click Remove.

3. There is a possibility of user generated/modified files to be left on your AppCOE
installation directory. If not necessary, delete the files manually to remove the files.

Supported Host Platforms

AppCOE supports the following host platforms:
e Windows XP/7 /8

e Linux
Supported Development APIs:

e Cross-OS: OS Abstractor* Interface
*supports Windows 2000, Windows XP®, Windows CE, Windows Vista, Android,
Linux, MQX®, NetBSD, Nucleus PLUS®, QNX, Solaris, ThreadX®, uCOS, micro-ITRON,
VxWorks®, ecos , T-Kernel® , LynxOS® , LynxOS , QNX ,UCOS® target operating
systems.

e Cross-0OS: OS Abstractor POSIX/LINUX Interface

e Cross-OS: OS Abstractor UITRON Interface

¢ OS Changer: Nucleus Interface

e OS Changer: pSOS Interface (1.5 Revision& 2.x Revision)

e OS Changer: ThreadX Interface

e OS Changer: VxWorks Interface

e OS Changer: Windows Interface

e OS Changer: uC/OS Interface

e OS Changer: FreeRTOS Interface

For a list of AppCOE supported target operating systems, click here: www.mapusoft.com/

Getting a License for AppCOE

AppCOE is licensed by the following host and target licenses. A 30-day advanced evaluation
license is available for the host licenses. Click www.mapusoft.com/downloads/ to request
an evaluation license.

\PU S@ FT 2l
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Installing License for AppCOE

MapuSoft provides a license key to the customers. Once the customers provide the Mac
Address of their system, MapuSoft Technologies provides a License key for that particular
system. This establishes security for the license.

To install the license:

1. Save the license file given to you by MapuSoft.
2. On AppCOE main menu, click the down arrow next to Key button and select Install
License as shown inFigure 2_1.

Figure 2_1: Importing License
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3. Browse to the location of the saved license file,click Open as shown in Figure 2_2.
The license key is installed and now you can work on AppCOE.

Figure 2_2: Selecting the Saved License File

r =]
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Look e | £ license v QFi*@
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My Documents
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My Network  Files of type: "lic v

MAPUSLHFT
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Updating APPCOE

Getting Updates for AppCOE

NOTE: This feature requires AppCOE Host License.
Clickhttp: / /www.mapusoft.com/contact/ to send a request to receive licenses and
documentation.

You can get latest AppCOE updates from http://www.mapusoft.com using the following two
options:
e Remote Update: By using Remote Update Site, the system will automatically contact
http:/ /www.mapusoft.com/ website and search for the latest updates. You need
internet connectivity for this to work

e Local Update: By using Local Update Site, you can do AppCOE updates without
connecting to the Internet. For this to work, you need to get the updated files from
http:/ /www.mapusoft.com/ by e-mail or CD

24
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To update software using Remote update site:

Application Common Operating Environment User Manual

1. From AppCOE main menu, select Help >Check for Updates as shown inFigure 2_3.

Figure 2_3: Software Updates Using Remote Site
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2. Check the Available Updates that you wish to install as shown in Figure2_ 4.

Figure2_ 4: Check the Available Updates
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3. Contacting Software Sites for Updates as shown in Figure 2_5.
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Figure 2_5: Contacting Software Sites for Updates
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4. On Available Updates Search Results window, select the features under the AppCOE
Update Site tree parent and click Next as shown in Figure 2_6.

Figure 2_6: Review and Confirm the Updates

i/ Available Updates

Update Details

Review and confirm the updates. ) ——
o
~
MName ersion 1d
= L(fx‘ .g\pplication Common Operating Environment {(4ppCOE) 1.3.9.201311081714 mapusoft.appcoe
L) AppCOE Host Target Feature 1.3.9.1 mapusoft.appcoe.host_target.feature.feature.group

Size: Unknown

Details

@ [ < Back " Mext > ]
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5. On Review License window, select the radio button next to I accept the terms in

the license agreements and click Finish as shown inFigure 2_7.

Figure 2_7: Remote Update Host Target Feature License

4/ Available Updates ‘;@@

Review Licenses

Licenses must be reviewed and accepted before the software can be installed.

License text {for AppCOE Host Target Feature 1,3.9.1):

e

D

| PLEASE READ CAREFULLY: THE USE OF SOFTWARE 15 SUBJECT TO THE
TERMS AND CONDITIONS THAT FOLLOW, IF YOU AGREE TO THESE TERMS,
PLEASE CONTINUE BY PRESSING "I AGREE",

End User License Agreement

PLEASE READ CAREFULLY BEFORE INSTALLING AMND USING THE SOFTWARE:
This End-User license Agreement {("EULA") is a legal agreement

between you, the end user, as an authorized representative of

the company acquiring the license {"Licensee"), and Mapusoft

Technologies Inc. {"MTI") that governs the use of any MT Software

made available by Mapusoft Technologies Inc., that is not otherwise

subject to a separate physically signed license agreement between

Licensee and Mapusoft Technologies Inc. The term "MT Software"

means computer software and may include associated media, printed
materials and documentation.

RIGHTS IN THE SOFTWARE PRODUCT ARE OFFERED OMLY ON THE CONDITION

()1 accept the terms of the license agreement

(1 do not accept the terms of the license agreement

3\

[ Finish

H Cancel ]

6. During the Updating Software Window, you can view the new plug-ins being

downloaded as shown in Figure 2_8.

Figure 2_8: Remote Updates Download
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il ot L F-O0-Q- - X ol J EY |2 Projects | (2 Profler
& Cic++ Projects 52 =g =0
ER-T

¥ demo_ada_to_c
] demo_cross_os
C demo_nuceus
[ dema_posix
£l demo_pses
L demo_threads
L dema_uitran
L demo_wnorks
L dema_windows

¥ Updating Software

=\ Updating Software

L)

............. )

Downloading mapusoft.appeoe. target

] Ahways run in background

[Runin Background ] [ cancel | [ Detaiks =>
1}/ Problems | B Conscle 5% | = Properties # - = O
Mo consales to display at this time.
Updating Software: (23%) CCm|

7. Security Warning in between the Installation as shown inFigure 2_9.

Figure 2_9: Security Warning

[4
/ Security Warning

» Warning: You are installing software that contains unsigned content. The

« \ authenticity or validity of this software cannot be established. Do you want to
continue with the installation?

[ OK I [ Cancel ] [ Details > ]

8. After press ok,Installation Continue as shown in
9. Figure 2_10.

Figure 2_10: Updating Software
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_/ Projects - Application Comme alm?‘?;m..rg:u-».y-A!uﬁlmm;;{_IEIE]’I
rae B OON-Bs- $-0- Q- 7 - | & [ promas |2 poter
&l CJC++ Projects &2 = fai = 8

[
&5

& AW demo_ada_to_c
] [: demo_cross_os
@ C demo_nucleus
] c dema_posix

@ [: demo_psos

® C demo_threadx
[} C demo_uitron
] c demo_vxworks
+ c demo_windows

4/ Updating Software

Downloading mapusoft.appcoe_root.win32,win32.x86

[] Always run in background

IRun in Background] [ Cancel ] [ Details > }

1% problems | B console 22 | I Properties fE r5-= 08

Mo consoles to display at this time.

Updating Software: (40%) » )&

Once all the features and plug-ins have been downloaded successfully and their files
installed into the product on the local computer, a new configuration that incorporates

these features & plug-ins will be formulated. Click yes when asked to exit and restart the
Workbench for the changes to take effect as shown in

Figure 2 _11. You have now successfully installed new feature updates to your AppCOE
using the Remote Update Site.

Figure 2_11: Restart AppCOE

/ Software Updates

¥ou will need to restart Application Common Operating Environment {AppCOE)
\0/ for the changes to take effect. Would you like to restart now?

Lyes J[ wo ]

10. Check the new features installed correctly from the AppCOE installed directory >
plugins as shown in Figure 2_12.

Figure 2_12: Confirmation of new features installed
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File Edit View Favorites Tools Help

@Back ¥ _') t.? /‘:\Search ﬂ. Folders v @FolderSync
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EEK

i C:\MapuSoft\AppCOE_x32\plugins

;]Gu

A Name -~

File and Folder Tasks 2 |4l mapusoft.appcoe.ada_1.3.9.jar

ﬂ mapusoft.appcoe.core_1.3.9.jar

ﬂ mapusoft.appcoe.generation_1.3.9.jar
ﬂ mapusoft.appcoe.license_1.3.9.jar

®f} Rename this file
[ Move this file

(D) Copy this file | 4] mapusoft.appcoe.profiler_1.3.9.jar
6 Publish this file to the »_-5] mapusoft,appcoe.startup_1.3.9.jar
e L Imapusoft. appcoe. target jar

() E-mail this file | 4] mapusoft.appcoe.target_1.3.9.jar
x Delete this file ﬁnet.sourceforge.lpg.ngjavaruntime_l.1.0.v201004271650.jar
ﬁ org.apache.batik.bridge_1.6.0.v201011041432.jar

ﬁ org.apache.batik.css_1.6.0.v201011041432, jar

ﬂ org.apache.batik.dom.svg_1.6.0,v201011041432.jar

ﬂ org.apache.batik.dom_1.6.0.+201011041432.jar

ﬂ org.apache,batik.ext.awt_1.6,0.v201011041432.jar

ﬂ org.apache.batik.parser_1.6.0.v201011041432.jar

PN

Other Places

I ApPCOE_Winx32_Final_
(£ My Dacuments

[ Shared Dacuments | 4] org.apache.batik.pdf_1.6.0.v201105071520.jar

-) My Computer ﬁ org.apache.batik.svggen_1.6.0.v201011041432.jar
.‘g My Network Places ﬁ org.apache.batik.transcoder_1.6.0.v201011041432.jar
ﬂ org.apache.batik.util.qui_1.6.0.v+201011041432.jar

ﬂ org.apache. batik.util_1.6.0.v201011041432.jar

Details A ﬂ org.apache.batik.xml_1.6.0.v¥201011041432.jar

ﬁ org.apache.commons.codec_1.3.0,v201101211617.jar
mapusoft.appcoe.target_ i ﬂ org.apache.commons. httpclient_3.1.0.v201012070820.jar
Executable Jar File ﬁ org.apache.commons.logging_1.0.4.v201101211617.jar
Date Modified: Today, sl awn. anarhe. Feliv.anan.rammand 0.8.0.9201 103120515, iar
November 08, 2013, 5:30 v <

Size | ¥
147 KB
2,747 KB

460KB
30KB
463 KB
63 KB
34,689 KB
34,689 KB
97 KB
521 KB
260 KB
471 KB
113KB
401 KB
61 KB
S11KB
194 KB
86 KB
161 KB
99 KB
41 KB
54 KB
315KB
45 KB

R7KR =

>

Type: Executable Jar File Date Modified: 11/8/2013 5:30 PM Size: 33.8 MB

33.8 MB

ﬂ My Computer

Updating Software Using Local Update Site

1. From AppCOE main window, select Help >Check for Updates as shown in Figure

2_13.

Figure 2_13: Software Updates Using Local Site
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2. Check the Available Updateswindows that you wish to install and click Next as
shown in Figure 2_1.

Figure 2_14: AppCOE Software Updates

L7 Available Updates

Avwailable Updates

(e
Check the updates that you wish to install. —l
B R
MName Yersion Id
gt Application Common Operating E...  1.3.9.201311081714 mapusoft.appcoe

[ Select all ] [ Deselect all ]

Details

5
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On Updates sites to visit window, select Add and browse for the folder provided by
MapuSoft, named as mapusoft. AppCOE.updatesite and click OK as shown in Figure 2_15.

NOTE: If the system does not allow you to give the same site name, select the previous

updatesite folder from the list and click Remove. Or, you can also save the Updatesite
folder in any other location on your local disk.

Figure 2_15: Installing Updates by Using Local Update Site
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3. On Edit Local Site pop up window, next to Name text box, provide a different name
and click OK. The name can be any name that is not already present on the list as
shown inFigure 2_16.and click OK.

Figure 2_16: Available Software Sites
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/ Preferences

[ Available Software Sites
# General
i Ant
@ C/CH+ type filter text
# Data Management Name Location Enabled
e Al AppCOE _Update_Ste fle:/C:Imapusoft. ADDCOE. updateske/ Enabled
e X"":":":::: e o« hetp:jdowrload. eckpse. org/btjupdate-ske/3.7 Disabled
o odat ‘
mg | ecipse Disabled

A el [HEC prao : [ sec]
# Plug-in Development 8 :g edipse. Disabled
# Report Design . ecipse Drsabled
& RunfDebug 8 j hitp: Ilw‘ems::qlnwwatesl . Disabled
# Team Disabled

Valdatin
@

Name: | AppCOE_Update_Ske
Location: | file:/C:/mapusoft. AppCOE .updatesie/|

? = =)

4. Contacting Software Sites for Updates as shown inFigure 2_17.

Figure 2_17: Contacting Software Sites for Updates

vironment (AppCOE)
re- B OOR-BO- -0~ Q- - SR 4 | & (2 powes | @ poer
@ jc++ Projects 2| = fi]lE BT
¢ B Y

AP demo_ada_to_c
& [CJ demo_cross_os
@ [ dema_nucleus
&[] demo_posix

@ [C] demo_psos

& [C. demo_threadx
@ [ demo_uitron

& [C] demo_vxworks
& [T demo_windows

/ Contacting Software Sites

i ) Checking for updates. ..
f

L

[ Always run in backaround

Run in Background | Cancel Details >>

|12 Problems | & Console 5% | £ Properties 8- 0
Mo consoles to display at this time.

Contacting Software Sites: (50%)  (F2%) @]
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S. On Available Updates Window, select the features under the AppCOE Update
Sitetree parent and click Next as shown in Figure 2_18.

Figure 2_18: Review and confirm the Updates

o Available Updates

Update Details
Review and confirm the updates.

Name Version 1d
= -(I{ Application Common Operating Environment (4ppCOE)  1.3.9.201311081714 mapusoft.appcoe
“J* AppCOE Host Target Feature 1.3.9.1 mapusoft.appcoe.host_target.feature.feature.group

Size: Unknown

Details

@ [ < Back “ Next > I

6. On Available Updates window, select the radio button next to I accept the terms in
the license agreements and click Finish as shown in Figure 2_19.

Figure 2_19: Remote Update Host Target Feature License

4/ Available Updates

Review Licenses

Licenses must be reviewed and accepted before the software can be installed.

License text {for AppCOE Host Target Feature 1,3.9.1):

PLEASE READ CAREFULLY: THE USE OF SOFTWARE IS SUBJECT TO THE
TERMS AND CONDITIONS THAT FOLLOW, IF YOU AGREE TO THESE TERMS,
PLEASE CONTINUE BY PRESSING "I AGREE".

End User License Agreement

PLEASE READ CAREFULLY BEFORE INSTALLING AMND USING THE SOFTWARE:
This End-User license Agreement {"EULA") is a legal agreement

between you, the end user, as an authorized representative of

the company acquiring the license ("Licensee"), and Mapusoft

Technologies Inc. ("MTI") that governs the use of any MT Software

made available by Mapusoft Technologies Inc., that is not otherwise

subject to a separate physically signed license agreement between

Licensee and Mapusoft Technologies Inc. The term "MT Software”

means computer software and may include associated media, printed
materials and documentation,

RIGHTS IN THE SOFTWARE PRODUCT ARE OFFERED OMLY ON THE CONDITION v

i

()1 accept the terms of the license agreement

(1 do not accept the terms of the license agreement

'@ [ Finish ][ Cancel ]

7. During the Updating Software Window, you can view the new plug-ins being
downloaded as shown in Figure 2_20.
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Figure 2_20: Remote Updates Download
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8. Security Warning in between the Installation as shown in Figure 2_21.

Figure 2 21: Security Warning

[4

/' Security Warning

i Warning: You are installing software that contains unsigned content. The

! authenticity or validity of this software cannot be established. Do you want to

continue with the installation?

ok || cancel || Detais>> |

9. Once all the features and plug-ins have been downloaded successfully and their files
installed into the product on the local computer, a new configuration that
incorporates these features and plug-ins will be formulated. Click Yes when asked
to exit and restart the Workbench for the changes to take effect as shown inFigure
2_22.

10. You have now successfully installed new feature updates to your AppCOE using the
Remote Update Site.
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Figure 2_22: Restart AppCOE

./ Software Updates @

You will need to restart Application Common Operating Environment {(AppCOE)
. for the changes to take effect. Would yvou like to restart now?

11. Check the new features installed correctly from the AppCOE installed directory
>plugins as shown Figure 2_23.

Figure 2_23: Confirmation of new features installed

& plugins

File Edit View Favorites Tools Help w
@ Back ~ _) Jf / ) Search h : Folders v ﬁﬁ;‘ Folder Sync
) C:\MapuSoft\AppCOE_x32\plugins v ] Go

& Name - Size | 4
File and Folder Tasks 2 |4l] mapusoft.appcoe.ada_1.3.9.jar 147 KB

EE Rename s File ﬂmapusoft.appcoe.cove_l .?.9.jar ) 2,747 KB El
3 i] mapusoft.appcoe.generation_1.3.9.jar 460 KB
‘-"9 Move:this file ﬁ mapusoft.appcoe.license_1.3.9.jar 30KB
(D) Copy this file ﬂ mapusoft.appcoe.profiler_1,3.9.jar 463 KB
e Publish this file ta the ﬂ mapusoft.appcoe.startup_1.3.9.jar 63 KB
: Wweb | mapusoft. appeoe.target_1 j 34,689 KB
(2) E-mail this file _ﬂ]mapusoft.appcoe.target_l .3.9.jar 34,689 KB
¥ Delete this file ﬁnet.sourceforge.lpg.ngjavaruntime_l.1.0.v201004271650.jar 97 KB
ﬁorg.apache.batik.bridge__l.6.0.v201011041432.jar 521 KB
ﬁ org.apache.batik.css_1.6.0.v201011041432, jar 260 KB
Other Places 2 | /] orq.apache. batik.dom.svg_1.6.0.v201011041432.jar 471 KB
> : 3 il]org‘apache.batik‘dom_l.6.0‘&/20101 1041432.jar 113KB
() APREOE Wini32 Final ﬂorg.apache.batik.ext.awt_l.6.0.v201011041432.jar 401 KB
3 My Dacuments | )| org.apache.batik. 1.6.0.v201011041432.jar 61KB

qg.apache.batik.parser_| % j

[ Shared Dacuments |4 org.apache.batik.pdf_1.6.0.v201105071520.jar 511 KB
:J My Computer ﬁ]org.apache.batik.svggen_l.6.llv20101 1041432, jar 194 KB
‘g My Network Places ﬂ]org.apache.batik.transcoder_l.6.0.v20101 1041432 jar 86 KB
4| org.apache.batik.util.gui_1.6.0.v201011041432.jar 161 KB
ﬂ org.apache.batik.util_1.6.0.v201011041432.jar 99 KB
Details A ﬂorg.apache.batik.xml_l.6.0.v20101 1041432.jar 41 KB
ﬂ org.apache.commons.codec_1.3.0.v201101211617.jar 54 KB
mapusoft.appcoe.target_ N ﬂ org.apache.commons.httpclient_3.1.0.v201012070820.jar 315KB
Executable Jar File ﬂ org.apache.commons.logging_1.0.4.v201101211617.jar 45 KB

Date Modified: Today, il arn.anarhe.Feliv.anan.cammand 0.8.0.4201 103120515, iar c7kp ¥

November 08, 2013, 5:30 V< |
Type: Executable Jar File Date Modified: 11/8/2013 5:30 PM Size: 33.8 MB 33.8 MB j My Computer
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Chapter 3.AppCOE Components

This chapter introduces all the AppCOE components. They are as follows:

Introduction to AppCOE Components
AppCOE Architecture

OS Simulator

OS Changer Porting kit

Cross-OS development Platform
Optimized Target Code Generator
Ada-C/C++ Changer

App/Platform Profiler
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Introduction to AppCOE Components

With Application Common Operating Environment (AppCOE) you can easily port, abstract
and optimize your code on a host machine and run the application on different target
platforms. AppCOE leverages the existing OS Changer and OS Abstractor technologies while
adding advanced code optimization capacities on multiple OS environments. AppCOE
provides users an easy-to-use graphical user interface that is integrated with the Eclipse®
based CDT environment.

AppCOE uses OS Abstractor and OS Changer technology to produce Cross-OS
development platform for manytargets.AppCOE target features include:

e Porting of legacy applications to your new chosen OS (OS Changer Porting Kit)

e Development of embedded applications on Host environment (OS Simulator)

e Convert Ada source code to C/C++ code (Ada-C/C++ Changer)
e Application profiling and platform profiling for your APIs (App/Platform Profiler)

e Generate API Profiling timing report and Profiling Timing comparison report
(App/Platform Profiler)

¢ Cross-OS Development Platform Features that includes:

@)

o

o

Automatic configuration of any OS Changer and OS Abstractor APIs
needed by the application

Custom configuration of OS & OS Abstractor resources needed by the
application

Custom configuration of OS Abstractor for single or multi-application
development (Process Feature support)

Full Source Library Package generation
Generation of project files for your IDE

Generated target code is optimized to contain only the APIs used by the
application

Allows for further optimization by in-lining user selected API’s

Enables to convert Ada source code into C/C++ code

e Target selection and configuration tabs to optimize the target code specific for
your application

@)

@)

@)

Target OS selection

Profiler configuration

Task configuration including a task pooling feature
Process configuration including a process feature
Memory configuration

Resource configuration

Debug configuration

Output configuration including the ability to output to a console or serial
port

ANSI Mapping configuration

Device I/O configuration
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MapuSoft provides an illustration to describe all the components of AppCOE. AppCOE
leverages the existing OS Changer and OS Abstractor technologies while adding advanced
code optimization capacities on multiple OS environments. They are all interlinked and
work closely as shown inFigure 3_1.

Figure 3_1: AppCOE Components
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AppCOE Architecture

Figure 3_2: AppCOE Architecture
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OS Simulator

AppCOE simulates various OS interfaces such as VxWorks, pSOS, POSIX/LINUX, Windows,
ThreadX and Nucleus on host development environments so users can develop embedded
code with preferred OS APIs and without the target hardware. AppCOE’s state-of-the-art
Eclipse based IDE offers seamless integration into existing development flows.

With Application Common Operating Environment (AppCOE) you can easily port, abstract
and optimize your code on a host machine and run the application on different target
platforms. AppCOE leverages the existing OS Changer and OS Abstractor technologies while
adding advanced code optimization capacities on multiple OS environments. AppCOE
provides users an easy-to-use graphical user interface that is integrated with the Eclipse®
based CDT environment. Target operating systems supported can be found here:
http:/ /mapusoft.com/products.

This chapter includes the following topics:
e List of Available OS Simulators
e Host Development Environment
e Creating an AppCOE C/C++ Project
e C Project Template Files
e HOST Defines
¢ Adding Source Code Files to AppCOE C/C++ Project
¢ Building Binary Files for a Project
e Executing Binary Files
e Debugging the Demos Supplied by MapuSoft
e Debugging Using External Console/Terminal
e Inserting Application Code to Run only on Host Environment
e Inserting Application Code to Run only on Specific Target OS Environment
o Updating Project Settings

For more information on the host development refer to OS Simulator.
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OS Changer Porting kit

The OS Changer family of products is COTS porting tools that give users the freedom to
change operating systems while reusing their existing embedded code and knowledge base
to protect their software investment and avoid costly porting issues. OS Changer also allows
developers to write code using a familiar application programming interface (API) and run
the application on a wide variety of supported target OS platforms. Solutions are available
for porting from VxWorks, pSOS, Windows and Nucleus to many different real time (RTOS)
and non-real time operating systems. Target operating systems supported can be found
here: http://mapusoft.com/products/.

OS Changer is designed for use as a C library. Services used inside your application
software are extracted from the OS Abstractor libraries and are combined with the other
application objects to produce the complete image. OS Changer is graphically represented
in the follow as shown in Figure 3_3.

Figure 3_3: OS Changer Porting kit

Your
Application

05 Abstractor
specific to
your 05

S CHANGER

Parting Kit

For more information on the host development refer to OS Changer.
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Cross-OS development Platform

Developing a solid software architecture that can run on multiple operating systems
requires considerable planning, development and testing as well as upfront costs associated
with the purchase of various OS and tools to validate your software. MapuSoft’s OS
Abstractor is an effective and economical software abstraction alternative for your
embedded programming. By using OS Abstractor, your embedded application can run on
many real time (RTOS) and non-real time operating systems to negate any porting issues in
the future when your platform changes. Target operating systems supported can be found
here: http://mapusoft.com/products.

OS Abstractor interface provides you a robust and standard OS interface architecture for
flexible application development and portability while eliminating the risks associated with
selecting an OS and dependency on a single vendor. OS Abstractor makes your application
adapt to multiple operating system platforms with a standard OS interface, thereby
reducing cost associated with code maintenance and learning multiple operating systems.

OS Abstractor is designed for use as a fully scalable C library. Services used inside your
application software are extracted from the OS Abstractor libraries and are combined with
the other application objects to produce the complete image. This image may be
downloaded to the target platform or placed in ROM on the target platform. Application
developers need to specify the OS for the application and also include the required OS
Abstractor libraries while building the application. Application developers can also select
the individual OS Abstractor components that are needed and exclude the ones that are not
required.

OS Abstractor is graphically represented in the follow as shown in Figure 3_4 .
Figure 3_4: Cross-OS development Platform

Cross-OS Development Platform
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Applications
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For more information on the host development refer toCross-OS development Platform.
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Full Library Package Generator

With Application Common Operating Environment (AppCOE) you can easily generate a
source code package to create libraries and develop application using your own IDE.

You can manually scale andconfigurethe product by modifying the user configuration file.

AppCOE provides users an easy-to-use graphical user interface that is integrated with the
Eclipse® based CDT environment. Target operating systems supported can be found here:
http:/ /mapusoft.com/products/.

Full Source Library Package Generator chapter includes the following topics:
e Generating Full Library Packages
e How to Use Libraries with Your Application

For more information on full source library package generator, refer to Full Library Package
Generator.

Optimized Target Code Generator

With Application Common Operating Environment (AppCOE) you can easily port, abstract
and optimize your code on a host machine and run the application on different target
platforms. AppCOE leverages the existing OS Changer and OS Abstractor technologies while
adding advanced code optimization capacities on multiple OS environments. AppCOE
provides users an easy-to-use graphical user interface that is integrated with the Eclipse®
based CDT environment. Target operating systems supported can be found here:
http://mapusoft.com/products/.

AppCOE reads application source code to determine the services used by your application
and produces OS specific interface code optimized for your specific application and for each
target OS platform. AppCOE gives you the ability to support multiple OS. It is also easily
expandable to generate code for your proprietary OS.

Optimized Target Code Generator chapter includes the following topics:
e Generating Target Code

e Generating Project Files for your Target
e Running AppCOE Generated Code on your Target

For more information on optimized target source code generator, refer to Optimized Target
Code Generator.

45



http://mapusoft.com/products/
http://mapusoft.com/products/

\PU Q’ ;
\PUS FTApplication Common Operating Environment User Manual

Ada-C/C++ Changer

MapuSoft Technologies now offers the Ada-C/C++ Changer tools that convertsAda to C
&give developers the ability to automatically convert legacy software written in Ada to the C
programming language. This automatic code conversion process eliminates the need for a
costly and tedious code re-write to provide developers extensive cost and time savings. Ada
tool gives users peace of mind by providing an error free tool that prevents mistakes made
in the error prone task of a manual rewrite. Ada tool supports converting Ada 83 and Ada
95 source code and generates ANSI C output as well as certain C++ features while
preserving the Ada code’s comments, files structures and variable names to ease ongoing
code maintenance.

For more information on using Ada-C/C++ Changer.

App/Platform Profiler
AppCOE enables you to view API performance data
o The App/Platform Profiler feature enables API data collection

e Collected data provides feedback concerning the utilization of MapuSoft’s APIs in the
project

e Reports allow for performance impact analysis by detailing API execution time

e Offers area, bar, line, pie and scatter charts for data analysis

e Generate API timing report and Timing comparison report
e Platform API Profiling—System specific API profiling
e Application Profiling-User specific API profiling

Platforms Supported for App/Platform Profiler
e VxWorks 6x® and VxWorks 5x®
e Linux 2.4® and Linux 2.6®
e LynxOS® and LynxOS-SE®
e Solaris
e Unix®
e Windows CE®
¢ Windows XP, Window 7 & Windows 8 ®
e QNX®
For more information on Profiling, refer to App/Platform Profiler.
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Chapter 4.Using OS Simulator

This chapter contains the following topics:

List of Available OS Simulators

Host Development Environment

Creating an AppCOE C/C++ Project

AppCOE C/C++ Project Template Files

Host System Configuration

Creating AppCOE C/C++ Project with Multiple Interfaces
Adding Source Code Files to AppCOE C/C++Project
Building Your Project

Executing Binary Files

Debugging the Demos Supplied by MapuSoft

Debugging Using External Console/Terminal

Inserting Application Code to Run only on Host Environment

Updating Project Settings
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List of Available OS Simulators

The following is the list of available OS Simulators:
o VxWorks
e pSOS
e Nucleus
e POSIX/LINUX/Linux

e ulTRON

e Windows
e ThreadX

e uC/0OS

e FreeRTOS

Host Development Environment

Host development needs a proper environment to run and build embedded programs. To
develop an environment, you need the following GNU tools:

e Eclipse IDE

e MinGW

e GNU Compiler
e PAL Debugger

Eclipse

An IDE is a powerful set of tools in the Application Common Operating Environment
(AppCOE) development suite. The IDE is based on the Eclipse Platform developed by
Eclipse.org, an open consortium of tools vendors.

The IDE incorporates into the Eclipse framework several AppCOE -specific plugins designed
for building projects for target systems running on HOST. The tools suite provides a single,
consistent, integrated environment; regardless of the host platform you are using Windows
or Linux. Plugins from most vendors should work within the Eclipse framework in the
same way.

NOTE: For more information on Eclipse and working on Eclipse framework, refer to
http:/ /www.eclipse.org/documentation/.

MinGW

MinGW, a contraction of "Minimalist GNU for Windows", is a port of the GNU Compiler
Collection (GCC), and GNU Binutils, for use in the development of native Microsoft Windows
applications. Offered in easily installed binary package format, for native deployment on
MS-Windows, or user-built from source, for cross-hosted use on UNIX or GNU/Linux, the
suite exploits Microsoft's standard system DLLs to provide the C-Runtime and Windows
API. It is augmented by additional function libraries for improved ISO C-99 compatibility,
and further, by community supported add-on tools and libraries, many pre-built, many
more in the form of "mingw PORTSs", to be built by the end user.

MinGW provides a complete Open-Source programming tool set which is suitable for the
development of native MS-Windows applications, and which do not depend on any 3rd-
party C-Runtime DLLs.

\PU S@ FT 8
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GNU Compiler

The GNU Compiler Collection includes front ends for C, C++, Java as well as libraries for
these languages (such as libstdc++, libgcj).

AppCOE Supplied GDB

A debugger is a computer program that is used to test and debug other programs (the
"target" program). The code to be examined might alternatively be running on an instruction
set simulator (ISS), a technique that allows great power in its ability to halt when specific
conditions are encountered but which will typically be somewhat slower than executing the
code directly on the appropriate processor. Some debuggers offer two modes of operation -
full or partial simulation to limit this impact.

Typically, debuggers also offer more sophisticated functions such as running a program
step by step (single-stepping or program animation), stopping (breaking) (pausing the
program to examine the current state) at some event or specified instruction by means of a
breakpoint, and tracking the values of some variables. Some debuggers have the ability to
modify the state of the program while it is running, rather than merely to observe it. It may
also be possible to continue execution at a different location in the program.

The GNU Debugger, usually called just GDB and named gdb as an executable file, is the
standard debugger for the GNU software system. It is a portable debugger that runs on
many Unix-like systems and works for many programming languages.

While working on AppCOE, you must use MapuSoft’s GNU Debugger, called as “AppCOE
Supplied GDB”.
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Creating an AppCOE C/C++ Project

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

To create an AppCOE C/C++ project:

1. From AppCOE main window, select any project underC/C++ Projects tab on the left
pane.
2. Select New >AppCOE C/C++ Project as shown in Figure 4_1.

Figure 4_1: Creating an AppCOE C Project

| Projects - Application Commen O

File Edit Source Refactor Navigate Search Project Tools Run  Window Help

P BOR-PO- BrO QP h v o] = | [rae)
B C/C++ Projects 52 =g = g

e ~

demo_cross_os
demo_freertos
demo_nucleus
demo_posix
demo_psos
demo_threadx
demo_ucos New v |C] AppCOE C Project
demo_uitron Solnto [ AppCOE C++ Project
demo_viworks BB Ada-C Changer Project
Open in New Window ]

e T (2 R R R R

Ada-C++ Changer Project
EF  Mew Ada-C Project
New Ada-C++ Project

Tools
Index
Build Configurations % Project..

Make Targets

e
& el

&% Source Folder
Build Project % Folder
Clean Project &
i
5

Source File
= Copy Header File
Paste File from Template
® Delete & Class
v 9 Example.. * ~rgv= 0
Rename...
% Other.. Ctri+N
E2y Import.
4 Exort..
o Refresh

Close Praject

Run As »
Debug As v
Profile As 3
Validate

Convert To...

Team 3
Compare With v

Restore from Local History...
3 Run C/C++ Code Analysis

Configure v
Properties Alt+Enter
Resource Configurations v

/demo_cross_os
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3. On AppCOE C/C++ Project Wizard window, type a project name and give a location

next to Project Name text box.

4. Under Project Types, expand the Executable menu. Select AppCOE Template

Project and click Next as shown inFigure 4_2.

Figure 4_2: AppCOE C Project Wizard Window

————— _
7 AppCOE C Project Wizard M i s [ S
— ——.

AppCOE C Project Wizard
Creates AppCOE C Project

Project name: Sample_AppCOE_Project

Use default location
DAMapuSoft\appcoe\AppCOE_Winx32_Beta2\workspace\Sample_A

Project type: Toolchains:

Browse...

4 (= Executable MinGW GCC
® Empty Project
® AppCOE Template Project
» (= Shared Library
» [= Static Library

Show project types and toolchains only if they are supported on the platform

Cancel
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S. On Basic Settings window, define the basic properties of your project and click Next
as shown inFigure 4_3.

Figure 4_3: Basic Settings Window

(7 AppCOE C Project Wizard EENX

Basic Settings

Application Name
Application Prefix
Author

Copyright notice
Greeting Message

Source Folder Name

@

Basic properties of a project

MyApp]

/

Name

Application Copyright Notice
Application Welcome Message

s0urce

< Back ” Next = Finish
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6. On Select Configurations window, select the platforms and configurations for
deployment and click Next as shown in Figure 4_4.

Figure 4_4: Configurations Window

/' AppCOE C Project Wizard ==y X

Select Configurations

Select platforms and configurations you wish to deploy on

Project type: Executable
Toolchains: MinGW GCC

Configurations:

(V] B Debug l Select all I
[V 53 Release

l Deselect all I

lAdvanced se‘ftings...l

Use "Advanced settings” button to edit project's properties.

Additional configurations can be added after project creation.
Use "Manage configurations” buttons either on toolbar or on property pages.
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7. On Select APIs Interface window, select the required AppCOE development APIs
and click Finish as shown inFigure 4_5.

Figure 4_5: Select APIs Window

Optimized Target Code Generator

This wizard optimizes target specific source code.

| Profiler Configuration | Platform API Profiling | Application Functions Profiling

[ Enable 05 Abstractor Interface API Profiling
Enable POSIX Interface API Profiling
Enable micro-ITRON Interface AP| Profiling
Enable Windows Interface APl Profiling
Enable ViWorks Interface AP| Profiling
Enable pS0OS Interface AP Profiling
Enable Nucleus Interface API Profiling
Enable ThreadX Interface API Profiling
Enable FreeRTOS Interface API Profiling

Enable uCOS5-1Il Interface APl Profiling

8. On Select Host Library Configuration window, select OS Abstractor Process Mode if
the created application runs in multiple processas shown in Figure 4_6.

MAPUSLHFT
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Figure 4_6: Select Host Library Configuration Window

£ AppCOE C Project Wizard = },,@,H,,,%J

Select APIs

List of API sets available

Interfaces | Host Library Cenfiguration

Select the optional OS Abstractor features te include with yeour application.

[T] OS Abstractor Process Mode Enabled

@ Next > [ Einish ] [ Cancel

\
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You can see the output as shown inFigure 4_7.

Figure 4_7: Creating AppCOE C/C++ Project Output
(" Projects - Application mmnom_z_ﬁu&imnmmmmcm“ _ e Ve

—— —
!filr.- Edit Source Refactor Mavigate Search Project Tools Bun Window Help |
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=[E -
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& _os_init_linux_host.o
£ _os_init_limeee
£ _os_init_lynoos.c
£ _os_init_mgu.c
2 _os_init_netbsd.c
[£ _os_init_nucleus.c
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£ __Of it _uitrome

£ 06 NI VEaOrs.s

£ _os_init_windowes_ho: * Problems = | @ Console 5 Properties =
£ O iniT_windows.c 0 arrars, 11 wanmings, 2 othars
|4 os_application_start.c Description ’ Resource  Path Location  Type
kel o5 library_indt.c & Warnings (11 items)
& 0s_main.c m i Infos (2 items)
) nl 1
fSample_AppCOE_Progect
—— = ———— N

MAPUSLHFT .




MAPUSLDFT

Application Common Operating Environment User Manual

AppCOE C/C++ Project Template Files

To view the AppCOE C/C++ project template files, expand the project folder you have just
created by clicking on the +sign beside the Project name as shown inFigure 4_8.

Figure 4_8: AppCOE C/C++ Project Template Files

T e ———— - T — ]
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L demo_uitron
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[ demo_windsws
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£ o ik _vwepeks.c
oninet o hot o
€ _in_il_meied ek £
05_Appiication_stat.c
£ g5 fiboary_int.c
£ oa_marec

LE iems seemed

You can view the following template files for your project on the left pane of the window:

__os_init_ linux host.c-This function is the entry function for the native operating
system. This is where you should put any of your operating system specific code. For
instance, if you want to add a signal handler on Linux host, you could do it here before
calling OS_Main().

__os_init_linux.c-This function is the entry function for the native operating system. This
is where you should put any of your operating system specific code. For instance, if you
want to add a signal handler on Linux, you could do it here before calling OS_Main().

__os_init_lynxos.c- This function is the entry function for the native operating system.
This is where you should put any of your operating system specific code. For instance, if
you want to add a signal handler on LynxOS, you could do it here before calling
OS_Main().

__os_init_mgqx.c—=This function is the entry function for the native operating system. This
is where you should put any of your operating system specific code. For instance, if you
wanted to add a signal handler on MQX, you could do it here before calling OS_Main().

» __os_init_nucleus.c- This function is the entry function for the native operating system.

MAPUSDFT

This is where you should put any of your operating system specific code. For instance, if
you wanted to add a signal handler on Nucleus, you could do it here before calling
OS_Main().
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» _os_init_gnx.c- This function is the entry function for the native operating system. This
is where you should put any of your operating system specific code. For instance, if you
wanted to add a signal handler on QNX, you could do it here before calling OS_Main().

» _os_init _solaris.c- This function is the entry function for the native operating system.
This is where you should put any of your operating system specific code. For instance, if
you want to add a signal handler on Solaris, you could do it here before calling
OS_Main().

» _os_init threadx.c- This function is the entry function for the native operating system.
This is where you should put any of your operating system specific code. For instance, if
you want to add a signal handler on ThreadX, you could do it here before calling
OS_Main ().

» _os_init_uitron.c- This function is the entry function for the native operating system.
This is where you should put any of your operating system specific code. For instance, if
you want to add a signal handler on micro-ITRON, you could do it here before calling
OS_Main ().

» _os_init_vxworks.c- This function is the entry function for the native operating system.
This is where you should put any of your operating system specific code. For instance, if
you want to add a signal handler on VxWorks, you could do it here before calling
OS_Main ().

» __os_init windows_host.c-These functions are the various entry functions for the
different operating systems. This is where you should put any of your operating system
specific code. For instance, if you want to add a signal handler on Windows host, you
could do it here before calling OS_Main ().When optimizing, you will need to write an
equivalent function for your target operating system.

» __os_init windows.c- These functions are the various entry functions for the different
operating systems. This is where you should put any of your operating system specific
code. For instance, if you want to add a signal handler on Windows, you could do it here
before calling OS_Main(). When optimizing, you will need to write an equivalent function
for your target operating system.

» _os_init_android.c-This function is the entry function for the native operating system.
This is where you should put any of your operating system specific code. For instance, if
you want to add a signal handler on android, you could do it here before calling OS_Main
0-

* _os_init ucos.c-This function is the entry function for the native operating system. This
is where you should put any of your operating system specific code. For instance, if you
want to add a signal handler on uCOS, you could do it here before calling OS_Main().

* _os_init_netbsd.c-This function is the entry function for the native operating system.
This is where you should put any of your operating system specific code. For instance, if
you want to add a signal handler on NetBSD, you could do it here before calling OS_Main
0)-

» os_application_start.c- This function is the first OS agnostic function and should be the
start point for the application development.

» os_library_init.c- This function initializes the required Interface products and creates the
entry threads for each product.

" os main.c- This function initializes the OS Abstractor Interface layer and calls
OS_Application_Wait_For_End which will suspend until OS_Application_Free or
OS_Delete_Process is called. It also spawns the first OS Independents thread which is the
true entry point for OS Abstractor Interface.
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The application code starts in the os_library_init.c file, the user defined entry function and
name of the application for OS Abstractor Interface can be specified in:

#define OS_ABSTRACTOR BASE ENTRY FUNCTION
#define OS_APPLICATION START TASK NAME

For VxWorksInterface, the user defined entry function and stack size can be specified in:

#define VXWORKS ENTRY FUNCTION
#define VXWORKS_ ENTRY FUNCTION STACK SIZE

Similarly, this is how it works for all the remaining changers/abstractors.
You can insert code that is only included when they use AppCOE host in the following way:

e For windows host you can insert code in _ os_init_ windows_host.c (inside main
function before calling 0S_MAIN), that is only included in AppCOE windows host.

e For Linux host, you can insert code in __os_init_linux_host.c (inside main function
before calling OS MAIN), that is only included in AppCOE Linux host.

You can insert code that is specific to a target OS (inside main function before calling
0S_MAIN) in the following way:

e For LynxOS target, insert in __os_init_lynxos.c

e For mqgx target, insert in __os_init_mqgx.c
e For Linux target, insert in __os_init_linux.c

e For Nucleus target, insert in __os_init_nucleus.c
e For QNX target, insert in __os_init_qnx.c

e For Solaris target, insert in __os_init_solaris.c

e For Threadx target, insert in __os_init_threadx.c
e For ulTRON target, insert in __os_init_uitron.c

e For VxWorks target, insert in __os_init_vxworks.c
e For Android target, insert in __os_init_android.c
e For uCOS target, insert in __os_init_ucos.c

e For NetBSD target, insert in __os_init_netbsd.c

e For FreeRTOS target, insert in _os_init_freertos.c
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The below defines are the system settings used by the OS_Application_Init() function. Use
these to modify the settings when running on the host. A value of -1 for any of these will
use the default values located in cross_os_usr.h. When you optimize for the target side
code, the wizard will create a custom cross_os_usr.h using the settings you specify at that

time so these defines will no longer be necessary.

#define HOST_DEBUG_INFO -1
#define HOST_TASK_POOL_TIMESLICE
#define HOST_TASK_POOL_TIMEOUT
#define HOST_ROOT_PROCESS_PREEMPT
#define HOST_ROOT_PROCESS_PRIORITY
#define HOST_ROOT_PROCESS_STACK_SIZE
#define HOST _ROOT_PROCESS_HEAP_SIZE
#define HOST_ROOT_PROCESS_AFFINITY -1
#define HOST _DEFAULT_TIMESLICE

#define HOST _MAX_TASKS

#define HOST_MAX_TIMERS

#define HOST _MAX_MUTEXES

#define HOST_MAX_PIPES

#define HOST _MAX_PROCESSES

#define HOST_MAX_QUEUES

#define HOST_MAX_PARTITION_MEM_POOLS
#define HOST _MAX_DYNAMIC_MEM_POOLS
#define HOST_MAX_EVENT_GROUPS
#define HOST _MAX_SEMAPHORES

#define HOST_USER_SHARED_REGION1_SIZE

-1
-1
-1
-1
-1
-1
-1
-1
-1
-1
-1
-1

OS_HOST: This flag is used only in AppCOE environment. It is not used in the target

environment.

Host mode defines can be modified in os_main.c file. For example, modify maximum tasks

under host environment in HOST MAX_ TASKS.

NOTE: You can manually change the values in the Optimized Target Code GeneratorWizard.

Refer to Generating Optimized Target Code chapter in the manual.
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Creating AppCOE C/C++ Project with Multiple Interfaces

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

To create AppCOE C/C++ project with multiple interfaces:

1. From AppCOE main window, select any project underC/C++ Projects tab on the left
pane.
2. Select New >AppCOE C/C++ Project as shown inFigure 4_9.

Figure 4_9: Creating a Project with Multiple Interfaces
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3. On AppCOE C Project Wizard window, type a project name and give a location next

to Project Name text box.
4. Under Project Types, expand the Executable menu. Select AppCOE Template

Project and click Next as shown inFigure 4_10.

Figure 4_10: AppCOE CProject Wizard Window

e _
| AppCOE C Project Wizard W e
— ——

AppCOE C Project Wizard

Creates AppCOE C Project

Project name: Sample_AppCOE_Project

Use default location

DAMapuSoft\appcoe\AppCOE_Winx32_Beta2\workspace\Sample_A Browse...
Project type: Toolchains:
4 = Executable MinGW GCC

@ Empty Project

@ AppCOE Template Project
> (= Shared Library
: (= Static Library

Show project types and toolchains only if they are supported on the platform
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S. On Basic Settings window, define the basic properties of your project and click Next
as shown in Figure 4_11.

Figure 4_11: Basic Settings Window

[ 5 AppCOE C Project Wizard )

Basic Settings

Basic properties of a project

Application Marne Myhpp

Application Prefix

Author Mame

Copyright notice Application Copyright Motice
Greeting Message Application Welcome Message

Source Folder Mame  source

@ <Back || Ned> Finish
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6. On Select Configurations window, select the platforms and configurations for
deployment and click Next as shown inFigure 4_12.

Figure 4_12: Configurations Window

L% AppCOE C Project Wizard E |-l

Select Configurations

-

Select platforms and configurations you wish to deploy on

Project type: Executable
Toolchains: MinGW GCC

Configurations:

@Dehug ’

Select all
53 Releaze ]
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Advanced settings...

Use "Advanced settings" button to edit project's properties.

Additional configurations can be added after project creation.
Use "Manage cenfigurations" buttons either on toclbar or on property pages.

@:J < Back “ Mest = Finich
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7. On Select APIs window, select the required check box. In this example, we have

shown Nucleus and VxWorks Interfaces API’s, selected. ClickFinishas shown in

Figure 4 13.
Figure 4_13: Select APIs Window.

,

Select APIs
List of API sets available

Interfaces | Host Library Configuration

05 Abstractor Interface APIs will automatically be included for AppCOE C/C++ Projects.
Select additional development API's used by your application:

Include O5 Abstractor Interface API's

[T Include Linux/POSIK Interface APT's

Include VxWorks Interface API's

[[]Include pS05 Interface API's

Include Mucleus Interface API's

[[]1nclude Thread¥ Interface API's

[ Include micro-ITROM Interface APT's

[T 1nclude Windows Interface API's

Include FreeRTOS Interface API's

@ Next > Finish | [ Cancel

8. On Select Host Library Configuration window, if you checked OS Abstractor

Process ModeEnabledoption, application runs in multiple Processes

otherwiseapplication runs in Single Process as shown inFigure 4_14.
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Figure 4_14: Select Host Library Configuration

L2 AppCOE C Project Wizard

Select APIs

List of API sets available

M} Host Library Cenfiguration

o

ECHEX

Select the opticnal OS Abstracter features te include with your application.

(] OS Abstracter Precess Mode Enabled

Cancel
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You cansee the output as shown inFigure 4_15.
Figure 4_15: A Project with multiple Interfaces Output

{6 Projects - Application Common Operating Environment (AppCOE)
File Edit Source Refactor Mavigate Search Project Tools Run window  Help

£ - R-P G- 3H-0-0Q- o 5~ 5] - % o

Hg cjc++ Projects 52

= E demo_cross_os
[ Includes
== include
@ _ns_application_start.h
@ demo.b
= source
= E Sample_application_Project
(= [ml Includes
@ D:f1_3_9_TestBuildsfAppCOE _winBuildCreation/out/eclipseimingwinchude
@ D:/1_3_9_TestBuildsf AppCOE_wWinBuildCreationfout/eclipsefmingwlib/gcc/mingw3z/4. 7. 2 finclude
@ D:f1_3_9_TestBuildsfAppCOE _winBuildCreationfout/eclipsefmingwlib/gcc/mingw3z/4. 7. 2finclude-fixed
@ D:/1_3_9_TestBuildsfAppCOE_winBuildCreationfout/eclipsefplugins/mapusoft. appcoe. host_1.3.9/include/cross_os_windowsfinclude
@ D:/1_3_9_TestBuildsfAppCOE_winBuildCreationfout/eclipsefplugins/mapusoft. appoo
= ildstAppiC finBuildCreationfout/eclipsefplugins/mapusaft, appco
@ Y ! BuildCreationjout/ec

efplugins/mapusoft. appcoe.hosk_1.
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Adding Source Code Files to AppCOE C/C++Project

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/to request an evaluation license.

To add source code files:

1. Select a project under C/C++ Projects pane.
2. Right click on it and select Import as shown inFigure 4_16.

Figure 4_16: Adding Source Code Files

£ Progects - demo_cross
| Ale ESt Seuce Refacter Nevigate Search Fun Froject Teols Window Help
£y~ W GOR-DO-M H~-0-Q~- ¥~ AL e " i
5 % Debug [[5 Progects | & Proties

T4 GG Progects = 0| (g applicationc € _ea_init_windows_hest.c

C demo_cross_os

c demo_rracieus

L demc_porx

c deme_pios

Ll demo_utren

L demo_oowad Ge Inte
deme_mndo

2 i&mdc.ﬁcn( Open in New Window

ne Incdludes
8 include
g Incdex

& seurce

New .

Tosls

Busld Cenfigurations
Make Targets
Busld Project

- v v -

Clean Peyect
Cepy
Pagt )S_3nCCEss) ;
X Deete
Move.

Rename. —
prole [T Progerties %5 Debug o e (m
gt

Bpont

LG

Refresh
Close Project

Rum &g »

Detug As ’

Profiie As 2

Convent To

Team .

Compare With ’
ISamgle Restore from Local Histery.,
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3. Select your import source from General > File System and thenclick Next
4. Select the directory on your local file system which contains the source code files

and click OK as shown inFigure 4_17.

Figure 4_17: Importing Source Code Files from Directory

/ Import
File system —
Saurce must nok be emphy, B
-

From direckary:

Select a directory ko import From.

El=] demo_wvxworks L
E,'] .settings
[ Debug
I3 include
[ source B
5 demo_windows
| demo_windows_mfc
|C5) Sample_AppCOE_Project v

Folder: ||:Iemu:|_vxwu:urks ‘ |
Filter Tvpes... Selzct ol

[ Make Mew Folder ] [ oK ] [ Cancel ]
Into Falder: | Sample_application_ProjEct [T Eromse...
Options

|:| Overwrite existing resources without warning

[] create top-level Foldsr

@
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5. Select the check boxes corresponding to the source code files you want to import
and click Finish as shown inFigure 4_18

Figure 4_18: Selecting Source Code Files for Importing

I
_/ Import
File system .
Import resources From the local file system. D
-
Fraom direckary: |C:'l,MapuSu:uFt'l,P.ppCOE_xS2'|,wu:urkspace'l,demn_vxwu:urks v| [ Browse, ., ]
= [B] = demo_wworks [1 ¥ .cproject
|:|[E7 Jsetkings [T %] .project

- [] = Debug
- [¥] (= include
#-[¥] (= source

[Filter Types...] [ Select Al ] [ Deselect All

Into Folder: |Sample_.ﬁ.|:upCOE_PrDject | [ Browse, .,

Opkions
|:| Overwribe existing resources without warning

[]create top-lewvel Folder

® Mext = [ Finish ] [ Cancel
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6. You can view the source code files added to your AppCOE C/C++ project as shown
inFigure 4_19.

Figure 4_19: Importing Source Code Files Output

= [: Sample_application_Project
# -l Includes
= [-p include
+ % demo.h
£ @ os_application_start.b
=l source
# g __os_init_android.c
L __os_inik_linu_host. o
L& __os_init_linux.c
16 _os_inik_lynzxos.c
- |6 __os_inik_mgx.c
# |6 __os_init_netbsd.c
#- g __os_init_nucleus,c
#- LG __os_inik_gnx.c
#- g __os_init_solaris.c
% __os_init_thread:.c
% __os_inik_ucos.c
| __os_init_uitron.c
1% __os_inik_wxworks,c
|6 __os_init_windows_host.c
L& __os_init_windows.c
L% application,:
|6 console.c

+-

+- g 0s_application_start.c
- g os_library_init.c
- |G os_main.c

7. Add the project include path by right click your created application project then Go
to Properties,expand the C/C++ Build > select Settingsand then add Include path:
“${workspace_loc:/${ProjName}/include}”as shown in Figure 4_20

Figure 4_20: Add Project Include path

— |
Hereet Settings =1 -
#| Resource
+- AppCOE
Euilders Configuration: |Debug [ Active ] + | | Manage Configurations. ..
=1 CJC++ Build
Build Yariables
Discovery Options =) =
oy i) Tool Settings | # Buid Steps | (1 Build Artiact | (&) Binary Parsers | @ Ervor Parsers
Logging T -
Eprm— = GCC Assembler Include paths (-I) £ & Q F
)
" General
Toal Chain Editor Lo EC © Compil “Di/1_3_9_TestBuilds/AppCOE_WinBuildireationfoutjeciipse/pluginsimapusoft.appeoe. host_1.3.9/includefvxwarks |
#- CiC++ General e ey ompiler _3_9_TestBuilds/AppCOE_\WinBuildCreationfout/eclipse/plugins/mapusoft. appcoe.hast 1. 3.9/include/nucleus_i
Project References (2 Preprocessor _3_9_TestBuilds,
Run/Debug Settings %: Symbols 2 TestBu\ds
Task Tags 22 Indudes
+ Validation [ Optimization

@ Debugging
@ Warnings
(E2 Miscellaneous
= 8 MinGW C Linker
(2 General F3 5
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Building Your Project

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

Creating an AppCOE C/C++ Project.

MAPUSDFT
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Adding Source Code Files to AppCOE C/C++Project

1. Select a project under C/C++ Projects pane, right click and select Build Project as
shown inFigure 4_21

Figure 4_21: Building Your Project

o L e
() Inclodes New 4
&| include Go It
[#-[*p source

Openin New Window

Tools
Index

Build Configurations
Make Targets
Build Project

- v v

Clean Project

[i=| Copy
(B Past=

3 Delete

Move... [2 Problems | B conscle 2 | = Properties &2 4 |<)===>| CHREE: = B-r%

Rename... CDT Build Console [Sample_Application_Project]

g Import...
£y Expart..,

o Refresh
Close Project

Run As 4
Debug As »
Profile As 4
Walidate
Convert Ta...
Team 4
Compare With »
Restore from Local Histary...

E’ Run CfiC++ Code Anilyﬁ

2. Building process as shown in Figure 4_22
Figure 4_22: Building Process

_/ Build Project - B[]

Building project...
4)

[----------- ]

Invoking Command: goc -DOS_TARGET=05_., , vxwarksisource!_os_init_windows, o

[ ] always rumin background

[Run i Elackgrn:nund] [ Cancel ] [ Details ==
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3. You can view how the binary files are built inFigure 4_23.

Figure 4_23: Output for Building Binary Files for a Project

[21 Problems | Bl Console 52 | E Properties e U S AREE =t B-F5- = O

H @E
CDT Build Consale [Sample_AppCOE_Project]
t_l.3.59/1nclude/nucleus 1ntertace/ 1nc lude

-ID:/1_3_S_TestBuilds/ippCOE_WinBuildCreation/out/eclipse/plugins/wapusoft.appooe.hos 2
t_1.3.9/include/include
-ID:/1 3 9 TestBuilds/ippCOE WinBuildCreation/out/eclipse/plugins/mwapusoft.appooe.hos
t_1.3.9/include/eross_os_windows/ inelude
"-ID:\41 3 9 TestBuilds''\AippCOE WinBuildCreationh'\out''\eclipse\'workspace' ' Sample App
COE_Projecth’include” -00 —g3 -Wall -o -fmessage-length=0 -m32 -o
"gourcehl, 08 init windows.o "..%hsourceh' os_init windows.c"
goo
-LD:/1 3_9 TestBuilds/AppCOE_WinBuildCreation/out/eclipse/pluginz/mapusoft.appeoe.hos
t_1.3.9/1lib/windovys/process/ -w3Z -0 Sample AppCOE Project.exe "sourcel\os main.o"
"sourcehos_library init.o" "sourcellos_application start.o"
"sourcehl oS init windows_host.o" "source\l  os init_windows.o"
"sourcehll 0= init vxworks.o" "sourceh) o= init uitron.o” "sourcel' o5 init ucos.o"
"sourcehl_ 0s_init threadx.o "sourceh_ os_init solaris.of "sourceh'_ os_init gnx.o"
"sourcehl 0= init nuecleus.o” "sourceh) 0= init netbsd.o” "source\h o3 init mgx.o
"sourcehl_ oz_init lynxos.o" "sourcelh_ o3 _init_ linux_host.o”
"sourceh' 05 _init_ linux.o™ "source)\'_ os_init_android.o” -lvxworks interface
—lnucleus interface —-locross os - lwinmm
15:16:35 Build Finished (took 20s.922ms)

-
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Executing Binary Files

To execute the binary in Windows host:

1. Select Project that you have created.
2. Select Created Application Project, right click and select Run As>Local C/C++
Application as shown inFigure 4_24.

Figure 4_24: Executing the Binary File

W
Mew 3

%%, Binarie:

[} Inchude o Into

2 include

2 source Open in Mew Window

== Debug

Tools

Index

Build Configurations
Make Targets

Build Project

Clean Project

v v v v

= Copy

¥ Delete
Move. .. [L Problems | 5

Rename. .. DT Build Consal
t 1.3.59/1n

E2g Import... -ID:/1 3 9
t 1.3.9/1in
-ID:/1_3_9
qgh Refresh £t 1.35.9/1n

Clase Project

£ Expart...

Debug As 3

Profile As *

Yalidate

Convert To.,, ”;Durce‘-. (Y=

Tearn r "aource' ' |

Compare With 4 "source' ' |

Restare From Local Hiskary, . "sourceh
%’ Run C)C++ Code Analysis "sourceh’h |

MAPUSDFT

75




S@ F.I:Application Common Operating Environment User Manual

3. Getting the Run Time output into Console View as shown inFigure 4_25.

Figure 4_25: Binary Output

2 Problems | B canscle 22 | = Properties =] NS e E-5-° 08
Sample_AppCOE_Project.exe [C/C++ Application] 0:41_3_9_TestBuilds)AppCoE_WinBuildCreationlout! edlipse\workspace! Sample_appCOE_Projec
Nuikbher of iterations by this task is: 116 L

Hello from the 'low prioritcy' task

Nunber of iterations by this task is 117

Hello from the 'high priority' task

Nuikbher of iterations by this task is: 117

Hello from the 'low prioritcy' task

Nunber of iterations by this task is 118

Hello from the 'high priority' task

Nubher of iterations by this t©

4 >

Caution:

If you try torebuild the createdApplication project whileexecutable of same Application
project running in background under windows operating system, you will face permission
denied Error that means you are not correctly terminated your previous executable file.
Before clean& rebuild you any application in AppCOE, you make sure thatyour application
is terminating correctly.
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Debugging the Demos Supplied by MapuSoft

Example: Debugging the demo_cross_os application

1. From AppCOE main window, select demo_cross_os project.
2. Right click on the project and select Debug as >AppCOELocalC\C ++ Application
or click on debugging icon as highlighted inFigure 4_26.

Figure 4_26: Debugging the Demo Application

R e

Fde Bot Sowte Retacie Weagme Sesch Pegert Bun Took  Wndow  Help
=il o DO -BS-B H-0-Q- -
=i [ Promen | 2 Brotier

Gl T+ Prajects 11

:'. demo_sda_tc <

SRMID_CITHE. A%
demo_n Hew
E! demop
C semop Ga I
™a
Ba SEITIOM i in Bhew Whnahore
L demox I
L demoa Teoh
Ll rampls leddes

Build Czrfmyuration

Make Targets
Bl Project

Clean Projeci
Copy
K Deirie
M
Ferarma...
i lepoi.
oY Fsport..
Fedresh
Close Propect
R=n Ba (3!
—— . .
[ebiisg 2 b Bl 1 ppCoE Local CoC++ Apphcation L= |
Peshibe 45 ¥ (2] Theal 0Ce s Spplication -
e luds
b Debisg Configuratanrs !
Team L
it windows bowt.c
Compare With ¥ | Command casceled
Reitaie Peern Lacal Helosy . fred, bulld L3 SCopped

1€ ma,

Peoperie G+ Enber .
1 fdwmo_crowm_ou |
S ——

NOTE: If the user uses the Debug dialog to create a new configuration then they need to
select AppCOE Local C/C++ Application before creating. The other option is to not use the
debug dialog, but instead select “AppCOE Local C/C++ Application" from the Debug
asmenu. This method will create the correct configuration automatically.

3. After selected the AppCOE Local Application for debugging, Confirm Perspective
Switch window is to confirm the Debug Perspective support for debugging the
application and it is displayed as shown inFigure 4_27, at a same time, windows
command prompt is displayed as shown inFigure 4_28.

Note: if the user used to open the Debug Perspective for debugging the application
by click Yes button, then debugging progress is started as shown in Figure 4_29
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Figure 4_27: Confirm Perspective Switch window

Confirm Perspective Switch
%)
management.

Do you want to open this perspective no

Remember my decision

This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective is designed to support application debugging. It
incorporates views for displaying the debug stack, variables and breakpoint

&

w?

Figure 4_28: Confirm Perspective Switch window& Windows Command Prompt

opened
Projects - Application Common Operating Environment (AppCOE) STETR
File Edit Source Refactor Navigate Search Project Tools Run Window Help
v w OOR M-~ = HrQ QA -l v Sv v
@ C/C++ Projects 52 = (a] =7 (]
AP demo_ada_to_c
c demo_cross_os
. demo_nucleus Confirm Perspective Switch B
. demo_posix =
[ demo,psos 0 This kind of launch is configured to open the Debug perspective when it suspends.
! demo_threadx ™ This Debug perspective is designed to support application debugging: &
! demo_uitron incorporates views for displaying the debug stack, variables and breakpoint
c demo_vxworks management.
c demo_windows
C sample Do you want to open this perspective now?
- AppCOEG pace\... [ = | = | [F] Remember my decision
£ Yes ] l No
= A8

1

IConsole 2

| Properties
[AppCOE Local C/C++ Application] C:\MapuSoft\AppCOE x32\mingw\bin\gdb.exe (11/11/13 6:36 PM)

s from C:\MapuSoft\AppCOE_x32\workspace\demo_cross_os\Debug\demo_cross_os.exe...done.
uch file or directory.

144 .0x7bc]

<

/demo_cross_os

Figure 4_29:

Debugging Progress Information

Progress Information

‘0‘ Launching demo_cross_os.exe

= (B )=

Cancel
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4. Debugging stops at the main function. Click Resume icon (highlightedin red circle)
to resume the debugging process as shown inFigure 4_30.

Figure 4_30: Resume Debugging process

| Debug - demo_cross_os/source/_os_init_windows_host.c - Application Common Operating Environment (AppCOE) o
g PPl P g PP
File Edit Source Refactor Navigate Search Project Run Window Help
o~ | & “® PO~ U -®® S~ e oro |
5 | 2 Projects [ Profiler (35 Debug
[ Rebug. 52 #i% ¥ = 8 |[69= Variables 52 | % Breakpoints| i} Registers | =\ Modules &ial |
a lemo_cross_os.exe [AppCOE Local C/C++ Application] +f ‘ £ 2
% AppCOE Supplied GDE (11/11/13 6:39 PM) (Suspended) Name Value
a Lﬁ’} Thread [1] (Suspended: Breakpoint hit.) 042 argc 1
= 1main() _os_init_windows_host.c85 0x00402f23 ¥ argv 0:01162d00
p-_z C:\MapuSoft\AppCOE_x32\mingw\bin\gdb.exe (11/11/13 6:39 PM)
P;l C:\MapuSoft\AppCOE_x32\workspace\demo_cross_os\Debug\demo_cross_os.ex:
“< mn » < »
[€] _os_init_windows_host.c &2 = 5 || 5% outline 52 =" m|
#if((OS_TARGET == 0S5_WINDOWS) && (0S_HOST == OS_TRUE)) R 01 R e B
R R AR R AR AR AR RN AR AR R R AR AR E RS SRR AR LR / = os_application_start.h
® main(int, LPSTR[]) : int

/* FUNCTION

0S_Application_Start

/* DESCRIPTION

or the different operati
any of your op
ted to add a

<

E] Console | ] Tasks L Problems | {2 Executables | [J Memory
Monitors &

5. The debugging resumes as shown inFigure 4_31.

Figure 4_31: Debug Demo Application Perspective

~ Debug - demo_cross_os/source/__os_init_windows_host.c - Application Common Operating Environment (AppCOE) "
File Edit Source Refactor Navigate Search Project Run Window Help

& i

B0 Q- @® G S e

3~ ) ® 0= i» =
J B9 | L9 Projects () Profiler 35 Debug
[%5 Debug 2 §1 3% T = O ||69= Variables i3 | 9 Breakpoints i Registers | mA Modules =

LE|§ | 3

Pl q demo_cross_os.exe [AppCOE Local C/C++ Application]
4 {2 AppCOE Supplied GDB (11/11/13 6:39 PM)
& Thread [1] (Running)
’; C:\MapuSoft\AppCOE_x32\mingw\bin\gdb.exe (11/11/13 6:39 PM)
P; C:\MapuSoft\AppCOE_,32\workspace\demo_cross_os\Debug\demo_cross_os.ex:

«
= 8 || 5 Outline 2
0 SECRS S
........ = os_application_start.h
. * © main(int, LPSTR{]) : int

€ _os_init_windows_host.c 23
#if((OS_TARGET == OS_WINDOWS) & (OS_HOST == 0S_TRUE))

"

& Console 52 | ¥ Tasks [1! Problems (3 Executables' [J Memory ] » o8| B 5|
Hemo_cross_os.exe [AppCOE Local C/C++ Application] C:\MapuSoft\AppCOE x32\mingw\bin\gdb.exe (11/11/13 6:39 PM)

[New Thread 948.8xe2c]

[New Thread 948.0xeb8]

[New Thread 948.8x988]

[New Thread 948.8x474] =
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You can see the debugging on the console as shown inFigure 4_32.

Figure 4_32: Debug Demo Application Output

Suystem time is: 1994

0300 3o 30 3o JoE M- JoE o oo e o e o e e e -JoEef- oo

Suspending Tasks B and 1

30306303030 - 3o o0 oo oo o -aE- oo 0 -uE- oo o

Getting the system clock back to =zero.
Thiz has been done 18 times.

EaZadaiadadobadabototototedototatotaiatatsdatatototototod
Delete and Restart task 2

B C\Mapusoft\AppCOE\workspace\demo_cross_os\Debug\demo_cross_os.exe |i‘ﬂl—g—hj

4 [m

Note: If the user not use the Debug Perspective by click No button from Debug
Perspective windows as shown inFigure 4_27. Debugging the Demo application from

AppCOE only as shown in the Figure 4_33 andFigure 4_34

Note: Best ways is user should use the Debug Perspective for debugging the demo
application, because its only helps to views for displaying the debug stack, variables,

breakpoint management.

Figure 4_33: Debug Demo ApplicationUsing AppCOE
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Projects - demo_cross_os/source/_os_init_windows_host.c - Application Common Operating Environment (AppCOE) \ =] H &P \i:h
File Edit Source Refactor Navigate Search Project Tools Run Window Help
i |6 ©OR-BO- » H-O Q@™ 4~
Y v v \ ‘ Profiler
@ C/C++ Projects 2 = O || g _os_init_ windows_host.c &3 = [l
= < #if((0S_TARGET == 0S_WINDOWS) && (0S_HOST == 0S_TRUE)) A
MW demoadatoc 0 || L eessssssss
C demo_cross_os:
c demo_nucleus
[: demo_posix
c demo_psos
C demo_threadx
c demo_uitron
C demo_vxworks
c demo_windows
9 0S_Main();
return(0S_SUCCESS);
#endif i
1% Problems | Bl Console | =1 Properties | %5 Debug 3 i Y= 8
4 Cl demo_cross_os.exe [AppCOE Local C/C++ Application]
4 AppCOE Supplied GDB (11/11/13 8:10 PM) (Suspended)
4 ,J;‘} Thread [1] (Suspended: Breakpoint hit.)
=1 main() _os_init_ windows_host.c:85 0x00402f23
p; C:\MapuSoft\AppCOE_,32\mingw\bin\gdb.exe (11/11/13 8:10 PM)
I-> C:\MapuSoft\AppCOE_x32\workspace\demo_cross_os\Debug\demo_cross_os.exe (11/11/13 8:10 PM)
. .
Figure 4_34: Resume Debugging process
Projects - demo_cross_os/source/_os_init_windows_host.c - Application Common Operating Environment (AppCOE) o[ @] =
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B v #if((0S_TARGET == OS_WINDOWS) && (OS_HOST == OS_TRUE)) A
4 e A || e I S oMM S5 S o e
' demo_cross_os
! demo_nucleus ]G\ AppCOE_32) demo_cross_os\Debu... | = || |23
C demo_posix 0S_DEBUG: The affinity of XO0SDEMO is heing managed hy [
Task @ Iteratio 1 =
L] demo_psos Task 1 Iterations: 1 E
c demo_threadx 0S_DEBUG: The affinity of Proc_@ is being managed by t|
[} demo_uitron Ualue read from Queue_@: 12345578
i Ualue read from Pipe_ | ABCDEFGH
. demo_vavorks Task 2 Iterations:
I demo_windows (Sz654321
Task 2 Iterations
Task @ Iterations
Ualue read from Queue 12345678
Ualue read from Pipe_©O: ABCDEFGH
Task 2 Iterations: 3
Task 1 Iterations: 2 =
Ualue read from Queue_@: 87654321
int main(int argc, LPSTR arg JEEECESYETEESTTNE S 1N EE (03206 )]
r Task 2 Iterations: 4
3 . Task @ Iterations: 3
05:Main () Ualue read from Queue O: 12345678
Ualue read from Pipe_@: ABCDEFGH
return(0S_SUCCESS); Task 2 Iterations: 5
} Ualue read from Queue_B: 87654321 r
#endif ),
% Problems | Bl Console 52 | = Properties| %5 Debug O] | B 5B »-= 0
demo_cross_os.exe [AppCOE Local C/C++ Application] C:\MapuSoft\AppCOE x32\mingwAbin\gdb.exe (11/11/13 8:10 PM)
[New Thread 3588.@xf44] -
[New Thread 3588.8x788]
[New Thread 3588.0xd83]
[New Thread 3588.0x1008] |
[New Thread 3588.@xc14] 2
[New Thread 3588.@xcb4]
)
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Debugging Using External Console/Terminal
Debugging can be done using an external console or terminal in the following way:
1. From AppCOE main window, select the demo_cross_os project.
2. Right click on the project and select Debug as > Debug Configuration as shown
inFigure 4_35.
Figure 4_35: Open Debug Dialog
" Projects - DADSPAL !

File Edit Scurce Refactor MNavigate Search Run  Project Tools Window Help
il | @OR-DO-F H-0-Q%- S ARy
F§ %5 Debug @ Profiler
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: FT = i B
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[ [: demo_cross_os
[ [: demo_nucleus
[» [: demo_posix ; . . .
i These are the various entry functions for th
[ [:: demo_psos 7
I [:: demo_uitron
I [:: demo_wviworks
[> [:: demo_windows P Then A

systems. This is should put any o

code. For instance, if you wanted

yvou could do it here before callin

cimizing, wvou will need to write an e
4 [:sample_abs_project Mew } fget operating system.
4 f;" Binaries

|>|ﬁsample_abs_ Open R H KRR KRR R KRR R AR AR AR AR R R R R R R AR R[]

[ I@" Includes Open With ¥ rgc, LPSTR argv[])
b 2 include
& [ source Tools * kac = arge:
II [ (= Debug Make Targets P LQV = argv;
[ Copy 3
| Paste
% Delete SUCCESS) ;
Move...
Rename... B |
r*g Import.. I | 3
4 Export... =
B Hpol ] Properties | %5 Debug i1 l B
" Refresh & it | = | = v
Add Bookmark... pple_abs_project.exe [AppCOE Local C/C++ Application]
Run As 5 f\FpCOE Supplied GDB (5,'.‘31,"12 5:57 EM] (Exited. Exit code = U
II - 1 Mo DLAOCTLA L 1AL 17 82 DGl kA ,-ZUlZ\mII
Debug As » [: 1 AppCOE Local C/C++ Application emp_22V
Profile As » |[E] 2Local C/C++ Application

Clean Selected File(s)

Debug Configurations...

Build Selected File(s)
Team 3
Compare With 3
Replace With 3 :I G
s
u le_ab: .
/sample_abs_p Properties Alt+Enter
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3. On Debug Configuration window, you can set your options for debugging as shown

in Figure 4_36,

NOTE: You must use MapuSoft Supplied GDB to execute debugging.

NOTE: AppCOE does not support Cygwin tools and its use is not recommended.

Figure 4_36: Debug Configuration Window

[ Debug Configurations

Create, manage, and run configurations

S X | B3~ Name:

type filter text [ Main | 9= Arguments | P§ Environment %& Debugger| % Source
4 q AppCOE Local C/C++ Application
q demo_cross_os Debug
Cl demo_cross_os.exe [¥]!CDebuggerTab.Stop_at_main_on_startup!  main !CDebuggerTab.Advanced! l
[T] c/C++ Application
E C/C++ Attach to Application

E C/C++ Postmortem Debugger Main ‘Shared Libraries ]
[E] ¢/C++ Remote Application GDB command file: .gdbinit

_.[ Eclipse Application (Warning: Some commands in this file may interfere with the startup operation of the
E_j Eclipse Data Tools debugger, for example "run".)

=41 Java Applet Protocol:
71 Java Application

Jur JUnit

_T{ JUnit Plug-in Test

@@= Launch Group

’f{} 0SGi Framework

@ Remote Java Application

ﬂ Report ;

Filter matched 17 of 17 items

®@

Debugger: | AppCOE Supplied GDB ~|

Debugger Options

m

Apply Revert

s

4. You can change any of the options here and click Apply.
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5. Click Debug to execute debugging using the external console or Terminal. You can
view the debugging process in your console as shown inFigure 4_37.

Figure 4_37: Debugging Output Using External Console/Terminal
|~ Debug - demo_cross_os/source/__os_init_windows_host.c - Application C Operating Envil (AppCOE) = |-
File Edit Source Refactor Navigate Search Project Run Window Help
<~ |m \@ I D i+ = 3 IF-O- Q- ®™ 5~ v v S -[ *
J ra] ‘ (2 Projects () Profiler |35 Debug
e t|i® ¥ = B ||= Variables 52 | % Breakpoints| i Registers| =) Modules =]
q demo_cross_os.exe [AppCOE Local C/C++ Application] L= [ g 9 22
$& AppCOE Supplied GDB (11/11/13 6:39 PM) (Suspended) Name Value
4 uj“} Thread [1] (Suspended: Breakpoint hit.) 64? arge 1
= 1main( _os_init_windows_host.c:85 0x00402f23 ¥ argv 0:011b2d00
p'_\ C:\MapuSoft\AppCOE_32\mingw\bin\gdb.exe (11/11/13 6:39 PM)
P’:.J C:\MapuSoft\AppCOE_x32\workspace\demo_cross_os\Debug\demo_cross_os.ex:
< m » < »
[ _os_init_windows_host.c &2 = 0 || 5% Outline 52 = g
== 0S_TRUE)) - =] Laz R \s o % v
. 1 os_application_start.h

#if((OS_TARGET == OS_WINDOWS) && (0S_HOST
© main(int, LPSTR[]) : int

/* FUNCTION

m

0S_Application_Start

/* DESCRIPTION

here you should put any of your operating sy
instance, if you wanted to add a signal handler 1
»

iyt S5

<

E] Console | ¥ Tasks L Problems | 3 Executables | Memory i3

Monitors 4

84

MAPUSLHFT




MAPUSLDFT

Application Common Operating Environment User Manual

6. To resume debugging, click the resume icon . on the debugging window as shown
in Figure 4_38.

Figure 4_38: Resume Debugging Using External Console/Terminal

" Debug - demo_cross_os/source/__os_init_windows_host.c - Application Ci Operating Envi (AppCOE) =)
File Edit Source Refactor Navigate Search Project Run Window Help
il | & N e 00 5 R FErO0- Q- OB S~ W IR A SR AT 4 e
J B ‘ () Projects [ Profiler ?;’r Debug
ebug &2 i ¥ %)= Variables 2 | ®9 Breakpoints| oioi Registers| 2 Modules
%5 Debug &2 ? | i = B ||®= Variabl 9% Break 341 Reg Modul = m|
4 q demo_cross_os.exe [AppCOE Local C/C++ Application] X k= | &= l ey ©

4 &% AppCOE Supplied GDB (11/11/13 6:39 PM)
P@ Thread [1] (Running)
P;i C\MapuSoft\AppCOE_32\mingw\bin\gdb.exe (11/11/13 6:39 PM)
P:J CA\MapuSoft\AppCOE_x32\workspace\demo_cross_os\Debug\demo_cross_os.ex:

<[ (T I

[ _os_init_windows_host.c 2 = 0 || 5% Outline &2 =e
#iF((0S_TARGET == 0S_WINDOWS) && (0S_HOST == 0S_TRUE)) = 2R o %

% os_application_start.h

@ main(int, LPSTR[]) : int

/* FUNCTION

0S_Application_Start

m

/* DESCRIPTION i

These are the various entry functions for the different operati
systems. This i re you should put any of your operating s
specific code. For tance, if you wanted to add a signal handler vt

e o 7 S S (B B L

< )

=] Console 52 | ¥ Tasks| [2( Problems| (3 Executables| 0 Memory } ® LE‘ g & ] ‘ #BEB~-ri-=0
Hemo_cross_os.exe [AppCOE Local C/C++ Application] C:\MapuSoft\AppCOE_x32\mingw\bin\gdb.exe (11/11/13 6:39 PM)
[New Thread 948.@xe2c] -

[New Thread 948.0xeb3]
[New Thread 948.06x988]
[New Thread 948.0x474]

m

1
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7. You have now successfully finished debugging by using external console or terminal
as shown inFigure 4_39.

Figure 4_39: Debugging in Progress
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Inserting Application Code to Run only on Host Environment

The below defines are the system settings used by the OS_Application_Init() function. Use
these to modify the settings when running on the host. A value of -1 for any of these will
use the default values located in cross_os_usr.h.

When you optimize for the target side code, the wizard will create a custom cross_os_usr.h
using the settings you specify at that time so these defines will no longer be necessary.

You can add some application code or debug statements like printf, assert, which is mostly
used in host environment only. This line of code will be ignored by the compiler in target

environment.

OS HOST Selection

The flag has to be false for Full Source Library Package generation.
Table4 1: OS HOST Selection

Flag and Purpose

Available Options

OS_HOST

To select the host operating
system

This flag is set as OS_TRUE by default in
AppCOE environment.

Target 64 bit CPU Selection

Based on the OS you want the application to be built, set the following pre-processor
definition in your project setting or make files:

Table 4_2: Target 64-bit CPU Selection

Flag and Purpose

Available Options

OS_CPU_64BIT
To select the target CPU

type.

The value of OS_CPU_64BIT can be any ONE of
the following:

e OS_TRUE - Target CPU is 64 bit type CPU
e OS_FALSE - Target CPU is 32 bit type CPU

NOTE: In New C projects creation, the flag
OS_CPU_64BIT will be set to OS_FALSE by
default and user needs to make this true if they
run on a 64-bit OS.
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Updating Project Settings

AppCOE provides exclusive way to update the Projects Settings by just a click of a button.
This is very useful in any one of the following cases:

1. If the user has moved his workspace to a different location
2. If the project requires new tool-chain that is installed recently

The Update button performs an auto update on all the projects updates which include files,
new directory structures, libraries, and tool-chains to the Project Settings.

To update project settings:
1. From AppCOE main menu select Tools > Update Settings or click AppCOE

A

C/C++Project Settings button
4_40.

on AppCOE main menu or, as shown inFigure

Figure 4_40: Updating Project Settings
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2. AppCOE does an auto search for the project updates and updates the settings as
shown in the Project Settings Updating window inFigure 4_41

Figure 4_41: AppCOE C/C++ Project Updates
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Chapter 5. Using OS Changer Porting Kit

This chapter contains the following topics:

About OS Changer

Interfaces Available for OS Changer

Using OS Changer

Error Handling

Porting VxWorks Applications

Porting a WindRiver Workbench ‘C’ Project

Porting VxWorks Legacy ‘C’ Code

Manually Porting Legacy Applications using Import Feature
Porting POSIX/LINUX Legacy ‘C’ Code

Porting Applications from Nucleus PLUS Legacy Code to Target OS
Porting Nucleus Legacy ‘C’ Code

Porting Threadx Legacy ‘C’ Code

Porting pSOS Legacy ‘C’ Code

Porting micro-ITRON Legacy ‘C’ Code

Porting Windows Legacy ‘C’ Code

Porting ucos legacy ‘C’ Code

Porting freertos legacy ‘C’ Code

Porting VRTX legacy ‘C’ Code

Porting QNX legacy ‘C’ Code

Porting RTLinux legacy ‘C’ Code

OS Changer VxWorks Interface

OS Changer POSIX/LINUX Interface

OS Changer Nucleus Interface

OS Changer ThreadX Interface

OS Changer pSOS Interface

OS Changer micro-ITRON Interface

OS Changer micro-ITRON Interface

OS Changer micro-ITRON Interface

OS Changer Windows Interface

Building Application with Multiple Interface Components
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About OS Changer

OS Changer allows you to reuse the code on any new OS without having to rewrite or port
your code. This saves time and money by reducing the porting effort.

OS Changer provides extensive support to various common proprietary libraries widely used
by the application developers. Further, developers can use the native TARGET OS interface
as well. This works toward getting the migration effort faster and much easier.

Figure 5_1: About OS Changer

Your
Application

05 Abstractor
specific to
your 0S5

LSCHANGER

Porting Kit

OS Changer is designed for use as a C library. Services used inside your application
software are extracted from the OS Changer and TARGET OS libraries, and, are then
combined with the other application objects to produce the complete image.

OS Changer is optimized to take full advantage of the underlying TARGET RTOS features. It
is built to be totally independent of the target hardware and all the development tools (like
compilers and debuggers).

Please note that there may be some minor implementation differences in some of the OS
Changer APIs when compared to the native API’s. This may be as a result of any missing
features within the underlying RTOS that OS Changer provides migration to.
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L5 CHANGER

Flow Diagram

STEP ONE » Choose an option STEP TWO
- 4
Option One Option Two
Optimzed Code Generation Ful Source Package Generation
e,
Your ion: Import using Geanarste source Linker
‘mm'ﬂ % o
—_—

Your apphcation
You Applcation: [ Downkoad/nun
Natve Roglace Pasdors, on your target 05
comguber Combine main ( )
“‘E:m pombtimper - = W
& mywter settings

and intishze 00
“.
acn data (optional)
OS
Onaut: View data using
05 PAL Profiler
wmmu-
Contrm to STEP TWO
Output:
Crose-QS imerfacs cbject
Existing OS5 intorface object
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Figure 5_2: OS Changer Flow Diagram

Your legacy application can be re-usable and also portable by the support provided by the
OS Changer library and the OS Abstractor library. Applications can directly use the native
target OS API, however doing so will not make your code portable across operating systems.
We recommend that you use the optimized abstraction APIs for the features and support
that are not provided by the OS Changer compatibility library.

NOTE: For more information on configuration and target OS specific information, see OS
Abstractor Interface Reference Manual.

Interfaces Available for OS Changer

The following are the interfaces available for OS Changer:

e VxWorks
e Nucleus
e pSOS

e micro-ITRON
e POSIX/LINUX
¢ Windows

e ThreadX

e uC/0OS

e FreeRTOS
e VRTX

o QNX

¢ RTLinux
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Using OS Changer

OS Changer is designed for use as a C library. Services used inside your application
software are extracted from the OS Changer and TARGET OS libraries, and, are then
combined with the other application objects to produce the complete image. This image can
be loaded to the target system or placed in ROM on the target system.

The steps for using OS Changer are described in the following generic form:

¢ Remove the TARGET RTOS header file defines from all the TARGET RTOS
source files.

e Remove definitions and references to all the TARGET RTOS configuration data
structures in your application.

¢ Include the TARGET RTOS_interface.h (For example, nucleus_interface.h in
case of OS Changer Nucleus Interface) and os_target.h in the source files.

e Modify the OS Changer init code (see sample provided) and the TARGET RTOS
root task of your application appropriately. (For example, Application_Initialize)

e Compile and link your application using appropriate development tools. Resolve
all compiler and linker errors.

e Port the underlying low-level drivers to Target OS.

e Load the complete application image to the target system and run the
application.

e Review the processor and development system documentation for additional
information, including specific details on how to use the compiler, assembler,
and linker.

Error Handling

Applications receive a run-time error via the OS_Fatal Error () function on some occasions.
This happens due to:

e Unsupported API function call, or
e Unsupported parameter value or flag option in a API call, or

e Error occurred on the target OS for which there are no matching error codes in
OS Abstractor Interface.

OS Changer calls OS_Fatal Error and passes along an error code and error string. The
OS_Fatal_Error handling function is fully customizable to the application needs. At the
moment it prints the error message if the OS_DEBUG_INFO conditional compile option is
set, then OS_Fatal_Error does not return. For more details on error handling and definition
of this function, refer to the OS Abstractor Interface Reference Guide. The non-zero value in
the error code corresponds to the underlying RTOS API error. Refer to the target OS
documentation for a better description of the errors. Error Handling section lists the errors
and the reasons for the occurrence.
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Porting VxWorks Applications

Porting applications into the AppCOE host environment can be done in three different ways:

1. Porting a WindRiver Workbench project
2. Porting a Legacy application
3. Manual porting using AppCOE

Method 1- Porting a WindRiver Workbench ‘C’ Project

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

From AppCOE main window, select any project underC/C++ Projects tab on the left
pane.
Select Tools > Porting >VxWorks> Import Workbench ‘C’ Project as shown in

Figure 5_3. You can also click on the Porting icon from the task bar.

Figure 5_3: Importing a VxXWorks Workbench ‘C’ Project in AppCOE

i

C
C
C

r: demo_threadx

demo_psos

c demo_uitron
c demo_vxworks
c deme_windows

Projects - Application Commeon Operating Environment (AppCOE) ‘i”i“&]
File Edit Source Refactor Navigate Search Project Tools Run Window Help
| & - A F-0-Q-F~ %l 2l

VxWorks » k'} Import Workbench 'C' Project i2] ‘ Profiler

B C/Ce Projects 3 = 5 pSOS » | (3 Import Legacy 'C' Code ) = g
1 = Nucleus >
= ThreadX >
POSIX »
demo_nucleus micro-ITRON >
demo_posix Windows »

1% Problems | B Console £2 | E Properties a s ]
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3. On AppCOE Import window, select a workspace directory to search for existing
workbench projects by clicking on Browse button next to the text box, and click
Next as shown inFigure 5_4.

4. On Select Host Library Configuration window, select OS Abstractor Process Mode if
the imported application runs in multiple process

S. In Import Wind River Workbench Projects window, the projects list is displayed in a
checkbox Tree. Application projects and Library projects are separated into
respective categories.

6. Select or deselect any one or all of the projects by selecting the check box next to the
project name and click Finish to import the project as shown inFigure 5_4.

Figure 5_4: AppCOE Import Window

" N

52 Import o I&][=]

Import Wind River Workbench Projects ‘R

Select a Workspace to Search for existing Workbench Projects.

Select Workspace Directery :  E\Examples\LegacyDemoes'\Legacy_Workbe Browse...

Host Library Configuration

[7] OS Abstracter Process Mode Enabled

T\

)

)
o
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The following are the project types:

Application Projects - Provides an executable application. This project type folder
contains three templates. The makefile for the Executable project type is
automatically created by the CDT.

Library Projects- An executable module that is compiled and linked separately.
When you create a project that uses a shared library (libxx.so), you define your
shared library's project as a Project Reference for your application. The makefile for
this project type is automatically created by the CDT.

NOTE: Select the check box next to your required library or application project to be
imported.

7. If you select Application project, and click Finish, you get Application Start up Files
windowas shown inFigure 5_5.
Figure 5_5: Application Startup Files Window
4 Import I. | =] |_ih]

Select a Workspace to Search for existing Workbench Projects.

Import Wind River Workbench Projects ‘H

Projects In Workspace :

4 [J] Application Projects

simple_wworks_app

[] Library Projects

oy

Cancel

MAPUSDFT

8. If you are importing a kernel application, click Yes to automatically create start up
files to connect the imported application to the OS platform.
NOTE: If you are porting a library project, click No to continue with the porting.

9. If you select any application type project, provide the inputs for the project andclick

OK as shown in Figure 5_6. If you do not want to provide the inputs, you can just
click Cancel.
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Figure 5_6: Provide Inputs for Projects Window

0 Inputs For simple viwerks_app @

Root Task Prototype: Enter pratotype function definition of application’s root task (e.g, int UsRoot(int argc); )

Root Task Stack Size(in bytes): (05 MIN_STACK SIZE

o]

NOTE: If you select an application project and if it contains any referenced projects
not selected by you, then a Confirmation dialogue box is displayed on your screen to
ask if you want to port the project. If you want to port, click OK. You can see the
porting processing results as shown in Figure 5_6 .

After the porting is successfully done, the porting report page is displayed as shown
inFigure 5_7, Click Done to complete the process.

Figure 5_7: Porting Reports Page

=
-
)

Porting Report

(1) Displays the Information about different activities involved in Porting.

hnputs Provided i
Status:

Description:
Input Values Provided for Project : simple_vioworks_app

m

Project Porting
Status:

Description:
simple_wxworks_app Project Ported Successfully.

Guidelines
Status: WARNING
Description:
Status: Require Application Code Modification

Paorting steps completed successfully.

In order to successfully compile your application, the following manual code changes may be
renirer

R
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10. In order to successfully compile your application, follow the guidelines
highlightedas shown inFigure 5_8.

Figure 5_8: Porting Reports Page Guidelines

% - . |

Forting Report

(i) Displays the Information about different activities involved in Porting.

Guidelines
Status: WARMNIMNG
Description:

Status: Require Application Code Madification
Parting steps completed successfully,
In order to successfully compile your application, the following manual code changes may be
reguirec:
1. Remove ViWorks header file references Use the following header files
instead of the VxWorks header files :
Finclude 'os_target.h’'
Finclude
“wiworks_interface.h'
2. If your application uses any V¥\Works APIs that are un-supported
by Interface, then manually port your code using 05 Abstractor Interface APIs
3 If
your application have a main() function, then move the necessary code from your main() to
the the main(} provided by Q5 Abstractor Interface in os_main.c
4, If your application
have any assembly code, then manually port them to the new 05 platform
5. If your
application have any interrupt handler code, manually port them to the new O5 platforms

m

@
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11.In AppCOE C/C++ projects perspective, the ported projects are displayed as

shown in Figure 5_9.
Figure 5_9: Project Perspective of the Ported Projects
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05 Ink_li hostc
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#1L((05_TARCEY we O3 WINDOWS) c& (O3 _HOSY we 03 _TRUE))
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'_us_‘.'n‘(‘mam(
LOLIng ucosc

LS Nk _uitron.c
_os_un(_mod}. <

05 ink_windows_hosts
__o6_ink_windows.c
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o SMNTgnw
man.c
winddemo.c

(LR I08 DN DN O8N

1

| | Ada-C/Ce s Changer
Infos g

I 3

25 items selected

You have successfully imported your VxWorks application to AppCOE.

Application Common Operating Environment User Manual

To know more about the project template files, go to AppCOE C/C++Project Template Files.
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Method 2-Porting VxWorks Legacy ‘C’ Code

This section explains Porting VxWorks Legacy Applications using AppCOE Porting Plug-in.
A sample porting of VxWorks Legacy application using AppCOE is described with an
example here.

NOTE:

1. This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

2. On OpenSuse 13.2, change the GTK2 Theme setting from "oxygen-gtk" to a different
theme:

e Click on the OpenSuse launcher icon and select "Configure Desktop".

e On the dialog that appears, click on the "Application Appearance" icon.

e Under both the Style and GTK sections, change any currently applied
GTK, GTK2, or GTK3 settings such that any "Oxygen" related settings are
change to a different setting. For example, select the "GTK" icon and then
on that view, for "Select a GTK2 Theme:” choose a different item, such as
"Raleigh".

e Click "Apply" to save changes.

Changing the theme settings on OpenSUSE 13.2

e EY K

&'...- Projects - Apphcats . sungy 5T Systam Setings Hos 00 4 - o2

Select Tools> Porting >VxWorks> Import Legacy ‘C’ Code as shown inFigure 5 10. You

& :

can also click on the Porting icon from the task bar.

Figure 5_10: Porting VxWorks Legacy ‘C’ Code in AppCOE
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1. On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing an

application project for example purpose.

2. Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Next as shown inFigure 5_11.

3. On Select Host Library Configuration window, select OS Abstractor Process Mode

if the imported application runs in multiple processes.

Figure 5_11: Import VxWorks Legacy Code Window

L3 Import

Import ¥xworks Legacy Code
Select a Directory te Import ViWerks Legacy Cede inte AppCOE.

(®) Import Application Project Import Library Project

O >

o

Root Directory | D\LegacyDemes\Legacy Vxworks_App | I Browse... I
q

Project Mame: | wvxworks_legacy |
1

Root Task Prototype : | int usrRoot{UMSIGMED argc); |
1 Root Task Stack Size(in bytes) : | OS_MIN_STACK_SIZE |

Host Library Configuration

[] 08 Abstractor Process Mode Enabled

':;:' Finish Cancel

4. Enter the project name for which you want to import the legacy code in the Project

Name text box.

S. Enter the root task prototype as int usrRoot(UNSIGNED argc);, next to Root Task

Prototype text box.

MAPUSDFT
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6. Enter the root task stack size, next to the Root Task Stack Size text box. The
value should be in bytes.Note: By Default, Root Task Stack Size should be

OS_MIN_STACK SIZE, even though if you changed.
Click Finish to complete the importing of legacy code into AppCOE.

You have successfully imported the legacy vxWorks code and a project with your

®© N

given project name is created in the current workspace as shown in Figure 5_12.

Figure 5_12: ImportedvxWorks Legacy Code output
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Method 3— Manually Porting Legacy Applications using Import Feature

Step 1:In your source code, remove references to the original OS include files and
use os_target.h and the header files of your ported legacy API instead.

1.

2.

o

Remove the original OS specific initialization code and use OS_Application_Init
function call instead (refer to the OS Abstractor Interface Reference Manual).
Create an AppCOE c/c++ project for your legacy application and select the
legacy API that your application will need (E.g.: to port VxWorks application, you
need to check the “Include OS Changer VxWorks Interface API’s”).

If your application uses any APIs that are not supported under AppCOE, re-write
the code using OS Abstractor Interface APIs.

Import your legacy application into the new project.

Compile and link your application and resolve all compiler and linker errors.

Run or debug your application under AppCOE host in an x86 environment. You
should rewrite/replace any hardware specific code in your application for this
step.

Step 2: Moving from AppCOE Host to target using AppCOE Optimized Target Code
Generator:

1) Generate the code for your target OS using the AppCOE Optimized Target

Code Generator.

2) Using cross-compiler compile, link, and download the AppCOE generated
code to your target.

3) Port low level drivers and hardware interrupt code as required (refer to
OSAbstractor Interface 1/O and device driver APIs sections in the OS
Abstractor Reference Manual).

4) Resolve any run time errors.
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Porting POSIX/LINUX Legacy ‘C’ Code

This section explains Porting POSIX/LINUX Legacy Applications using AppCOE Porting
Plugin. A sample porting of POSIX/LINUX Legacy applications using AppCOE is described
with an example here.

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-

evaluation/ to request an evaluation license.
To port a sample POSIX/LINUX legacy application:

1. Select Tools> Porting >POSIX/LINUX> Import Legacy ‘C’ Code as shown inFigure
5_13. You can also click on the Porting icon from the task bar.

Figure 5_13: Porting POSIX/LINUX Legacy ‘C’ Code in AppCOE

Projects - Apghcation Common Opersting Envwonment (AppC OF) |- ]
fie [t Source Refactor Newgate Search Project ook Bun  Yindow Mep
- = H\-'O“‘v :“-’-.)'I,I-- Y -

(3 ImportLegacy 'C Code
et AT AN S

o
> * v v e v .

OO0

* Problems & Corucle Propertes v "S>
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3. On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing a
application project for example purpose.

4. Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Next as shown inFigure 5_13.

Figure 5_13: Import POSIX/LINUX Legacy Code Window

( T — N\
L2 Import

o &= |
Import Posix Legacy Code ‘N

Select a Directery to Import Posix Legacy Cede inte AppCOE.

@ Import Applicaticon Project Import Library Project

Root Directory E\Examples\LegacyDemos'\Legacy_Posix_App
Project Name: posix_legacy

Root Task Prototype : int px_main(int argc, char® argv(]}

Root Task Stack Size(in bytes): OS_MIN_STACK_SIZE

Host Library Configuration
[ OS Abstracter Process Mode Enabled

J Finish ] [ Cancel

S. Enter the project name for which you want to import the legacy code in the Project
Name text box.

6. Enter the root task prototype asint px_main(int argc, char* argv[]), next to Root
Task Prototype text box.

7. Enter the root task stack size, next to the Root Task Stack Size text box. The value

should be in bytes.
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8. Click Finish to complete the importing of legacy code into AppCOE. You can see
POSIX/LINUX legacy code you have imported as shown in Figure 5_14.

Figure 5_14 : Importing POSIX/LINUX Legacy Code Output

Bile  Edit Bowrce  Refacior  Nesgate  Segech Bun Froect Jook  Window  Help |
4= W DOS-B2o5-B H-0-Q - T - = - -

W demo_sda 1o«
L demo_cross os
L demo_nuscheus
L demo_pasin
E demno_psos
2 deno_uitren “

E dermo_vaowaiks

derma_vandown
a L, poss_legecy

.c] mpplication.c
.r| ms_spphcsbion_sarkc

& Problems [ Console [ Properties | % Debug © o S#ET™

¥ Rerra pelected

You have successfully imported the POSIX/LINUX legacy C code and a project with
your given project name is created in the current workspace.
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Porting Applications from Nucleus PLUS Legacy Code to Target OS

In most applications, using Nucleus OS Changer is straightforward. The effort required in
porting is mostly at the underlying driver layer. Since we do not have specific information
about your application, it will be hard to tell how much work is required. However, we
want you to be fully aware of the surrounding issues upfront so that necessary steps could
be taken for a successful and timely porting. This section provides porting guidelines in a
flow chart format. This covers issues relating with Nucleus OS Changer, device drivers,
interrupt service routines, etc. It is possible that we have not addressed all your
application specific issues in the flow chart, so for further information, contact MapuSoft
Technologies.

Figure 5_15: Porting Nucleus PLUS Applications

Porting Nucleus PLUS Applications to Linux - Guidelines
Chart A - Kernel APIs, interrupts and device drivers

CHECK 1
S your application uses kernel APIs™tha
are un-supported in
Nucleus PLUS OS Changer?

mplement the

unsupported APIs
Yes using

OS Abstractor o
target OS AP,

CHECK 2 )
Daoés your application uses kernel APIs' Moq|fy_your
. application to
are partially supported by Yes—p handle the
Nucleus PLUS OS Changer? N
differences

CHECK 3
Boes your application configure the targe
hardware differently than default setup in
Nucleus PLUS?

Modify the target OS
Yes—» BSPs to the desired
target configuration

Port the device driver
routines to target OS or
modify application to use
target OS drivers instead

CHECK 4
Are you using Nucleus PLUS based
device drivers?

CHECK 5
Are you using interrupt service routines tha
are not part of the Nucleus PLUS based
device drivers?

Make changes if needed to
Yes—¥{ make them to work under
target OS

Happy Porting
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Porting Nucleus Legacy ‘C’ Code

This section explains Porting Nucleus Legacy Applications using AppCOE Porting Plugin. A
sample porting of Nucleus Legacy application using AppCOE is described with an example
here.

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/to request an evaluation license.

1. Select Tools> Porting > Nucleus > Import Legacy ‘C’ Code as shown inFigure

5_16. You can also click on the Porting icon ﬁ " from the task bar.

Figure 5_16: Importing Nucleus Legacy ‘C’ Code in AppCOE

Preyects - Application Common Operating Envi {2ppCOE) [ [ e
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On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing an
application project for example purpose.

Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Next as shown in Figure 5_17.

On Select Host Library Configuration window, select OS Abstractor Process Mode
if the imported application runs in multiple process

Figure 5_17: Import Nucleus Legacy Code Window

e

£ Import =

(= ][
Import Nucleus Legacy Code ‘N

Select a Directeory to Import Nucleus Legacy Code inte AppCOE.

@ Import Application Project Import Library Project

Root Directory E:\Examples'\LegacyDemos'Legacy_Nucleus_App
Project Name: nucleus_legacy

Root Task Prototype : VOID NucleusReot{UNSIGNED argv,VOID*  argc);

Root Task Stack Size(in bytes): OS_MIN_STACK_SIZE
Root Task Name: NU_ROOT

Host Library Cenfiguration

[7] OS Abstractor Process Mode Enabled

[ Finish ] 1 Cancel

MAPUSDFT

Enter the project name for which you want to import the legacy code in the Project
Name text box.

Enter the root task prototype asVOID NucleusRoot(UNSIGNEDargv,VOID* argc);,
next to Root Task Prototype text box.

Enter the root task stack size, next to the Root Task Stack Size text box. The value
should be in bytes.

Enter the root task name, next to Root Task Nametext box.
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9. Click Finish to complete the importing of legacy code into AppCOE. You can see the

output as shown inFigure 5_18.

Figure 5_18: Importing Nucleus Code Output

Projects - lication C Operating Envii nt
.+ Projects - Application Common Operating Environme
Eile Edit Source Refactor Mavigate Search Run Project Tools Window Help

wilhe
B %5 Debug @ Profiler

[E) C/C++ Projects 53 =0

| B R e o B TR s I N v 5] - .S

dlEsT

> :l demo_ada_to ¢
> [: demo_cross_os
> [: demo_nucleus
> [: deme_posix
> [: demo_psos

> C demo_uitron

>

>

4

demo_vxworks
demo_windows

~
nucleus_legacy |

> |l Includes
5 |7 include
4 |[=. source

» [ include
> (= init
4 |[= source
> application.c
> os_application_start.c

> [: posix_legacy

s

E; Problems | & Console | & Properties ﬁ-Debug 33

9 items selected

S

|+ =z~ =08

10. You have successfully imported Nucleus legacy C code and a project with

yourgiven project name is created in the current workspace.
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Porting Threadx Legacy ‘C’ Code

This section explains Porting Threadx Legacy Applications using AppCOE Porting Plugin. A
sample porting of Threadx Legacy application using AppCOE is described with an example
here.

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

1. Select Tools> Porting > ThreadX> Import Legacy ‘C’ Code as shown inFigure

5_19. You can also click on the Porting icon from the task bar.

Figure 5_19: Importing ThreadX Legacy ‘C’ Code in AppCOE

"/ Projects - Application Common Operating Environment (AppCOE) = =
File Edit Source Refactor Navigate Search Project Tools Run Window Help
Fie | i P~ BrQrQv ST v v
Vorks b &5 | (£ Projects | @ Profiler
= S0S » =
B C/C++ Projects 22 g P g
T Nucleus 4
S ThreadX » | 3 Import Legacy 'C' Code ]
t demo_cros POSIX 4
[: demo_nucleus micro-ITRON »
[: demo_posix Windows 4
c demo_psos
[: demo_threadx
C demo_uitron
C demo_vxworks
C demo_windows
% Problems | Bl Console 52 | E Properties A i vt

111



http://mapusoft.com/downloads/AppCOE-evaluation/
http://mapusoft.com/downloads/AppCOE-evaluation/

MAPUSLDFT

Application Common Operating Environment User Manual

2. On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing a
application project for example purpose.

3. Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Next as shown inFigure 5_20.

4. On Select Host Library Configuration window, select OS Abstractor Process Mode if
the imported application runs in multiple process
Figure 5_20: Import Threadx Legacy Code Window

' Import = -3 @ .

Proj

Import ThreadX Legacy Code ‘R

Select a Directory to Import Pesix Legacy Code inte AppCCE.

@ Import Application Project Import Library Project

Root Directory E\Examples\LegacyDemos'\Legacy_ThreadX_App

Root Task Prototype: tx_kernel_enter();
Root Task Stack Size(in bytes): OS_MIN_STACK_SIZE

Host Library Configuraticn

"] OS Abstractor Process Mode Enabled

ect Name: threadx_legacy

'(7,’ Finish J { Cancel
S. Enter the project name for which you want to import the legacy code in the Project

MAPUSDFT

Name text box.

Enter the root task as a tx_kernel enter(); prototype, next to Root Task Prototype
text box.

Enter the root task stack size, next to the Root Task Stack Size text box. The value
should be in bytes.

Enter the root task name, next to Root Task Nametext box.
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9. Click Finish to complete the importing of legacy code into AppCOE. You can see the

output as shown in Figure 5_21.

Figure 5_21: Importing Threadx Code Output
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10. You have successfully imported ThreadX legacy C code and a project with your given

project name is created in the current workspace.
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Porting pSOS Legacy ‘C’ Code

This section describes the sample porting of pSOS Legacy Applications using AppCOE
Porting Plug-in. A description for porting pSOS Legacy applications using AppCOE is
described with an example here.

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

1. Select Tools> Porting >pSOS> Import Legacy ‘C’ Code as shown inFigure 5_22,
you can also click on the Porting icon from the task bar.

Figure 5_22: Importing pSOS Legacy ‘C’ Code in AppCOE

Projects - Application Common Operating Environment (AppCOE) == \@
File Edit Source Refactor Navigate Search Project Tools Run Window Help
i | B LR HrQ Qv P v 5l -
VxWorks -l = Projects | £/ Profiler
A v 'C' Cod =
& /s Projects 22 = g5 pSOS (3> ImportLegacy 'C' Code i g
, =y Nucleus »
S ThreadX >
POSIX 2
c s micro-ITRON >
C demo_posix Windows >
[: demo_psos
[: demo_threadx
. demo_uitron
C demo_vxworks
[: demo_windows
¢ Problems | B Conscle 52 | El Properties r 4= 0
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3. On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing a
application project for example purpose.

4. Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Nextas shown Figure 5_23.

S. On Select Host Library Configuration window, select OS Abstractor Process Mode if
the imported application runs in multiple process

Figure 5_23: Import pSOS Legacy Code Window

s N

L2 Tmport SRIECHIE>AN|

Import pSOS Legacy Code ‘N

Select a Directory to Import pSOS Legacy Code inte AppCOE.

@ Impoert Application Project Import Library Project

Root Directory  E'\Examples\LegacyDemos'Legacy_Pscs_App
Project Name : pses_legacy

Root Task Prototype : VOID Function_Reot(ULONG argument);

Root Task Stack Size(in bytes): OS_MIN_STACK_SIZE

Host Library Configuration
[] OS Abstractor Process Mode Enabled

? [ Finish ] [ Cancel

6. Enter the project name for which you want to import the legacy code in the Project
Name text box as shown in the Figure .

7. Enter the root task prototype as VOID Function Root (ULONG argument);, next
to Root Task Prototype text box as shown in the Figure 5_24.

8. Enter the root task stack size, next to the Root Task Stack Size text box as shown
in Figure 5_24.. The value should be in bytes.
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9. Click Finish to complete the importing of legacy code into AppCOE. You can see

POSIX/LINUX legacy code you have imported as shown in Figure 5_24 .

Figure 5_24: Importing pSOS Legacy Code Output

. Projects - Application Common Operating Environment

File Edit Source Refactor Navigate Search Run Project Tools Window Help

o - | & RBO B B0 A A o

& %5 Debug Q Profiler

&) C/C++ Projects &3 =0 =0
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> .fl demo_ada_to_c
> [: demo_cross_os
- [: demo_nucleus
- [: deme_posix

> [: demo_psos

> C demao_uitron

> [: demo_wxworks
> [: demo_windows
> [: nucleus_legacy
> [: posix_legacy
4 [: psos_legacy
b | Includes
b | include
4 |2 source
b |(= include
b | (= init
4 |[=. source
> | [ application.c
> | g dvserial.c
> @ os_application_start.c

> | L€ usr.c

[Z: Problems | Bl Console | = Properties | %5 Debug 52 i T =0
P )

o°® 11 items selected

10. You have successfully imported pSOS legacy C code and a project with your given

project name is created in the current workspace.
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Porting micro-ITRON Legacy ‘C’ Code

This section explains porting of micro-ITRON Legacy Applications using AppCOE Porting
Plugin. A sample porting of micro-ITRON Legacy applications using AppCOE is described
with an example here.

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

1. Select Tools> Porting >micro-ITRON> Import Legacy ‘C’ Code as shown inFigure
5_25. You can also click on the Porting icon from the task bar.

Figure 5_25: Importing micro-ITRON Legacy ‘C’ Code in AppCOE

' Projects - Application Common Operating Envi t (AppCOE) ‘i”@y
File Edit Source Refactor Navigate Search Project Tools Run Window Help
e | G -0~ £l R R g gl v |
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. = Nucleus »
= ThreadX >
POSIX »
micro-ITRON » [ €3 ImportLegacy 'C' Code
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C demo_psos
’1: demo_threadx
C demo_uitron

c demo_vxwork:

c demo_windows

=

1% Problems | & Console 53 | E Properties . v v 8
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3. On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing a
application project for example purpose.

4. Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Next as shown in Figure 5_26.

S. On Select Host Library Configuration window, selectOS Abstractor Process Mode if
the imported application runs in multiple process

Figure 5_26: Import micro-ITRON Legacy Code Window

s

L2 Tmport o |[= =]

Import micro-ITRON Legacy Code ‘H

Select a Directory to Impert micro-ITRON Legacy Cede into AppCOE.

@ Import Application Project Import Library Project

Root Directory  E\Examples\LegacyDemos'Legacy_Uitron_App
Project Name : uitron_legacy

Root Task Prototype : VOID ulTROMReoct(UNSIGNED argv);

Root Task Stack Size(in bytes): OS_MIN_STACK_SIZE

Host Library Configuration

[] OS Abstractor Process Meode Enabled

Finish ] [ Cancel

o\
—
—

7
\

6. Enter the project name for which you want to import the legacy code in the Project
Name text box.

7. Enter the root task prototype as a VOID uITRONRoot (UNSIGNED argv) ;, next to
Root Task Prototype text box as shown in Figure 5_27.

8. Enter the root task stack size, next to the Root Task Stack Size text box as shown.
The value should be in bytes.
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9. Click Finish to complete the importing of legacy code into AppCOE . You can see

micro-ITRON legacy code you have imported as shown in Figure 5_27.

Figure 5_27: Importing micro-ITRON Legacy Code Output
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B % Debug ([ Projecis) @ Profiler
[E) C/C++ Projects 53 =0
CAR=T

3 “‘}I derno_ada to_c
' [: demo_cross_os
s [: demo_nucleus
v [: deme_posix
' [: demo_psos
3 C demo_uitron
v [: demo_vxworks
> [: demo_windows
3 [: nucleus_legacy
3 [: posix_legacy
s [: psos_legacy
4 [: uitron_legacy
> |[plt Includes
> |72 include
4 |[=- source
s [ include
> (= init
4 |[= source
> application.c
> console.c
> os_application_start.c

EA Problems | & Console | & Properties ﬁ-Debug 33

1 10 items selected

A

10. You have successfully imported micro-ITRON legacy C code and a project with your

given project name is created in the current workspace.
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Porting Windows Legacy ‘C’ Code

This section explains porting of Windows Legacy Applications using AppCOE Porting Plug-
in. A sample porting of Windows Legacy applications using AppCOE is described with an
example here.

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

1. Select Tools> Porting >Windows> Import Legacy ‘C’ Code as shown inFigure

5_28. You can also click on the Porting icon from the task bar.

Figure 5_28: Importing Windows Legacy ‘C’ Code in AppCOE

Projects - Application Common Operating Environment (AppCOE) o & |3
File Edit Source Refactor MNavigate Search Project Tools Run Window Help
Wi | & L. R4 F-O-Q- I - - - v | o
VxWorks k ia Projects Profiler
= SOS » _
B C/C++ Projects 2 | P 8
e Nucleus >
= SIS S
AP demo_ada_to_c Thle‘a‘d,«
[: demo_cross_os POSIX L4
c demo_nucleus micro-ITRON |
C deme_posix Windows » [ €3 Import Legacy 'C’ Code
C demo_psos
r,: demo_threadx
C demo_uitron
C demo_vxworks
C demo_windows
1% Problems | Bl Console 52 | E Properties Colgm RS Im)
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3. On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing a
application project for example purpose.

4. Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Next as shown inFigure 5_29.

S. On Select Host Library Configuration window, select OS Abstractor Process Mode if
the imported application runs in multiple process
Figure 5_29: Import Windows Legacy Code

| &2 Import o |[@] =]

Select a Directory te Import Windows Legacy Code into AppCOE.

Import Windows Legacy Code ‘R

@ Import Application Project Import Library Project
Reot Directory E\Examples\LegacyDemos'\Legacy_Windows_App
Project Name: windows_legacy
Reot Task Prototype: int win_main(int argcj;

Root Task Stack Size(in bytes): OS_MIN_STACK_SIZE

Host Library Configuration
("] OS Abstractor Process Mode Enabled

(?) [ Finish ] [ Cancel

N/

6. Enter the project name for which you want to import the legacy code in the Project

MAPUSDFT

Name text box as shown in the Figure 5_29.

Enter the root task prototype like int win main(intargc); next to Root Task
Prototype text box as shown in the Figure 5_29.

Enter the root task stack size, next to the Root Task Stack Size text box as shown
in the Figure 5_29. The value should be in bytes.
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9. Click Finish to complete the importing of legacy code into AppCOE. You can see
Windows legacy C code you have imported as shown in Figure 5_30.

Figure 5_30: Importing Windows Legacy Code Output

(2 Projects - Application Cammen Operating Enviranmen - e s
Eile Edit Source Refactor Mavigate Search Run Project Tools Window Help
o - E RB G B PO Hr Lot
=] {&Dehug P, Profiler i
[E) €/C++ Projects &3 =0 =0
R

v “‘}I demo_ada_to ¢
' [: demo_cross_os
s [: demo_nucleus
v [: deme_posix
' [: demo_psos
3 C demo_uitron
v [: demo_vxworks
> [: demo_windows
3 [: nucleus_legacy
3 [: posix_legacy
s [: psos_legacy
3 [: uitron_legacy
Pl [: win_Legacy
> |[al) Includes
» |22 include
4 |[= source
> (= init
4 |[= source
> events.c
» mutex.c
> os_application_start.c
> wait.c I

[£1 Problems | B Console | =1 Properties | % Debug | =3 Y =0

1 10 items selected

You have successfully imported Windows legacy code and a project with your given project
name is created in the current workspace.

Note: Legacywindows is supported only when process mode is true, so the user might
always check out the OS Abstractor Process Mode Enabled.
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Porting uC/0OS Legacy ‘C’ Code

This section explains porting of uC/OS Legacy Applications using AppCOE Porting Plugin. A
sample porting of uC/OS Legacy applications using AppCOE is described with an example
here.

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

1. Select Tools> Porting >uC/0S> Import Legacy ‘C’ Code as shown inFigure 5_31.
You can also click on the Porting icon from the task bar.

Figure 5_31: Importing nC/OSLegacy ‘C’ Code in AppCOE

Projects - Applicatin Common Opersting Environment (AppCOE) - X
Eile Edit Source Refactor Navigste Search Project ook Run Window Help
ek | & Optimized Target Code Generater ‘ ERA R R Bl oD [ | |2 Projects () Profiler
e oo @ Update Settings =
TR C/C+ Projects 88 " s 5

License 5
i} demo_oda_to.s

[ demo cross ox = Full bty Peckage Genertor

I demo_freertos €3 Porting > VWorks >
[ demo_nucleus T pSO0S >
L demo_posix Nucleus »
! demo_psos —— R
[ demo_threadx rea
T demo_ucos POSIX 4
[ demo_uitron micro-ITRON >
[ demo_nworks Windows »
| demo_windows! p—. N
>

5 Import Legacy 'C’ Code ucos

1% Problems | B Console 22 | ] Properties S48 EERl#tE-r9-=0
COT Build Console [freertos_legacy]
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3. On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing a
application project for example purpose.

4. Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Next as shown in Figure 5_32.

S. On Select Host Library Configuration window, selectOS Abstractor Process Mode if
the imported application runs in multiple process
Figure 5_32: Import nC/0OS Legacy Code Window

1 L9 Import O X

@

Import uCOS-lll Legacy Code ‘N

Select a Directory to Import uCO5-1ll Legacy Code inte AppCOE.

(®) Import Application Project Import Library Project
Root Directory | B:i\Legacy_projects\ucos_legacy | Browse...

Project Mame: | ucos_legacy| |
Root Task Prototype : | VOID ApplicationTaskStart (WVOID *p_arg) |
Root Task Stack Size(in bytes) : | O5_MIN_STACK_SIZE |

Host Library Configuration
[ ] 05 Abstractor Process Mode Enabled

MAPUSDFT

Enter the project name for which you want to import the legacy code in the Project
Name text box.

Enter the root task prototype as VOID ApplicationTaskStart(VOID *p_arg);, next to
Root Task Prototype text box as shown in Figure 5_32.

Enter the root task stack size, next to the Root Task Stack Size text box as shown.
The value should be in bytes.
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9. Click Finish to complete the importing of legacy code into AppCOE . You can see
uC/OS legacy code you have imported as shown in Figure 5_33.

Figure 5_33: Importing uC/OS Legacy Code Output

Projects - Application Common Operating Environment (AppCOE) - X
File Edit Source Refactor Navigate Search Project Tools Run Window Help
[~ | ) ’S ~ P’ B %‘3 Q- % AT TE T (=g " % f:fl Projects [ Profiler
TE C/Ce+ Projects £ | A& =0 =0

AW demo_ada_to_c
[: demo_cross_os
demo_freertos
demo_nucleus
demo_posix
demo_psos
demo_threadx

demo_uitron

demo_wworks

demo_windows

ucos_legacy

v [l Includes

(% A/MapuSoft/AppCOE x32_1.5int] /mingw/inclu
@ A:/MapuSoft/AppCOE x32_1.5int1/mingw/Tib/g:
(3 A/MapuSoft/AppCOE x32.1.5int/mingw/lib/g:
[® A/MapuSoft/AppCOE_132_1.5int1/plugins/map
(B A/MapuSoft/AppCOE_132_1.Sint1/plugins/map
(8 A/MapuSoft/AppCOE 132_1.5int!/plugins/map
1 ucos_legacyfinclude

IO,

v (= include

o5 application starth 21 problems | Bl Console 2 | = Properties &4 Q;}‘ B EE "‘ #E 8= 0
v (5 source ) COT Build Console [demo_ucos]
[ include
(= int
[ source
8 >

10. You have successfully imported uC/OS legacy C code and a project with your given
project name is created in the current workspace.
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Porting FreeRTOSLegacy ‘C’ Code

This section explains porting of FreeRTOSLegacy Applications using AppCOE Porting
Plugin. A sample porting of FreeRTOS Legacy applications using AppCOE is described with
an example here.

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

1. Select Tools> Porting >FreeRTOS> Import Legacy ‘C’ Code as shown inFigure
5_34. You can also click on the Porting icon from the task bar.

Figure 5_34: Importing FreeRTOSLegacy ‘C’ Code in AppCOE

Prajects - Application Common Operating Environment (AppCOE) - X
File Edit Source Refactor Mevigate Search Project |Tools Run Window Help
i | i@ Optimized Target Code Generator ‘ FH-Q - QA P il oDy ‘ 5| [ Projects (2 Profiler
Update Settings
B C/C+ Projects 17 A =0
License >
¥ demo_ada to_
c demo_cross_os Full Library Package Generator
!: demo_freertos| €3 Porting > VuWorks >
[ deme_nucleus pSOS. >
! demo_posic Nucleus N
L demo_psos S R
L demao_threads e
I demo_ucos POSIX 2
: demo_uitron micro-ITRON ¥
L, demo.ovorks Windows >
[, dema windows!
M (3 Import Legacy 'C' Code FreeRTOS »
uCos >
. Problems| Bl Censole 52 | = Properies G o8| Bk #tE-9-°6

COT Build Console [freertos_legacy]
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3. On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing a
application project for example purpose.

4. Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Next as shown in Figure 5_35.

S. On Select Host Library Configuration window, select OS Abstractor Process Mode if
the imported application runs in multiple process

Figure 5_35: Import FreeRTOSLegacy Code Window

L5 Import O et

Import FreeRTOS Legacy Code ‘H

Select a Directory to Import FreeRTOS Legacy Code inte AppCOE.

(®) Import Application Project Import Library Project

Root Directory | B:\Legacy_prnjects\freertns_legac:,ri Browse...

Project Mame: | freertos_legacy |

Root Task Prototype : | void freeRTOSRoot(void® param) |

Root Task Stack Size(in bytes) : | 05_MIN_STACK_SIZE |

Host Library Configuration
[] 0% Abstractor Process Mede Enabled

=

6. Enter the project name for which you want to import the legacy code in the Project

Name text box.
7. Enter the root task prototype as void freeRTOSRoot(void* param);, next to Root

Task Prototype text box as shown inFigure 5_35.
8. Enter the root task stack size, next to the Root Task Stack Size text box as shown.
The value should be in bytes.
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9. Click Finish to complete the importing of legacy code into AppCOE . You can see
FreeRTOSlegacy code you have imported as shown in Figure 5_36.

Figure 5_36: Importing FreeRTOS Legacy Code Output

Projects - Application Common Operating Environment (AppCOE)
File Edit Source Refactor Mavigate Search Project Tools Run Window Help
i ‘n'l'v KB~ FvQ- QA LR TRA R '|” Ef‘ Projects () Profiler
TR C/Ce+ Projects 21 | Eg Y=08 =8

) demo_ada_to_c

[ 4

| demo_cross_os
k| (oM C10%. 05
4

i

[, demo_nucleus

-

[, demo_posix

-

L demo_psos

[ demo_threadk

r

e dEMO_UCOS
E dema_uitron
[: dema_works
[: dema_windows

v [: freertos_legacy

v i)l Includes

(1% As/MapuSeft/AppCOE x32_1.5int]/mingw/inclu
(1= A:/MapuSoft/AppCOE x32_15int1/mingwlib/g
(1% As/MapuSoft/AppCOE 332 1.5int1/mingw/lib/g.
(= A/MapuSoft/AppCOE x32_1.5int1/plugins/map
(1 Ay/MapuSeft/AppCOE 332 1.5int1/plugins/map
(= A/MapuSoft/AppCOE x32_1.5int1/plugins/map
[ freertos_legacy/include

@ freertos_legacy/include

! freertos_legacy/source/include

%1 Problems | BJ Console 52 | = Propetties

v = include No consoles to display at this time.

[n] 0s_application_start.h
v [ source
(= include

(= init
(= source

10. You have successfully imported FreeRTOS legacy C code and a project with your
given project name is created in the current workspace.

Porting VRTXLegacy ‘C’ Code

This section explains porting of VRTX Legacy Applications using AppCOE Porting Plugin. A
sample porting of VRTX Legacy applications using AppCOE is described with an example
here.

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

1. Select Tools> Porting >VRTX> Import Legacy ‘C’ Code as shown inFigure 5_37.

You can also click on the Porting icon from the task bar.

Figure 5_37: Importing VRTX Legacy ‘C’ Code in AppCOE
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(2 Projects - Application Commen Operating Environment (AppCOE) - I3
File Edit Source Refactor Navigete Search Project Run Tools Window Help
(md | G (1 BB H-0-Q-gr 5 T [ || Projects | (2 Profiler
[ C/C = Projects 52 R Ve ? =g
pSOS >
[ demo_cross_os
[ demo_freertos fed s D
L demo_nucleus ThreadX >
! deme_posix POSIX >
L] deme_pses micro-ITRON >
[ demo_gnx
] demo_tlinux Windows ’
L demo_threadx FreeRTOS >
Ll demo_ucos ucos >
>
>

L geme.uitron VRTX (3 Import Legacy 'C' Code
d b

L demo_w onx

. demo_vworks

. demo_windows RTLinux >

& Console 52 ~Cr=0O

Mo consoles to display at this time.

] . = g _ 0324PM
ﬂ A Type here to search i B | & & o ) N6 o, B

2. On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing a
application project for example purpose.

3. Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Next as shown in Figure 5_38.

4. On Select Host Library Configuration window, select OS Abstractor Process Mode if
the imported application runs in multiple process

Figure 5_38: Import VRTX Legacy Code Window
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Import ¥RTX Legacy Code ‘H

Select a Directory to Import VRTX Legacy Code into AppCOE,

(®) Import Application Project Import Library Project

Root Directory | D\LegacyDemosivrt_legacy Browse...

Project Mame : |~.rrbc:_legac3,r |

Root Task Prototype : | void vrte_ro Dt_functiDnCI;| |

Root Task Stack Size(in bytes) : | OS_MIN_STACK_SIZE |

Host Library Configuration
[] 0% Abstractor Process Mode Enabled
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S. Enter the project name for which you want to import the legacy code in the Project

Name text box.

6. Enter the root task prototype as void vrtx root_function();,next to Root Task

Prototype text box as shown in Figure 5_38.

7. Enter the root task stack size, next to the Root Task Stack Size text box as shown.

The value should be in bytes.
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8. Click Finish to complete the importing of legacy code into AppCOE. You can see
VRTXlegacy code you have imported as shown in Figure 5_39.

Figure 5_39: Importing VRTX Legacy Code Output

(Z) Projects - Application Common Operating Environmen it (AppCOE) - x
File Edit Source Refactor Navigate Search Project Run Tools Window Help
Dl | o [ -2 H-0-Q-F-p-h - o [ || Projects (2 Profiler
Bg v = 0o =5
C demo_nucleus
[ demo_posix
' demo_psos
! demo_anx
L demo_rtlinux
C demo_threadx
[’ demo_ucos
[’ demo_uits
. demo_vrix
L demo_wworks
[ demo_windows
v [ vrtc_legacy
il Includes
(= include
v (= source
(= include
= init
~ (= source
£ application.c
[£] os_application_start.c
& Console 32 oG AR MB-Or= B
COT Build Console [vrbx_legacy]
9items selected
s . o . e _ 0343PM
H P Type here to search ; r 14 ~ G oz m ) NG Gy B

9. You have successfully imported VRTX legacy C code and a project with your given
project name is created in the current workspace.

Porting QNXLegacy ‘C’ Code

This section explains porting of QNX Legacy Applications using AppCOE Porting Plugin. A
sample porting of QNX Legacy applications using AppCOE is described with an example
here.

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

1. Select Tools> Porting >QNX> Import Legacy ‘C’ Code as shown inFigure 5_40. You

can also click on the Porting icon & from the task bar.

Figure 5_40: Importing QNX Legacy ‘C’ Code in AppCOE

MAPUSLFT

131



http://mapusoft.com/downloads/AppCOE-evaluation/
http://mapusoft.com/downloads/AppCOE-evaluation/

MAPUSLDFT

Application Common Operating Environment User Manual

(2 Projects - Application Commen Operating Envirenment (AppCOE) - X
File Edit Source Refactor Navigate Scarch Project Run Tools Window Help
(mid | G (s BB H-0-Q-gr 5 o [ || Projects (2 Profiler
[ C/C = Projects 52 R Ve ? =g
pSOS >
[ demo_cross_os
[ demo_freertos fed s D
C! demo_nucleus ThreadX >
! deme_posix POSIX >
L] deme_pses micro-ITRON >
[ demo_gnx
] demo_tlinux Windows ’
L demo_threadx FreeRTOS >
Ll demo_ucos ucos >
. demo_uitron VRTX 5
L7 demo it QNX > & ImportLegacyC Cod
L demo_wworks e
L demo_windows RICE 2
& Console 52 -or=0
Mo consoles to display at this time.
: . - - > _ 03:24PM
ﬂ A Type here to search B & £ g o) N6 o, B

2. On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing a
application project for example purpose.

3. Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Next as shown in Figure 5_41.

4. On Select Host Library Configuration window, select OS Abstractor Process Mode if
the imported application runs in multiple process

Figure 5_41: Import QNXLegacy Code Window
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L& Import O x

Import QN Legacy Code ‘H

Select a Directory to Import GMX Legacy Code into AppCOE.

(®) Import Application Project Import Library Project

Root Directory | D\LegacyDemos\gnx_legacy | Browse...

Project Mame: | gnx_legacy |

Root Task Prototype : | VOID root_thread_entry_function( void *arg1:|;| |

Root Task Stack Size(in bytes) : | 05_MIN_STACK_SIZE |

Host Library Configuration
[ ] 05 Abstractor Process Mode Enabled

S. Enter the project name for which you want to import the legacy code in the Project
Name text box.

6. Enter the root task prototype as VOID root_thread_entry function( void
*argl);,next to Root Task Prototype text box as shown in Figure 5_41.

7. Enter the root task stack size, next to the Root Task Stack Size text box as shown.
The value should be in bytes.
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8. Click Finish to complete the importing of legacy code into AppCOE. You can see
QNXlegacy code you have imported as shown in Figure 5_42.

Figure 5_42: Importing QNX Legacy Code Output

Projects - Application Common Operating Environmen t (AppCOE) - X
File Edit Source Refactor Navigate Search Project Run Tools Window Help
i = [ R H-0-Q--E-0 o [ || Projects (2 Profiler
Bg v = 0o =5
C demo_nucleus
[ demo_posix
' demo_psos
! demo_anx
L demo_rtlinux
C demo_threadx
[’ demo_ucos
[’ demo_uits
. demo_vrix
L demo_wworks
[ demo_windows
v [ an_legacy
il Includes
(= include
v (= source
(= include
= init
~ (= source
£ application.c
[£] os_application_start.c
& Console 32 oG AR MB-Or= B
COT Build Console [gy_legacy]
9items selected
i . B = o _ 0352PM
H P Type here to search ; |4 3 G oz W ) NG Gy, B

9. You have successfully imported QNX legacy C code and a project with your given
project name is created in the current workspace.

Porting RTLINUXLegacy ‘C’ Code

This section explains porting of RTLINUX Legacy Applications using AppCOE Porting
Plugin. A sample porting of RTLINUX Legacy applications using AppCOE is described with
an example here.

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

1. Select Tools> Porting >RTLINUX> Import Legacy ‘C’ Code as shown inFigure
5_43. You can also click on the Porting icon from the task bar.

Figure 5_43: Importing RTLINUX Legacy ‘C’ Code in AppCOE
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(2 Projects - Application Common Operating Environment (AppCOE) - x
File Edit Source Refactor Navigate Search Project Run Tools Window Help
(md | G (=3¢ BB H-0-Q-gr 5 o [ || Projects | (2 Profiler
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L demo_threadx FreeRTOS >
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d b
] demo.v o §
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2. On AppCOE Import Window select the Import Application Project/Library Project
radio button with reference to your project. Here we are considering importing a
application project for example purpose.

3. Select the root directory from where you want to import the legacy code by clicking
on Browse button next to the text box, and click Next as shown in Figure 5_44.

4. On Select Host Library Configuration window, select OS Abstractor Process Mode if
the imported application runs in multiple process

Figure 5_44: Import RTLINUX Legacy Code Window
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L5 Import O oy

Import RTLINUX Legacy Code ‘N

Select a Directory to Import RTLINUX Legacy Code into AppCOE.

(®) Import Application Project Import Library Project

Root Directory | D\LegacyDemoshrtlinux_legacy | Browse...

Project Mame : | rtlinux_legacy |

Root Task Prototype: | YOID * rtlinux_root_function(veid * arg);

Root Task Stack Size(in bytes) : | 05_MIN_STACK_SIZE |

Host Library Configuration
[] 05 Abstractor Process Mode Enabled

S. Enter the project name for which you want to import the legacy code in the Project
Name text box.

6. Enter the root task prototype as VOID * rtlinux_root_function(void * arg);,next to
Root Task Prototype text box as shown in Figure 5 44.

7. Enter the root task stack size, next to the Root Task Stack Size text box as shown.
The value should be in bytes.
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8. Click Finish to complete the importing of legacy code into AppCOE. You can see
RTLINUXlegacy code you have imported as shown in Figure 5_45.

Figure 5_45: Importing RTLINUX Legacy Code Output
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9. You have successfully imported RTLINUX legacy C code and a project with your
given project name is created in the current workspace.
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Building OS Abstractor Interface Library

Before using OS Abstractor Interface, make sure the OS and tools are configured correctly
for your target. To ensure this, compile, link and execute a native sample demo application
that is provided by the OS vendor on your target. Refer to the OS vendor provided
documentation on how to compile, link, download, and debug the demo applications for
your specific target and toolset. After this step, you are ready to use the OS Abstractor
Interface library to develop your applications.

Building OS Abstractor Interface Demo Application

The demo application is located at the \mapusoft\demo_cross_os directory location. From
this location, you will find the make files or project files at the appropriate
specific/<OS>/<tool>/<target> directory. For instance, if you need the demo application to
be built for Windows OS using visual studio 12 tools and for x86 target, then the make file
location will be at specific\windows\x86\vsnet2012 directory.

OS Changer VxWorks Interface

The OS Changer Nucleus Interface library contains the following modules

Table 5 1: VxWorks Interface Header File

Module Description

vxworks_interface.h This header file is required in all of the VxWorks
source modules. This header file provides the
translation layer between the VxWorks defines, APIs
and parameters to OS Abstraction

The OS Changer VxWorks Interface OS Changer OS Changer VxWorks Interface demo
contains the following modules:

Table 5_2: VxWorks Interface Demo Application File

Module Description
demo.c Contains a sample demo application

Building OS Changer VxWorks Interface

Before building the VxWorks Interface library and/or application, ensure that the flag
INCLUDE_OS_VxWorks is set to OS_TRUE in the cross_os_usr.h configuration file.

Building OS Changer VxWorks Interface Library

The VxWorkslInterface library is located at \mapusoft\ vxworks_interface directory. From
this location, you will find the make files or project files at the appropriate
specific/<OS>/<tool>/<target> directory. For instance, if you need the demo application to
be built for VxWorks OS using Eclipse tools and for x86 targets, then the make file location
will be at specific\vxworks\<OS>\x86\eclipse directory.

Building OS Changer VxWorks Interface Demo Application

The demo application is located at the \mapusoft\ demo_vxworks directory location. From
this location, you will find the make files or project files at the appropriate
specific/<OS>/<tools>/<target> directory. For instance, if you need the demo application
to be built for VxWorks OS using Eclipse tools and for x86 targets, then the make file
location will be at specific\vxworks_interface\<OS>\x86\eclipse directory.
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OS Changer POSIX/LINUX Interface
The OS Changer POSIX/LINUX Interface library contains the following modules:

Table 5 3: Posix Interface Header File

Module Description

posix_interface.h This header file is required in all of the POSIX/LINUX
source modules. This header file provides the
translation layer between the POSIX/LINUX defines,
APIs and parameters to OS Abstraction

The POSIX/LINUX Interface demo contains the following modules:

Table 5_4: POSIX/LINUX Interface Demo Application File

Module Description
demo.c Contains a sample demo application

Building OS Changer POSIX/LINUXInterface

Before building the POSIX/LINUX Interface library and/or application, ensure that the flags
INCLUDE_OS_POSIX is set to OS_TRUE in the cross_os_usr.h configuration file.

Building OS Changer POSIX/LINUX Interface Library

The OS Changer POSIX/LINUX Interface library is located at \mapusoft\posix_interface
directory. From this location, you will find the make files or project files at the appropriate
specific/<OS>/<tool>/<target> directory. For instance, if you need the demo application to
be built for POSIX/LINUX OS using Eclipse tools and for x86 targets, then the make file
location will be at specific\posix\<OS>\x86\elipse directory.

BuildingOS ChangerPOSIX/LINUX Interface Demo Application

The demo application is located at the \mapusoft\demo_posix directory location. From this
location, you will find the make files or project files at the appropriate
specific/<OS>/<tools>/<target> directory. For instance, if you need the demo application to
be built for POSIX/LINUX OS using Eclipse tools and for x86 target, then the make file
location will be at specific\posix\<OS>\x86\eclipse directory. We need to have the OS
Abstractor Interface Library. It has to be included in all the Interface demos.

After every demo application, include/link in the POSIX/LINUX Interface library.

OS Changer Nucleus Interface

The OS Changer Nucleus Interface library contains the following modules:

Table 5 5: Nucleus Interface Header File

Module Description

nucleus_interface.h This header file is required in all of the Nucleus PLUS
source modules. This header file provides the
translation layer between the Nucleus PLUS defines,
APIs and parameters to OS Abstraction

The OS Changer Nucleus Interface demo contains the following modules:

Table 5_6: Nucleus Interface Demo Application File

Module Description
demo.c Contains a sample demo application
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Building OS Changer Nucleus Interface

Before building the OS Changer Nucleus Interface library and/or application, ensure that
the flag INCLUDE_OS_Nucleus is set to OS_TRUE in the cross_os_usr.h configuration file.

Building OS Changer Nucleus Interface Library

The Nucleus Interface library is located at \mapusoft\nucleus_interface directory. From
this location, you will find the make files or project files at the appropriate
specific/<OS>/<tool>/<target> directory. For instance, if you need the demo application to
be built for Nucleus OS using Eclipse tools and for x86 targets, then the make file location
will be at specific\nucleus\<OS>\x86\eclipse directory.

Building OS Changer Nucleus Interface Demo Application

The demo application is located at the \mapusoft\ demo_nucleus directory location. From
this location, you will find the make files or project files at the appropriate
specific/<OS>/<tools>/<target> directory. For instance, if you need the demo application
to be built for Nucleus OS using Eclipse tools and for x86 targets, then the make file
location will be at specific\nucleus\<OS>\x86\eclipse directory.

OS Changer ThreadX Interface
The OS Changer ThreadX Interface library contains the following modules:

Table 5 7: ThreadX Interface Header File

Module Description

threadx_interface.h This header file is required in all of the ThreadX
source modules. This header file provides the
translation layer between the ThreadX defines, APIs
and parameters to OS Abstraction

The OS Changer ThreadX Interface demo contains the following modules:

Table 5_8: Nucleus Interface Demo Application File

Module Description
demo.c Contains a sample demo application

Building OS Changer ThreadX Interface

Before building the OS Changer ThreadX Interface library and/or application, ensure that
the flag INCLUDE_OS_ThreadX is set to OS_TRUE in the cross_os_usr.h configuration file.

Building OS Changer ThreadX Interface Library

The ThreadX Interface library is located at \mapusoft\ThreadX_ interface directory. From
this location, you will find the make files or project files at the appropriate
specific/<OS>/<tool>/<target> directory. For instance, if you need the demo application to
be built for ThreadX OS using Eclipse tools and for x86 target, then the make file location
will be at specific\ThreadX\<OS>\x86\eclipse directory.

Building OS Changer ThreadX Interface Demo Application

The demo application is located at the \mapusoft\ demo_ThreadX directory location. From
this location, you will find the make files or project files at the appropriate
specific/<OS>/<tools>/<target> directory. For instance, if you need the demo application
to be built for ThreadX OS using Eclipse tools and for x86 target, then the make file
location will be at specific\ThreadX\<OS>\x86\eclipse directory.

OS Changer pSOS Interface

The pSOS Interface library contains the following modules:
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Table 5_9: pSOS Interface Header File

Module Description

psos_interface.h This header file is required in all of the pSOS source
modules. This header file provides the translation
layer between the pSOS defines, APIs and parameters
to OS Abstraction

The pSOS Interface demo contains the following modules:

Table 5_10: pSOS Interface Demo Application File

Module Description
demo.c Contains a sample demo application

Building OS Changer pSOS Interface

Before building the pSOS Interface library and/or application, ensure that the flag
INCLUDE_OS_pSOS is set to OS_TRUE in the cross_os_usr.h configuration file.

Building OS Changer pSOS Interface Library

The pSOS Interface library is located at \mapusoft\ psos_interface directory. From this
location, you will find the make files or project files at the appropriate
specific/<OS>/<tool>/<target> directory. For instance, if you need the demo application to
be built for pSOS OS using Eclipse tools and for x86 target, then the make file location will
be at specific\psos_interface/<OS>\x86\eclipse directory.

Building OS Changer pSOS Interface Demo Application

The demo application is located at the \mapusoft\ demo_pSOS directory location. From
this location, you will find the make files or project files at the appropriate
specific/<OS>/<tools>/<target> directory. For instance, if you need the demo application
to be built for pSOS OS using eclipse tools and for x86 target, then the make file location
will be at specific\psos\<OS>\x86\eclipse directory.

OS Changer micro-ITRON Interface
The OS Changer micro-ITRON Interface library contains the following modules:

Table 5_11: OS Changer micro-ITRON Interface Header File

Module Description

uitron_interface.h This header file is required in all of the uITRON source
modules. This header file provides the translation
layer between the ulTRON defines, APIs and
parameters to OS Abstraction

The OS Changer micro-ITRON Interface demo contains the following modules:

Table 5_12: OS Changer micro-ITRON Interface Demo Application File

Module Description
demo.c Contains a sample demo application

Building OS Changer micro-ITRON Interface

Before building the OS Abstractor micro-ITRON Interface library and/or application, ensure
that the flag INCLUDE_OS_UITRON is set to OS_TRUE in the cross_os_usr.h configuration
file.
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Building OS Changer micro-ITRON Interface Library

The OS Abstractor micro-ITRON Interface library is located at \mapusoft\uitron_interface
directory. From this location, you will find the make files or project files at the appropriate
specific/<OS>/<tool>/<target> directory. For instance, if you need the demo application to
be built for ulITRON OS using Eclipse tools and for x86 target, then the make file location
will be at specific\uitron\<OS>\x86\eclipse directory.

Building OS Changer micro-ITRON Interface Demo Application

The demo application is located at the \mapusoft\demo_uitron directory location. From this
location, you will find the make files or project files at the appropriate
specific/<OS>/<tools>/<target> directory. For instance, if you need the demo application
to be built for micro-ITRON OS using Eclipse tools and for x86 targets, then the make file
location will be at specific\uitron\<OS>\x86\eclipse directory.

OS Changer uC/0OS Interface
The pC/OS Interface library contains the following modules:
Table 5_13: OS Changer uC/OSInterface Header File

Module Description

ucos_interface.h This header file is required in all of the uCOS source
modules. This header file provides the translation
layer between the uCOS defines, APIs and parameters
to OS Abstraction

The uC/OS Interface demo contains the following modules:

Table 5_14: uC/OS Interface Demo Application File

Module Description
demo.c Contains a sample demo application

Building OS Changer uC/OS Interface

Before building the OS Abstractor uC/OS Interface library and/or application, ensure that
the flag INCLUDE_OS_UCOS is set to OS_TRUE in the cross_os_usr.h configuration file.

Building OS Changer uC/OS Interface Library

The OS Abstractor pC/OS Interface library is located at \mapusoft\ucos_interface
directory. From this location, you will find the make files or project files at the appropriate
specific/<OS>/<tool>/<target> directory. For instance, if you need the demo application to
be built for uC/OS using Eclipse tools and for x86 target, then the make file location will be
at specific\ucos\<0OS>\x86\eclipse directory.

Building OS Changer uC/0OS Interface Demo Application

The demo application is located at the \mapusoft\demo_ucos directory location. From this
location, you will find the make files or project files at the appropriate
specific/<OS>/<tools>/<target> directory. For instance, if you need the demo application
to be built for uC/OS using Eclipse tools and for x86 targets, then the make file location will
be at specific\ucos\<OS>\x86\eclipse directory.

OS Changer FreeRTOS Interface
The FreeRTOS Interface library contains the following modules:
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Table 5_15: OS Changer FreeRTOSInterface Header File

Module Description

freertos_interface.h This header file is required in all of the freertos source
modules. This header file provides the translation
layer between the freertos defines, APIs and
parameters to OS Abstraction

The freertos Interface demo contains the following modules:

Table 5_16: FreeRTOSInterface Demo Application File

Module Description
demo.c Contains a sample demo application

Building OS Changer FreeRTOS Interface

Before building the OS Abstractor freertos Interface library and/or application, ensure that
the flag INCLUDE_OS_FREERTOS is set to OS_TRUE in the cross_os_usr.h configuration
file.

Building OS Changer FreeRTOS Interface Library

The OS Abstractor freertos Interface library is located at \mapusoft\freertos_interface
directory. From this location, you will find the make files or project files at the appropriate
specific/<OS>/<tool>/<target> directory. For instance, if you need the demo application to
be built for freertos using Eclipse tools and for x86 target, then the make file location will be
at specific\freertos\<OS>\x86\eclipse directory.

Building OS Changer FreeRTOS Interface Demo Application

The demo application is located at the \mapusoft\demo_freertos directory location. From
this location, you will find the make files or project files at the appropriate
specific/<OS>/<tools>/<target> directory. For instance, if you need the demo application
to be built for freertos using Eclipse tools and for x86 targets, then the make file location
will be at specific\freertos\<OS>\x86\eclipse directory.

OS Changer RTLinux Interface
The RTLinux Interface library contains the following modules:
Table 5_17: OS Changer RTLinuxInterface Header File

Module Description

rtlinux_interface.h This header file is required in all of the rtlinux source
modules. This header file provides the translation
layer between the rtlinux defines, APIs and
parameters to OS Abstraction

The rtlinux Interface demo contains the following modules:

Table 5_18: RTLinux Interface Demo Application File

Module Description
demo.c Contains a sample demo application

Building OS Changer RTLinux Interface

Before building the OS Abstractor rtlinux Interface library and/or application, ensure that
the flag INCLUDE_OS_RTLINUX is set to OS_TRUE in the cross_os_usr.h configuration file.
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Building OS Changer RTLinux Interface Library

The OS Abstractor rtlinux Interface library is located at \mapusoft\rtlinux_interface
directory. From this location, you will find the make files or project files at the appropriate
specific/<OS>/<tool>/<target> directory. For instance, if you need the demo application to
be built for rtlinux using Eclipse tools and for x86 target, then the make file location will be
at specific\rtlinux\<OS>\x86\eclipse directory.

Building OS Changer RTLinux Interface Demo Application

The demo application is located at the \mapusoft\demo_rtlinux directory location. From
this location, you will find the make files or project files at the appropriate
specific/<OS>/<tools>/<target> directory. For instance, if you need the demo application
to be built for rtlinux using Eclipse tools and for x86 targets, then the make file location will
be at specific\rtlinux\<0OS>\x86\eclipse directory.

OS Changer Windows Interface

The OS Changer Windows Interface library contains the following modules:

Table 5_19: OS Changer Windows Interface Header File

Module Description

windows_interface.h This header file is required in all of the Windows
source modules. This header file provides the
translation layer between the Windows defines, APIs
and parameters to OS Abstraction

The Windows Interface demo contains the following modules:

Table 5_20: Windows Interface Demo Application File

Module Description
demo.c Contains a sample demo application

Building OS Changer Windows Interface

Before building the WINDOWS Interface library and/or application, ensure that the flags
INCLUDE_OS_WINDOWS and INCLUDE _OS_PROCESS are set to OS_TRUE in the
cross_os_usr.h configuration file.

Building OS Changer Windows Interface Library

The WINDOWS Interface library is located at \mapusoft\windows_interface directory. From
this location, you will find the make files or project files at the appropriate
specific/<OS> /<tool>/<target> directory. For instance, if you need the demo application to
be built for WINDOWS OS using Eclipse tools and for x86 target, then the make file location
will be at specific\windows\<OS>\x86\eclipse directory.

Building OS Changer Windows Interface Demo Application

The demo application is located at the \mapusoft\demo_windows directory location. From
this location, you will find the make files or project files at the appropriate
specific/<OS>/<tools>/<target> directory. For instance, if you need the demo application to
be built for Windows OS using Eclipse tools and for x86 target, then the make file location
will be at specific\windows\<OS>\x86\eclipse directory. We need to have the OS Abstractor
Interface Library. It has to be included in all the Interface demos.

Building Application with Multiple Interface Components

MapuSoft provides a feature to build application with multiple interfaces. For example; you
can build an application with both Nucleus and VxWorks interfaces.
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Building Application with Multiple Interfaces

Before building the multiple Interface library and/or application, ensure that the
corresponding flags are set to OS_TRUE in the cross_os_usr.h configuration file.

For instance; If you want to build an application with both Nucleus and VxWorks
interfaces, set INCLUDE_0OS NUCLEUS and INCLUDE OS_ VXWORKSasOS_TRUE.

Developing Applications with Multiple Interfaces
The steps for developing applications on host targets are described as follows:
1. Include os_target.h in all your application source files.

2. Set the appropriate compiler switches within the project build files to indicate the
target OS and other target configurations.

3. Initialize the OS Abstractor library by calling OS_Application_Init() function. If you
are also using POSIX/LINUX Interface, then also use OS_Posix_Init() function call
to initialize the POSIX/LINUX component as well. For instance, to develop an
application with both Nucleus and VxWorks application development, go to
os_library_init.c and give your appropriate entry function in
NUCLEUS_ENTRY_FUNCTION. Define the name of the Nucleus entry task. The
default entry task is NU_ROOT. Give your appropriate entry function in
VXWORKS_ENTRY_FUNCTION. You also have to give the appropriate stack size for
your entry function in VXWORKS_ENTRY_FUNCTION_STACK_SIZE. The default
stack size given by MapuSoft is OS_MIN_STACK_SIZE. In the main thread, call
OS_Application_Wait_For_End() function to suspend the main thread and wait for
application re-start or termination requests.

Compile and link your application using development tools provided by Mapusoft.

Download the complete application image to the target system and let it run.

Refer to the sample demo applications provided with OS Abstractor as a reference point to
start your application. Please review the target processor and development tools
documentation for additional information, including specific details on how to use the
compiler, assembler, and linker.
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Chapter 6: Using Cross-OS Development platform

Cross-OS Development Platform provides you a robust and industry standard OS interface
architecture for flexible application development while allowing the user to protect the
software from being locked to one OS. Cross-OS Development Platform makes your
application adapt to multiple operating system, reduces cost associated with code
maintenance, need for learning multiple operating systems and eliminates the risk
associated with the OS selection process.

This chapter contains the following topics:

About Cross-OS Development Platform

About OS Abstractor

Interfaces Available for OS Abstractor

Developing OS Abstractor or Cross-OS Application

Full Library Package Generator

Generating Project Files for your Target

Inserting Application Code to Run only on Target OS Environment
Running AppCOE Generated Code on your Target
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About Cross-OS Development Platform

There are three interfaces in the OS Abstractor Interface options providing the ability to
develop & use portable application.

1. OS Abstractor development interfaces from Mapusoft — OS Abstractor Target
Specific Module (specific to each target OS) provides the connection to your target
operating system(s).

Linux/POSIX Interface- Providing the POSIX/LINUX re-host capability
micro-ITRON Interface. — Provides ITRON re-host capability

Developers also have the ability to choose multiple Interfaces for use within the
sameapplication and existing applications can connect to the appropriate Interface for
re-hosting on a different OS.

Figure 6_1: Cross-OS Development Platform

Cross-OS Development Platform

Linux/POSIX

Your
Applications

OS Abstractor

In-house abstraction
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About OS Abstractor

OS Abstractor is designed for use as a C library. Services used inside your application
software are extracted from the OS Abstractor libraries and are then combined with the
other application objects to produce the complete image. This image may be downloaded to
the target system or placed in ROM on the target system. OS Abstractor will also function
under various host environments.

Developing a solid software architecture that can run on multiple operating systems
requires considerable planning, development and testing as well as upfront costs associated
with the purchase of various OS and tools to validate your software. MapuSoft’s OS
Abstractor is an effective and economical software abstraction alternative for your
embedded programming. By using OS Abstractor, your embedded application can run on
many real time (RTOS) and non-real time operating systems to negate any porting issues in
the future when your platform changes.
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Figure 6_2: OS Abstractor Flow Diagram
Interfaces Available for OS Abstractor

The following are the OS Abstractor products:
¢ POSIX/LINUX
e micro-ITRON
e VxWorks
e pSOS
e Nucleus

¢ Windows

MAPUSLDFT

148




S@ F.I:Application Common Operating Environment User Manual

e ThreadX

e uC/0Ss

e FreeRTOS
e VRTX

e ONX

e RTLinux

Application developers need to specify the target operating system that the application and
the libraries are to be built for inside the project build scripts. Application developers can
also customize OS Abstractor to include only the components that are needed and exclude
the ones that are not required for their application.

If the Application also uses Interface products, additional configuration may be necessary.
Please refer to the individual Interface documents.

Developing OS Abstractor or Cross-OS Application

The steps for using OS Abstractor are described in the following generic form:
1. Include os_target.h in all your application source files.

2. Set the appropriate compiler switches within the project build files to indicate the
target OS and other target configurations.

3. Configure the pre-processor defines found in the cross os usr.h header file
under each target OS folder to applications requirements.

4. Initialize the OS Abstractor library by calling 0S Application Init () function. If
you are also using POSIX/LINUX Interface, then also use 0OS Posix Init ()
function call to initialize the POSIX/LINUX component as well. If you use OS
Changer(s), you may need to call other appropriate initialization functions as well.
After initialization, create your initial application resources and start the
application’s first task. After this and within the main thread, call
OS_Application Wait For End() function to suspend the main thread and wait
for application re-start or termination requests.

5. Compile and link your application using appropriate development tools.
6. Download the complete application image to the target system and let it run.

NOTE: Make sure to disable User Account Control (UAC) in order to have administration
permission in Windows Vista and Windows7.

Turning Off UAC
In order to run our products successfully, users need to turn off the User Access Control
(UAC).
To turn off UAC:
e On Windows Vista:
1. Go to Start> Control Panel > Security Center > Other Security Settings.
2. Turn off User Access Control.
¢ On Windows 7/8:
1. Go to Start>Control Panel\User Accounts and Family Safety\User Accounts.
2. Set the notification to Never Notify.

Refer to the sample demo applications provided with OS Abstractor as a reference point to
start your application. Please review the target processor and appropriate development tools
documentation for additional information, including specific details on how to use the
compiler, assembler, and linker.
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Full Library Package Generator

MapuSoft enables you to generate a full library code package to create libraries and develop
applications using your own IDE. You can manually scale and configurethe product by
modifying the user configuration file.

Note: Before you begin, refer to MapuSoft System Configuration Guide.
This section contains the following topics

Generating Full Library Packages
Generating Binary Packages

Generating Full Library Packages

NOTE: This feature requires a Library Package generation license. Click
http:/ /mapusoft.com/contact/ to send a request to receive licenses and documentation.

AppCOE can also create full library packages to complete the porting and development
outside of AppCOE with your own tools and environment.

NOTE: To generate full library package on Windows Interface, ensure that the flag
INCLUDE_OS_PROCESS:is set to OS_TRUE in the cross os_usr.h configuration file.

To generate full source library package, follow the steps:
To generate full library package:

e From AppCOE main menu, click Full Library Package Generator button on the tool
bar as highlighted inFigure 6_3Or select Tools > Full Library Package Generator.

Figure 6_3: Generating Library Package
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e On Full Library Package Generator window, select the required Target OS from the list
and click Nextas shown in Figure 6_4.

Figure 6_4: Select Target OS
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Full Library Package Generator
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e Select the development OS APIs needed to generate full library package and click Nextas
shown inFigure 6_5.

Figure 6_5: Select OS Changer or OS Abstractor Products
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e Select the destination path to save the generated package and click Finish as shown in

Figure 6_6.
Figure 6_6: Select Destination Path
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e The successful library package generation is shown inFigure 6_7 .

Figure 6_7: Full Library Package Generation Verification Report

Porting Report

(@ Displays the Information about different activities in Standalone Generation

Linux OS Abstractor Generation
Status: °

Description:
Standalones Generated for Target OS :Linux Successfully.

Demos Generation

Status: ©/CCES

m

Description:
demo_cross_os Successfully Generated.

Documents Generation
Status: ©

Description:
OS_Abstractor_Interface_reference_Manual.pdf Successfully Generated.

Documents Generation
Status: © _C

Description:
svstem confiauration auide.ndf Successfullv Generated.

@
NS,

Note: Incase of linux 64 bit machines the user might be required to change the path of the
library from usr/lib to usr/lib64 for smooth execution of the projects. Otherwise the following
compilation error might be faced,

/usr/bin/1ld: skipping incompatible /usr/lib/libpthread.so when searching
for -lpthread

/usr/bin/ld: skipping incompatible /usr/lib/librt.so when searching for -
1rt

/usr/bin/ld: skipping incompatible /usr/lib/libc.so when searching for -lc
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Show the Full Library Package Created by AppCOE

The full library package includes libraries with full source code to manually link into the
applications. Once the application is recompiled with MapuSoft’s products it will run on the
new OS.

To view the generated full library package:

a) Open the folder created by AppCOE.

b) Click on the folder to view the files included in the package as shown inFigure
6_8, which include:

= A sample application

» Libraries containing the MapuSoft products needed to run their application
on the new OS

Figure 6_8: Full Library Package Generation Folder

@\/9‘ » Computer » Virtual_Machine (k) » Full_lib »

Organize « Include in library « Share with = Bumn Mew folder
= Recent Places . Name Date modified Type Size
USB_Ste clysh
L USE Storage (readyshare) cross._os_linux 28-Nov-16 216 PM  File folder
@) Creative Cloud Files
demo_cross_os 28-Nov-1¢

File folder

o docs 28-Mov-1¢ File folder
w4 Libraries

= include 28-Nov-16 216 PM  File folder
j Documents

3. Make sure if your application is built for 32bit architecture, OS_CPU_64BIT is set as
OS_FALSE as a command line option.

Note: Incase of linux 64 bit machines the user might be required to change the path of the
library from usr/lib to usr/lib64 for smooth execution of the projects. Otherwise the
following compilation error might be faced,
/usr/bin/ld: skipping incompatible /usr/lib/libpthread.so when
searching for -lpthread

/usr/bin/1ld: skipping incompatible /usr/lib/librt.so when searching

for -1rt
/usr/bin/1d: skipping incompatible /usr/lib/libc.so when searching
for -1lc
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Steps to compile the extracted source code using Makefile project

If your target is of linux based operating systems, Makefile can also be used in compilation.
Copy the extracted source code to the linux machine and follow the below steps.

Makefile command line options

Table 6_1: User specific command line options of make file

Command line options Descrption
ROOT_DIR=<path> Sets the user selected path as the root
directory
LIB_OUT_DIR=<path> Sets the user selected path as the directory

holding the library extension
file(eg:libcross_os.a)

make all Compiles the extracted source code

make clean Cleans/Removes the built libraries
completely

make ARCH=32 Compiles the 32 bit os_abstractor

application in a X86_64 bit machine

¢ From the extracted directory, Makefile is navigated. It will be found in
/../../cross_os_linux/specific/linux/x86/gnu/

Figure 6_9: Navigating the extracted folder

root@ubuntu:~/Full_1ib# cd cross_os_linux/specific/linux/x86/gnu/
root@ubuntu:~/Full_1ib/cross_os_linux/specific/linux/x86/gnu# 1s
Makefile

root@ubuntut=/Full_1ib/cross_os_Llinux/specific/linux/x86/gnui

e In order to set a different root directory of your make file, the following command is
used.

make ROOT DIR=<path>
Figure 6_10: Setting the user selected root directory

root@ubuntu:~/Full lib/cross os Llinux/specific/linux/x86/gnu#t make clean
root@ubuntu:~/Full lib/cross_os_linux/specific/linux/x86/gnu#:make ROOT DIR=/root/lin_threadx/

gcc -DOS_CPU_64BIT=05_TRUE -Wall -Wformat -Wpointer-arith -Wswitch -Wuireatisute=code =wunused -D_DEBUG -DOS_TARGET=05S_LINUX -D_GNU_SO
URCE -MD -pg -g -08 -I/root/lin_threadx//include/include -I/root/1in_threadx//cross os linux/include -c -0 "os_delete memory pool.o"
"ofoif.of..Jsourcefos delete memory pool.c"

e In default the library extension file(eg: libcross_os.a)can be found in the <extracted
source code directory>/lib/... The user can also select their own target directory using
the command line option

make LIB_OUT DIR=/..(path)
For eg: make LIB OUT DIR=/root/target/

Figure 6_11: User selected library directory

root@ubuntu:~/Full_lib/cross_os_linux/specific/linux/x86/gnu# make clean
A[[Aroot@ubuntu:~/Full_lib/cross_os_linux/specific/linux/x86/gnu# make LIB_OUT | DIR ]rOOt/lleDﬁf
gcc -DOS_CPU_64BIT=05_TRUE -Wall -Wformat -Wpointer-arith -Wswitch - da—Wunused -D_DEBUG -DOS_TARGET=0S_LINUX -D_GNU_SO

URCE -MD -pg -g -00 I/root/Full lib/cross_os_linux/specific/linux/x86/gnu/. /../../ off 3 flncludeflnclude I]root/Full 11b/cro<< os_li
nux/specific/linux/x86/anu/../../../../..[cross_os_linux/include -c -o "os_delete_memory_pool.o" "../../..f../source/os_delete_memory
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e If you have a X86_64 bit machine and you are in need of compiling a 32 bit
os_abstractor application, then the following command is used.

make ARCH=32

The flag =-m32could be found in the compilation window in this case.

Figure 6_12: Compiling a 32 bit application in X86_64 machine

root@ubuntu:~/Full lib/cross os linux/specific/linux/x86/gnui. make ARCH=32
cc -m32 -Wall -Wformat -Wpointer-arith -Wswitch -Wunreachable-coae=iiuiiUsed -D DEBUG -DOS TARGET=0S LINUX -D_GNU SOURCE -MD -pg -q -0

-I/root/Full_Lib/cross os_linux/specific/linux/x86/anuf../..[../../../include/include -I/root/Full 1ib/cross os_linux/specific/linux
x86/anu/../..[..[../../cross os linux/include -c -0 "os delete memor . o). /sourcefos delete memor

(Note: In default Makefile will have ARCH=64)

e In order to compile the extracted os_abstractor source code, the command make allis
given in the terminal.

Figure 6_13: Compiling the extracted source code

root@ubuntu:~/Full:lib/cross_os_iinﬂx/specific/linux/xSé/gnu# 1s
Makefile

root@ubuntu:~/Full lib/cross os linux/specific/linux/x86/gnu#, make all
gcc -DOS_CPU_64BIT=05 TRUE -Wall -Wformat -Wpointer-arith -Wswitcir=wWlUnreachable-code -Wunused -D DEBUG -DOS_TARGET=0S LINUX -D_GNU SQ
URCE -MD -pg -g -00 -Ifroot/Full lib/cross os linux/specific/linux/x86/gnu/../../..[..]../include/include -I/root/Full lib/cross os 1i

e If you have made changes in your source after giving make all command, you can
either give make/make all command to update your libraries with changed code or you
can clean/remove all your libraries using the command make clean and then it can be
compiled again from the first using the command make all.

Figure 6_14: Cleaning the libraries

_processes.o os_create _mutex.o os_delete_application_counter.o os_delete_tiered_shared_memory pool.o os

oot@ubuntu:~/Full_lib/cross_os_linux/specific/linux/x86 /gnu# ﬂake clean
oot@ubuntu:~/Full_lib/cross_os_linux/specific/linux/x86/gnu# N

158




J :
S@ FTApplication Common Operating Environment User Manual

Steps to cross-compile the source code using Makefile for target hardware.

If you need to cross-compile for target hardware Makefile can also be used in cross-
compilation using make command along with arguments. Copy the extracted source code to
the existing host machine and follow the below steps.

Makefile command line options for target hardware

Table 6_2: User specific command line options of make file for target
hardware.

Command line options Description
ROOT_DIR=<path> Sets the user selected path as the root
directory
LIB_OUT DIR=<path> Sets the user selected path as the directory

holding the library extension
file(eg:libcross_os.a)

make all Compiles the extracted source code

make clean Cleans/Removes the built libraries
completely

make ARCH=32 Compiles the 32 bit os_abstractor
application in a X86_64 bit machine

CROSS=<cross compiler tool prefix> Specifies the cross compiler executable
prefix.

TOOL DIR=<installation location of Sets the path of the cross compiler package

cross compiler tool> installed on your Linux host machine.

e Make change in cross_os_usr.h for the target you need to compile. Default will be
OS_LINUX_X86.

#define OS LINUX TARGET OS_LINUX X86

You can change to OS_LINUX_ARM, OS_LINUX_ARM_RASPBERRY_PI and
OS_LINUX_OTHERS as defined in cross_os_def.h.

For example : Target is ARM

Figure 6_15: Editing the cross_os_usr.h file.

/* set this define to be what Linux target you are using.
Look at def.h for walid walues */
#define 0S5 _LINUX TARGET 0S LINUX_ ARM|

e Configure the cross-compiler on your host machine after successful installation of
the cross -compiler.

For example: Configuring the arm-xilinx-linux-gnueabi- on Debian 9 host machine.

Xilinx_SDK_2017.2_0616_1_Lin64.bin package installed on your Linux host
machine. Edit the bash.bashrc using vi editor or using other utility application as
export PATH=<Xilinx SDK location>/SDK/2017.2/gnu/arm/lin/bin
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6_16: Configuring the cross-compiler path in.bashrc file.

export PATH=$PATH:/Xilinx2017/SDK/2017.2/gnu/arm/1in/bin

"bash.bashrc" 58L, 1922C 53,1-8 Bot

Build your cross_os and other interfaces source code packages using the make
command passing the argument as name of the cross-compiler. The command
stated as follows:

make CROSS=<cross compiler tool prefix>

For example : After configuring the arm-xilinx-linux-gnueabi-, make command to
build cross_os and interfaces as :

make CROSS=arm-xilinx-linux-gnueabi-

6_17: Cross-compiling the cross os and interfaces using cross-compiler

| root@debian:/home/testl/cross os Linux/specific/linux/x86/gnu# make CROSS=arm-xilinx-linux-gnueabi- |

|root@debian:/home/testl/posix interface/specific/linux/x86/gnu# make CROSS=arm-xilinx-linux-gnueabi-

Then build your application using the make command passing the argument as
name of the cross-compiler and the path of the binary of the cross-compiler package
installed in your linux . The command stated as follows:

make CROSS=<cross compiler tool prefix> TOOL DIR=<binary path of the
cross compiler tool>

For example: make command to build the canned demo application.

make CROSS = arm-xilinx-linux-gnueabi-
TOOL DIR=/Xil1inx2017/SDK/2017.2/gnu/lin

Figure 6_18: Cross-compiling the demo/other applications using cross-
compiler.

root@debian:/home/testl/demo posix/specific/linux/x86/gnu# make CROSS=arm-xilinx-linux-gnueabi- TOOL DIR=/Xilinx
2017/SDK/2017.2/gnu/arm/1in

b ook ke kb ek ok ke ok ke ke ke ok ok ek ke kb ek 1 g o i A o 113 20 L ot + 1s Lo : NO£ S Lia

The executable of application can run on target hardware.

Generating Binary Packages

NOTE: If you want to build a library as a Shared Library, use the makefile named
makefile_s under cross_os_xxxx/specific/x86 /gnu/makefile.
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Optimized Target Code Generator

AppCOE’s Optimized Target Code Generator generates porting and OS Abstractor Interface
source code optimized for your application. This allows you to create project files. This also
includes the system settings you chose in the GUI-based Wizard.

Note: Before you begin, refer to MapuSoft System Configuration Guide.
This section contains the following topics:

Generating Optimized Target Code
Generating Project Files for your Target
Inserting Application Code to Run only on Target OS Environment

Running AppCOE Generated Code on your Target
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Generating Optimized Target Code

This section describes how to generate optimized target code using AppCOE. Most of the
configurations described below can also be changed at run time wusing the
OS_Application_Init function.

NOTE 1: This feature requires a target license. Click http://mapusoft.com/contact/ to
send a request to receive licenses and documentation.

NOTE 2: For all Optimized Target Code Generation the preprocessor OS_HOST flag is set to
OS_FALSE. If the user intends to do the host development on the optimized target code,
they need to change this preprocessor flag to OS_TRUE manually.

NOTE 3: On Linux target, PC hangs while running demo_uitron from terminal if you
terminate the execution by Ctrl+C. Make sure that #define OS_BUILD_FOR_SMP is set to
False when compiling for non SMP processors.

NOTE 4: If you select a library project, which either has, a C/C++ generic library project or
AppCOE library project, Target Code Generator icon is disabled.

NOTE 5: API optimization is not supported for AppCOE libraries linked with application
project during target code generation.

NOTE 6:The Eclipse Indexer may report errors after successfully building an application.
These errors are related to missing symbols and are due to the fact that the indexer is not
detecting the changes in the source files which are generated., and select Index > Rebuild
from the context menu.

To resolve the errors:

1. Right-click the Project, then Select Project > Properties > C/C++ General >
Indexer.

2. Click Enable Project Specific Settings check box, and click Enable Indexer check
box.

3. Click Apply and OK.
Optimized Target Code Generation for Ada Projects

AppCOE allows Optimized Target Code Generation for Ada-C/C++ Changer Projects, when
the projects are created with OS Abstractor Integration.

NOTE 1: The project file generated to QNX Momentics 4.x IDE using optimized target does
not enable the build variant, so you need to manually enable the build variant after
importing in the QNX IDE.

To enable the Build Variant:

e Select the project and go to Project Properties->C/C++ General->QNX
C/C++Project.

e Select Build variant tab.

e To enable the build variant, select the X86 check box.

NOTE 2: Check if the Indexer is enabled. Generating Optimized Target Code will not work if
Indexer is OFF.

NOTE 3:For all Optimized Target Code Generation the preprocessor OS_HOST flag is set to
OS_FALSE. If the user intends to do the host development on the optimized target code,
they need to change this preprocessor flag to OS_TRUE manually.

NOTE 4: The QNX Momentics IDE has an issue where relative path names are not updated
unless there is a modification to the project settings. This will cause the initial build of the
Full Source version of OS Abstractor to fail since the project files were created in a different
location than where they were installed.
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To force Momentics to update these paths:

e Right-click on the project and select Properties from the context menu. Then
click Apply and close the properties window.

NOTE 5: To generate optimized target code on Windows Interface, ensure that the flag
INCLUDE_OS_PROCESS is set to OS_TRUE in the cross_os_usr.h configuration file.

To generate Optimized Target Code:

1. From AppCOE C/C++ projects, select a project.
2. From AppCOE main menu, click Tools >Optimize Target Code Generator or click

©
the Optimized Target Code Generator button L—lon the AppCOE Toolbar as shown

inFigure 6_19.

Figure 6_19:AppCOE Target Code Generator

| Projects - Application Common Operating Environment (AppCOl I T s
File Edit Source Refactor Navigate Search Project [Tools] Run Window Help

i | & @o ® +F 5+ |(© Optimized Target Code Generstor L - - o of = | TFE)
T8 C/C++ Projects 52 = g |[|Q  UpdateSettings =0
pa— ®,  License 3
r e P Full Library Package Generator
» I demo_cross_os
> I demo_freert 3 Porting r
» B3] demo_nucleus
» I demo_posix
> 1] demo_psos
» B3| demo_threads
» I demo_ucos
> 1] demo_uitron
> I demo_wxworks
[/ Problems | B Console 52 | = Properties > - Fh .= g

/demo_cross_os

3:40 PM gl

[ RN

28-Feb-17
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3. From AppCOE Optimized Target Code Generator window, select your target platform
specifications from the drop down list. VxWorks operating system is selected as an

example as shown in6_20.

Figure 6_20: Selected VxWorks Target in this Example

o = LN X
r2d - — e g
Optimized Target Code Generator )
This wizard optimizes target specific source code,
Target [VxWorks - ]
Version [B.x VI
SMP up -
Kernel Mode [User Mode v]
Architecture 32-bit -|
Target Hardware [XE& VI
Load settings from [Previous VI
[7] Generate a Project File
Project WindRiver Workbench 3.1
Destination Path choptimizecode)| Browse...
@ < Back Mext > e
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The field descriptions on AppCOE Optimized Target Code Generator window are as follows:
Table 6_3: Field descriptions on AppCOE Optimized Target Code

Generator

Field Description Your Action

Target Specifies the target OS name. Enter the target OS
name in the text box.

Version Based on the Target OS name you selected, Select the appropriate
this specifies, the available version names target version.
listed in the Version drop down list.

SMP This specifies the Symmetric Multi processor. | Select this if your
target supports SMP
or UP.

Kernel If applicable to the Target OS name and Select the  Target

Mode version, this specifies the following modes: kernel mode by
e User mode selecting it from the
o Kernel mode drop down list.

Architectu | This specifies the architecture of the Target Select the architecture

re OS. The options are: you need.
e 32-bit
e 64-bit

Target Specifies the type of target hardware used to | Select the type of

Hardware | complete code optimization. target hardware used.
Note: You can select the target hardware The options are:
only when you select VxWorks as your target | PPC,PPC_604,X86,AR
OS. M,M68K,MCORE,MIP

S,SH,SIMLINUX,SIMN
T,SIMSOLARIS,SPARC

Load This specifies the following two options to Select the option to

Settings load settings from: load settings from by
e Previous: If you select Previous, then selecting from the

initial values for this wizard are loaded drop down list.
from previously saved settings and
populated.
e Default: If you select Default, then the
values from default settings are
populated.

Generate Specifies if you want to generate a project Select the check box

a Project file. next to Generate

File project file.

Project Specifies the different target project types Select the project from
that you can generate for this project. The the drop down list.
generated project files are directly imported
into the specified IDE (Eclipse/Visual
Studio), and this project becomes a project of
that IDE.

Destinatio | Specifies the path to place the generated Click Browse and

n Path optimized target code. select the folder to
place the generated
code.

4. From AppCOE Optimized Target Code Generator window, when you select your
target platform as Linux/RT Linux Resource Protection Under SMP selection is

provided as shown in Figure 6_17.
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Resource Protection Under SMP has option of either Spin Lock or Mutex Lock .
Spin lock is useful if protection is required for a short time. Spin Lock wastes CPU if
protection required is for longer periods. If you have two or more cores and when
you see serious performance issues then it is recommended to use Mutex Lock.
When you enable Mutex Lockas shown inFigure 6_21,this willset
OS_PROTECTION_USE_MUTEX LOCK flag to OS_TRUE in cross_os_usr.h file. The
followingFigure 6.17 will show the Spin Lock or Mutex Lock in selection.

Figure 6_21: Resource Protection under SMP selection in Linux/RT Linux

Optimized Target Code Generator

This wizard optimizes target specific source code,

Target |Linux

Version |2.4.x or Greater

Kernel Mode User Mode

Architecture |32-bit vl

Resource Protection under SMP Mutex Lock W

Sﬁin Lock I

Load settings from | Default v ‘

Generate a Project File

Project |makefi|e

Destination Path | chsril,

Cancel

If you select an application project, AppCOE checks if the application project has any
linked-in libraries and queries the workspace for any matching library projects. If AppCOE

finds any libraries, then it will install the available libraries on the page as shown in 6_22.
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All the libraries are selected by default, and you can select or deselect any/all libraries

to export library sources along with the application during code generat
Select the libraries and click Next.

Figure 6_22: Select the linked-in Libraries

ion process.

Optimized Target Code Generator G

This wizard optimizes target specific source code. / £

This application project depends on the following libraries within the current workspace and as such will also be exported
along with the application during the code generation process,

i you prefer not to export any specific library then unselect them,

Libranes:

7 L AppCOE_wx libproj

(? < Back : Next; ] Finist . Cancel ‘

NOTE: When you export AppCOE libraries, it will skip API Optimization.

Target Code Generator will contain the following folders /files:
e Application project sources and project/make files.

e OS Abstractor Interfaces (the ones that are included in the project)

e Library sources without project files.
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5. On Profiler Configuration tab, define your profiler data specifications as shown in

Figure 6_2323.

Figure 6_23: Profiler Configuration

Optimized Target Code Generator
- -]
This wizard optimizes target specific source code, '

Profiler Configuration | Platform API Profiling | Application Functions Profiling

Description Cross-05 ViWorks project

Profiler Task Priority 200

File Path To Store Profiled Data

(e.g. c\profiledData\ OR /home/userl) froot

Mumber of Data in Memory Before Each Write 3000

Maxirnum Profiler Data to Collect 30000

@ <Back || Ned> || Finish
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The field descriptions on Profiler Configuration tab are as follows:

Table 6_4: Field descriptions on Profiler Configuration tab

Field Description Your Action

Description Specifies the description for | Type description
the OS Abstractor for the (O]
Interface project. Abstractor

Interface project.
Profiler Task Priority Specifies the priority level Enter a priority
of the profiler thread. level for the
profiler thread.
The value can be
between 0
through 225. The
default value is

set to 200.
File Path to Store Specifies the directory Enter a data file
Profiled Data location where the profiler path.

file will be created. The default
location set is
/root on  Unix
based machines
and ¢/ on MS

Windows
machine.
Number of Data in Specifies the depth of the Enter the number
Memory Before Each profiler queue. of data in memory
Write before each write.

The default value
is set to 3000.

Maximum Profiler Specifies the maximum Enter the number
Data to Collect records collected in the of profiler
XML file. messages. The

default wvalue is
set to 30000.
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6. On Platform API Profiling tab, select the check box to enable your appropriate
Interface API Profiling as shown inFigure 6_24.

Figure 6_24: Platform API Profiling

Optimized Target Code Generator

This wizard optimizes target specific source code,

| Profiler Cenfiguration | Platform API Profiling | Application Functions Profiling

[ Enable OS5 Abstractor Interface AP| Profiling
Enable POSIX Interface AP| Profiling
Enable micro-ITRON Interface API Profiling
Enable Windows Interface APl Profiling
Enable VxWorks Interface API Profiling
Enable p5035 Interface APl Profiling
Enable Nucleus Interface API Profiling
Enable ThreadX Interface API Profiling
Enable FreeRTOS Interface AP Profiling

Enable uCO5-1Il Interface APl Profiling
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The field descriptions on Platform API Profiling tab are as follows:

Table 6_5: Field descriptions on Platform API Profiling tab

Field Description Your Action
Enable OS Specifies if the OS Select the check
Abstractor Abstractor Interface API box to enable
Interface API Profiling feature is enabled platform profiling.
Profiling or disabled. Platform  Profiling
means OS
Abstractor Interface
APIs profiling.
NOTE: By default,
(ON] Abstractor
Interface API
profiling is enabled
for all projects.
Enable Specifies if OS Abstractor Select the check
POSIX/LINUX POSIX/LINUX Interface API | box, if you need
Interface API Profiling feature is enabled profiling for your
Profiling for your project. POSIX/LINUX APIs.
Enable micro- Specifies if OS Abstractor Select the check
ITRON Interface micro-ITRON Interface API box, if you need

API Profiling

Profiling feature is enabled
for your project.

profiling for your
micro-ITRON APIs.

Enable Windows
Interface API
Profiling

Specifies if OS Changer
Windows Interface API
Profiling feature is enabled
for your project.

Select the check
box, if you need
profiling for your
Windows APIs.

Enable VxWorks
Interface API

Specifies if VxWorks
Interface API Profiling

Select the check
box, if you need

Profiling feature is enabled for your profiling for your
project. VxWorks Interface

APIs.
Enable pSOS Specifies if OS Changer Select the check
Interface API pSOS Interface API Profiling | box, if you need

Profiling feature is enabled for your profiling for your
project. pSOS Interface

APIs.
Enable Nucleus Specifies if OS Changer Select the check
Interface API Nucleus Interface API box, if you need

Profiling Profiling feature is enabled profiling for your
for your project. (ON) Changer
Nucleus Interface

APIs.
Enable uC/0OS Specifies if OS Changer Select the check
Interface API uC/OS Interface API box, if you need

Profiling

Profiling feature is enabled
for your project.

profiling for your
OS Changer uC/0S
Interface APIs.

Enable FreeRTOS
Interface API
Profiling

Specifies if OS Changer
FreeRTOS Interface API
Profiling feature is enabled
for your project.

Select the check
box, if you need
profiling for your
(0N Changer
FreeRTOS Interface
APIs.
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7. On Application Functions Profiling tab, you can also perform profiling for your
specific APIs as shown in Figure 6_25.

Figure 6_25: Application Function Profiling

Optimized Target Code Generator
: et |
This wizard optimizes target specific source code, '

| Profiler Configuration | Platform API Profiling | Application Functions Profiling

[TJEnable Application Function(s) Profiling ;

Enter Application Function Add

e.g. function_1 or function_1()

Remove

@ <Back || New> || Finish
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Table 6_6: Field descriptions on Application Functions Profiling tab

Specifies if you want to
remove any application
functions from the list.

Field Description Your Action

Enable Application | gpecifies if the | Select the check box

Functions Profiling Application Functions | to enable Application
Profiling  feature  is | Functions profiling.
enabled or disabled. This profiling is used

for User APIs
profiling.

Enter Application Specifies the name of the | Enter the name of

Function Application Function for | the application
profiling. function.

NOTE: This field is
case sensitive.

Add Specifies if you want to | To ~ add any
add any application | @pplication function,
functions. enter the name in the

text box, and click
Add.
Remove To remove any

application function
from the list, select
the name of the
application function
in the text box, and
click Remove.

8. Add your APIs by typing in the name of the API next to Enter Application Function
text box and click Add and click Next.
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9. On API Optimization tab, you can select either to generate Full API Library
Interface or Optimized API interface. In API Optimization, you can select the API’s
which needs to be a standard function or a macro function and move the selected
API using the double arrow button as shown in Figure 6_26. Macro functions will
execute faster but will increase the memory footprint of the application and click
Next.

Figure 6_26: API Optimization

Optimized Target Code Generator , c
-
This wizard optimizes target specific source code. /
L2y

Generate Full API Library Interface
@ Generate Optimnized API Interface Files

Select whether the API needs to be a standard or a macro function. Macro functions will be faster as they do
not have a function wrapper. To change a standard function into a macro function select the name in the
standard functien column and click the > > arrow. Te change a macre function to a standard function , select
the name in the macro function column and click the << arrow.

Standard Function Macro Function

05 _Application_Init -
05_Fatal_Error
05_Application_Wait_For_End
kernellnit

semBCreate

msgQCreate

taskldSelf

taskSpawn

printf

semGive

taskSuspend

taskDelay

creat

Q5 _Driver_Install

remove =

m
w
w

~
A

'@:‘ | < Back |[ Mext = l Finish Cancel

Need for Code Optimization: Macro function is used to eliminate the time overhead when
a function is called. It is typically used for functions that execute frequently. It also has a
space benefit for very small functions, and is an enabling transformation for other
optimizations.

Without macro functions, however, the compiler decides which functions to inline. The
programmer has little or no control over which functions are macro functions and which
are not. Giving this degree of control to the programmer allows her/him to use application-
specific knowledge in choosing which functions to macro.
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The field descriptions on API Optimization tab are as follows:

Table 6_7: Field descriptions on API Optimization tab
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Field

Description

Your Action

Generate Full

Specifies if you want to

Select the radio Dbutton to

Optimized API
Interface Files

generate optimized API
interface files.

Note: If the application
includes AppCOE based
application libraries,
generating optimized API
interface option is

API Library generate full API library generate full library package.
Interface package.
Note: If you select this option,
Note: You can do this if | the rest of the fields on this
you have a valid license window are disabled.
for standalone
generation.
Generate Specifies if you want to Select the radio button to

generate optimized API interface
files.

Note: By default this option is
enabled.

every place in the code
where that function is
used. It is used to
eliminate the time
overhead when a
function is called and
execute it frequently.

disabled.
Standard Specifies if the APIs used | Select the functions used in this
Function in your application are application as standard
standard functions. functions for the target OS
project.
You can select multiple function
names at once to place them in
the other list.
You can select all function
names in a list using the select
All (Ctrl+A) action also.
Specifies that a compiler
Macro inserts the complete To select a standard function
Function body of the function in into a macro function, select the

API and click the right arrow.

To select a macro function into
a standard function, select the
API under macro function, and
click the left arrow.

Note: You can use optimization
for this. If a function is being
called repeatedly, they can
improve the performance by
making this a macro function.

175




MAPUSLDFT

Application Common Operating Environment User Manual

10. On Task configuration tab, configure the options to your specifications as shown in
Figure 6_27. Applications can create @ OS Abstractor Interface tasks during

initialization and will be able to re-use the task envelope repeatedly by selecting the
check box next to Enable Task Pooling Feature.

Figure 6_27: Task Tab

o — o |

Optimized Target Code Generator ,
This wizard optimizes target specific source code,

Task | Process | Memaory | Other Resources | Debug | Output Devices | ANSI Mapping | Device /O | Interface|

Maximurmn Task Control Blocks 100
System Time Resolution (O5_TIME_TICK_PER_SEC) 10

Default Timeslice for Standard Tasks (05_DEFAULT_TSLICE) (OS_TIME_TICK_PER_SEC()/ 10)

Enable Task Poeling Feature
Default Taskpool Timeslice OS_DEFAULT_TSLICE

Default Taskpool Timeout Value OS_TIME_TICK_PER_SEC() *6

@:‘ MNext = [ Einish l l Cancel ]

NOTE: In the current release, Task Pooling feature is not supported in ThreadX and
Nucleus targets.
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The field descriptions on Task tab are as follows:

Table 6_8:Field descriptions on Task tab

Field Description Your Action

Maximum Specifies the total Enter a value.
Task Control | number of tasks NOTE: The default value is 100.
Blocks required by the One control block will be used by

application.

the OS_Application_Init function
when the INCLUDE_OS_PROCESS
option is true.

System Time
Resolution
(OS_TIME_TI
CK_PER_SEC

)

Specifies the system
clock ticks

(not hardware clock
tick).

For example, when
you call
OS_Task_Sleep(5),
you are suspending
task for a period

(5*
OS_TIME_RESOLUTI
ON).

Enter a value.
NOTE: The default value is 10000
micro second (= 10milli sec).

This value is derived from the
target OS. If you cannot derive the
value, refer to the target OS
reference manual and set the
correct per clock tick value.
NOTE: Since the system clock tick
resolution may vary across
different OS under different target,
it is recommended that the
application use the macro
OS_TIME_TICK_PER_SEC to
derive the timing requirement
instead of using the raw system
tick value in order to keep the
application portable across
multiple OS.

Default Time
slice for
Standard
Tasks
(OS_DEFAUL
T_TSLICE)

Specifies the default
time slice scheduling
window width among
the same priority
pre-emptiable
threads when they
are all in ready state.

Enter a default time slice for
standard tasks.

NOTE: The default value is 10 ms.
If system tick is 10ms, then the
threads will be scheduled round-
robin at the rate of every 100ms.
NOTE: On Linux operating
system, the time slice cannot be
modified per thread. (ON)
Abstractor Interface ignores this
setting and only uses the system
default time slice configured for
the Linux kernel.

Enable Task
Pooling
Feature

Specifies if the Task
pooling feature is
enabled for this
application.

Task pooling feature
enhances the
performances and
reliability of
application. If you
enable the task
pooling feature,
applications can
create OS Abstractor
Interface tasks

To enable task pooling feature,
select the check box.

\PU Q’ ;
\PUS FTApplication Common Operating Environment User Manual

177




MAPUSLDFT

Application Common Operating Environment User Manual

Field Description Your Action
during initialization
and be able to re-use
the task envelope
repeatedly. To
configure task-
pooling, set the
following pre-
processor flag as

follows:

INCLUDE_OS_TASK _

POOLING.
Default Task | Specifies the default | Enter the default Task pool Time
pool Time Task pool Time slice. | slice.
slice NOTE: The default value is

OS_DEFAULT TSLICE.

Default Task | Specifies the default Enter the default Task pool
pool Timeout | Task pool timeout timeout value.

Value value. NOTE: The default value is
OS_TIME_TICK PER_SEC() * 6.

11. On Process configuration tab, configure the options to your specifications as shown
inFigure 6_28. Select the check box next to Enable OS Abstractor Interface
Process Feature to allocate the memory from a shared memory region to allow
applications to communicate across multiple processes. By disabling this option, the
memory will be allocated from the individual application/process specific pool,
which is created during the OS_Application_Init function call.

Figure 6_28: Process Tab

- I |
Optimized Target Code Generator c
[
This wizard optimizes target specific scurce code. =
s

Task Process | Mernery mwﬁesuutm_ﬂehu-g Output Devsces | ANSI Mapping | Deace 1D | Imedsce

Enaible 0% Abstractor Interface Process Featung
Mazimum Process Control Blodks
Proecess Memony Pool bliremuam Size n Bytes 4 |
Process Memory Pool Maximum Size in Bytes
Stack Size Tor the Main Precess i KileBytin
Heap Size for the Bain Process in KiloBytes
Taak Priority for the Main Process |

Tazk Preemnption Mode for the Man Process

? < Back | Finish J Cancel
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The field descriptions on Process tab are as follows:

Table 6_9: Field descriptions on Process tab

J :
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Field

Description

Your Action

Enable OS Abstractor
Interface Process
Feature

Specifies if the OS
Abstractor Interface process
feature

is enabled or disabled.

Select the check box
to enable this
feature.

Maximum Process
Control Blocks

Specifies the total number of
processes required by the
application

Enter the maximum
number of process
control blocks for the
application.

NOTE: Default value
is 100.

Process Memory Pool
Minimum Size in Bytes

Specifies the minimum size
of the process memory pool
in Bytes.

Enter the minimum
size of the process
memory pool.
NOTE: Default value
is 1024 Bytes.

Process Memory Pool
Maximum Size in Bytes

Specifies the maximum size
of the process memory pool
in Bytes.

Enter the maximum
size of the process
memory pool.

NOTE: Default value
is Oxffffffff Bytes.

Stack Size for the Main
Process in kilobytes

Specifies the stack size for
the main process in

Enter the stack size
for the main process.

Kilobytes. NOTE: Default value
is 1024 * 200
Kilobytes.

Heap Size for the Main
Process in kilobytes

Specifies the heap size for
the main process in

Enter the heap size
for the main process.

Kilobytes. NOTE: Default value
is 1024 * 400
Kilobytes.
Task priority for the Specifies the task priority for | Enter the task
Main Process the main process. priority for the mail
process.

NOTE: Default value
is O.

Task Preemption Mode
for the Main Process

Specifies the preemption
status of this task.

Enter the task
preemption status of
the task.
NOTE: The
parameters are:
* OS_PREEMPT -
Task can be pre-
empted by the
system.
* OS_NO_PREEMPT -
Task cannot be
pre-empted.

valid
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12. On Memory configuration tab, configurethe options to your specifications as shown
in Figure 6_29.

Figure 6_29: Memory Tab

2 — [ | O
Optimized Target Code Generator )
This wizard optimizes target specific source code,

Task | Process | Memory | Other Resourcesl Debug | Output Devices | ANSI Mapping | Device /'O | Interface|

Maximum Variable Memory Pool Control Blocks 100
Maximum Fixed Memory Pool Control Blocks 100
Maximum Tiered Memory Pool Control Blocks 10
Maximum Tiered Shared Memory Pool Control Blocks 100
Minimum Variable Pool Allocation Size in Bytes 4
User Shared Memory Region Size 1024

@j Mext > [ Einish ] ’ Cancel
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The field descriptions on Memory tab are as follows:

Table 6_10: Field descriptions on Memory tab

Field Description Your Action
Maximum Variable Specifies the total number of | Enter the
Memory Pool Control | dynamic variable memory maximum
Blocks pools required by the number of
application. dynamic variable
pools.
NOTE: Default
value is 100.
Maximum Fixed Specifies the total number of | Enter the
Memory Pool Control | partitioned (fixed-size) maximum
Blocks memory pools required by number of
the application. partitioned
memory pools.
NOTE: Default
value is 100.
Minimum Variable Specifies the minimum Enter the
Pool Allocation Size memory allocated by the minimum
in Bytes malloc() and /or memory
OS_Allocate_Memory() calls. | allocated.
NOTE: Increasing this value | NOTE: Default
further reduces memory value is 4.
fragmentation at the cost of | Increasing this
more wasted memory. value further
reduces memory

fragmentation at
the cost of more
wasted memory.

Blocks

required by the application.

User Shared Memory | Specifies the application Enter the user

Region Size defined shared memory shared memory
region usable across all OS | region size.
Abstractor Interface NOTE: Default
processes/applications. value is 1024

Bytes.
Maximum Tiered Specifies the total number of | Enter the
Memory Pool Control | Tiered Memory Pools maximum

number of Tiered
Memory variable

pools.

NOTE: Default

value is 100.
Maximum Tiered Specifies the total number of | Enter the
Shared Memory Pool | Tiered Shared Memory Pools | maximum
Control Blocks required by the application. number of Tiered

Shared Memory

variable pools.

NOTE: Default

value is 100.
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13. On Other Resources configuration tab, configure the options to your specifications

as shown in Figure 6_30.

Figure 6_30: Other Resources Tab

e
ALd —

) S

Optimized Target Code Generator

This wizard optimizes target specific source code,

| Task | Process | Memoryl Other Resources | Debug | Output Devices | AMSI Mapping | Device /'O | Interface|

Maximum Pipe Control Blocks
Maximum Queue Control Blocks
Maximum Mutex Contrel Blocks
Maximum Semaphore Control Blocks
Maximum Event Group Control Blocks
Maximurm Tirmer Control Blocks
Maximurmn Protection Control Blocks

Maximum Protection Systern Handles

100
100
100
100
100
100
100

100
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The field descriptions on Other Resources tab are as follows:

Table 6_11: Field descriptions on Other Resources tab

Field Description Your Action
Maximum Specifies the total Enter the maximum number of
Pipe Control number of pipes for pipe control blocks.
Blocks message passing NOTE: Default value is 100.
required by the
application.
Maximum Specifies the total Enter the maximum number of
Queue number of queues for queue control blocks.
Control message passing NOTE: Default value is 100.
Blocks required by the
application.
Maximum Specifies the total Enter the maximum number of
Mutex Control | number of mutex mutex control blocks.
Blocks semaphores required by | NOTE: Default value is 100.
the application.
Maximum Specifies the total Enter the maximum number of
Semaphore number of regular semaphore control blocks.
Control (binary/count) NOTE: Default value is 100.
Blocks semaphores required by
the application.
Maximum Specifies the total Enter the maximum number of
Event Group number of event groups | event group control blocks.
Control required by the NOTE: Default value is 100.
Blocks application
Maximum Specifies the total Enter the maximum number of
Timer Control | number of application timer control blocks.
Blocks timers required by the NOTE: Default value is 100.
application
Maximum Specifies the total Enter the maximum number of
Protection number of Protection Protection control blocks.
Control Control blocks required | Note: Default value is 100.
Blocks by the application
Maximum Specifies the total Enter the maximum number of
Protection number of System System Handles.
System handles required by the | Note: Default value is 100.
Handles application
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14. On Debug tab, configure the options to your specifications as shown in Figure 6_31.
The application will be checked for API usage errors by selecting the check box next
to Enable Error Checking. Disabling error checking will increase the application
performance and reduce your code size.

Figure 6_31: Debug Tab

2 — B

Optimized Target Code Generator )
This wizard optimizes target specific source code,

| Task | Process | Memaory | Other Resources| Debug | Output Devices | AMSI Mapping | Device /'O | Interface|

Enable Debug Output |05_DEBUG_MINIMAL -

[T11gnore Fatal Errors

@:l Mext = Finish ] ’ Cancel
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The field descriptions on Debug tab are as follows:

Table 6_12: Field descriptions on Debug tab

S@ F.I:Application Common Operating Environment User Manual

Field Description Your Action
Enable Debug Specifies if you want to Select the debug output from
Output enable the debug the dropdown menu:

output.

* OS_DEBUG_VERBOSE -
print debug info, fatal and
compliance errors

» OS_DEBUG_MINIMUM -
print minimum amount of
debug info
OS_DEBUG_VERBOSE

Note: The default value is

OS_DEBUG_VERBOSE

Enable Error
Checking

Specifies if you want to
enable the error
checking.

To enable error checking, select
the check box. Use this option
to increase performance and
reduce code size.

Note: By default this feature is
enabled.

Ignore Fatal
Errors

Specifies if you want to
enable the feature to
ignore fatal errors.

To enable the feature to ignore
fatal errors, select the check
box.

Note: By default this feature is
disabled.
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15. On Output Devices configuration tab, select your output device from the drop

drown list as shown in 6_32.

Figure 6_32: Output Devices Tab

2 - - o )

Optimized Target Code Generator )
This wizard optimizes target specific source code,

| Task | Process | Memaory | Other Resources | Debug | Output Devices | ANSI Mapping | Device /O | Interface|

Console Output Device ’EOS_WIN_CONSOLE ']

@j Mext = Einish ] l Cancel
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The field descriptions on Output Devices tab are as follows: .

Table 6_13: Field descriptions on Output Devices tab

application.

Field Description Your Action
Console Output Specifies the console Select the output device from the
Device output device for the dropdown menu:

* OS_WIN_CONSOLE - print to
console

= OS_SERIAL_PORT - print to serial
NOTE: The default value is
OS_WIN_CONSOLE

User can print to other devices by
modifying the appropriate functions
within usr.h and use OS Abstractor
Interface’s format I/O calls.

PU SQ‘ FT
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16.On ANSI Mapping configuration tab, as shown in 6_33. Make surethe ANSI
mapping is unchecked, because we no longersupport thisin1.8 AppCOE.

Figure 6_33: ANSI Mapping Tab

2 - - o )

Optimized Target Code Generator )
This wizard optimizes target specific source code,

| Task | Process | Memaory | Other Resources | Debug | Output Devices | ANSI Mapping | Device /O | Interface|

7] Map ANSI /O API
[T Map ANSIT/O Formatting API

@j Mext = Einish ] l Cancel
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The field descriptions on ANSI Mapping tab are as follows:
Table 6_14: Field descriptions on ANSI Mapping tab

S@ F.I:Application Common Operating Environment User Manual

free() to OS Abstractor
Interface equivalent
functions.

Field Description Your Action
Map ANSI Specifies you want to To map ANSI to OS Abstractor
Memory API map ANSI malloc() and Interface equivalent functions,

select the check box.

By default this feature is
disabled.

Note: We no longer support this

feature in 1.8 AppCOE

Map ANSII/O
API

Specifies if you want to
map ANSI device I/O
functions like open(),
close(), read(), write,
ioctl(), etc. to OS
Abstractor Interface
equivalent functions.

To map ANSI I/O functions to
(0N} Abstractor Interface
equivalent functions, select the
check box.

By default this
disabled.

Note: We no longer support this

feature in 1.8 AppCOE

feature is

MAP ANSII/O
Formatting API

Specifies if you want to
map ANSI printf() and
sprintf() to OS
Abstractor Interface
equivalent functions.

To map ANSI I/O formatting
functions to OS Abstractor
Interface equivalent functions,
select the check box.
By default this
disabled.

Note: We no longer support this

feature in 1.8 AppCOE

feature is
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17. On Device I/O configuration tab, configure the options to your specifications as
shown in Figure 6_34.

Figure 6_34: Device Input or Output Tab

2 I (ISR

Optimized Target Code Generator )
This wizard optimizes target specific source code,

as| roCess Emo er Resources | Debu utput Devices appin evicel/ nterface
Task P M ry | Other R Debug | Output Devi ANSIMpp'gD O | Interf

Maxirmurm Murmber of Device Drivers 20

Maximurm Number of Files 30

Maximum File Name Length (EMAXPATH + 1)
Maxirnum File Path Length 255

Internally Used Systemn Name Path ftmp

Internal Mame Padding 20

@j Mext > Einish ] l Cancel
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The field descriptions on Device I/O tab are as follows:

Table 6_15: Field descriptions on Device I/O tab

Abstractor Interface file control
block structure.

Note: One control block is used
when the OS Abstractor Interface
driver is opened. These settings do
not impact the OS setting for max
number of files.

Field Description Your Action
Maximum Specifies the maximum number of | Enter the maximum
Number of drivers allowed in the OS number of device
Device Abstractor Interface driver table drivers.
Drivers structure. Note: Default value

Note: This excludes the native is 20.

drivers the system, since they do

not use the OS Abstractor

Interface driver table structure.
Maximum Specifies the maximum number of | Enter the maximum
Number of files that can be opened number of files that
Files simultaneously using the OS can be opened

simultaneously.
Note: Default value
is 30.

Maximum File
Name Length

Specifies the maximum length of
the file name.

Enter the maximum
number of files that
can be opened
simultaneously.

Note: Default value
is Maximum  File
Path Length +1.

Maximum File
Path Length

Specifies the maximum length of
the directory path name including
the file name for OS Abstractor
Interface use excluding the null
char termination.

Enter the maximum

length of the file
path.
Note: Default value

is 255.
This setting does not
impact the OS setting
for the max path/file
name.

Internally Specifies the temporary directory Enter the temporary
Used System | of the file path. directory of the file
Name Path path.
Note: Default value
is /tmp.

Internal Name
Padding

Specifies the padding for the
internal name.

Enter the padding for
the internal name.
Note: Default value
is 20.

\PU Q’ ;
\PUS FTApplication Common Operating Environment User Manual

191




MAPUSLDFT

Application Common Operating Environment User Manual

18. If your project uses pSOSInterface or uC/OS Interface, in Interface configuration
tab, assign the number of unsigned arrays used to store the task’s data as shown in

Figure 6_35.The number of Thread Local Storage in uC/OS can also be defined here.

Figure 6_35: Interface Tab

Optimized Target Code Generator )
This wizard optimizes target specific source code, @

|Tas|vc | Procasl Memoryl Other RSOUI’CS' Debug | Output Devices | ANSI Mapping | Device I!Dl Interface I_

Mumber of pS05 Interface Task Registers
Mumber of uCOS-ll Interface Task Registers

Mumber of uCOS5-lll Interface Thread Local Storage

Finich
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The field descriptions on Interface tab are as follows:

Table 6_16: Field descriptions on Interface tab

Field Description Your Action
Number of pSOS Specifies the number of pSOS
Interface Task Interface Task Registers. Enter the number of

pSOS Interface task

Registers registers.

Note: Default value is
32.
19. Click Finish. The target code will be generated into the destination path you defined
in step 5 as shown in Figure6_36.
NOTE: If it is not able to generate the target code, the system will throw up an error.

Figure6_36: Target Code Generation Output

Generator Verification

@ Displays the Information about different activities in Target Code Generation

Create Target Directory ‘
Status:

Description:
Creation of "¢:\tmp\Optimized_code\demo_nucleus’ target directory was successful

License Check
|| Status:

Description:
License is valid

m

License Check
Status:

Description:
License file contains 2 valid license for VxWorks 6.x

Generate OS Abstractor Interface
Status:

Description:
Generation for OS Abstractor Interface is successful,
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You can view the AppCOE generated optimized code in Figure 6_37.
Figure 6_37: AppCOE Generated Example
& demo_cross_os Q@1
: Fle Edit Yiew Favorites Tools Help .1','

@ Back ~ \_) " /‘j) Search [1[ -~ Folders ' @ Folder Sync
¢ Address () Di\targetcode\demo_cross_os vl so

File and Folder Tasks A | l;’ include IJ optimized_interface

() Make a new folder
&) Publish this folder to the (
Web

r

source

O

ka2 Share this folder

Other Places

[ targetcode
@3 My Documents
[ Shared Documents

9 My Computer
& My Network Places

Details

3 objects 0 bytes & Iy Computer

MAPUSLHFT

194




MAPUSLDFT

Generating Project Files for your Target

Application Common Operating Environment User Manual

NOTE: This feature requires a target license. Click http://mapusoft.com/contact/ to send a
request to receive licenses and documentation.

AppCOE provides the ability to generate project files for project files for the following

targets:

e Wind River’s Workbench 2.6, 3.1, 3.3
e LynxOS Luminocity 3.0.5
e MQX Code Warrior 10.x

¢ (QNX’s Momentics 4.x

e Sun Microsystem’s Sun Studio

e Visual Studio.NET 2005

e Micro Soft’s Visual Studio 2006

e Micro Soft’s Visual Studio .Net 2008
e Micro Soft’s Visual Studio .Net 2012

e Eclipse’s CDT 4.x
e Makefiles

After Generating Optimized Target Code,select the check box next to Generate a Project

File and choose your IDE as shown inFigure 6_3.

Figure 6_38: Generating Project Files

Optimized Target Code Generator

This wizard optimizes target specific source code.

Destination Path

Target [ELynxOS v]
Version [4.0.0 vl
SMP up -
Kernel Mode User Mode

Architecture |32-bit -
Load settings from [P‘revious v]
Generate a Project File

Project makefile ~|

c\tmph\Optimized_code\l

Browse...

©)
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Inserting Application Code to Run only on Target OS Environment
The user configuration is done by setting up the appropriate value to the pre-processor
defines found in the cross_os_usr.h.

NOTE: Make sure the OS Abstractor libraries are re-compiled and newly built whenever
configuration changes are made to the cross_os_usr.h when you build your application. In
order to re-build the library, you would actually require the full-source code product version
(not the evaluation version) of OS Abstractor.

Applications can use a different output device as standard output by modifying the
appropriate functions defines in os_target_usr.h along with modifying os_setup_serial_port.c
module if they choose to use the format Input/output calls provided by the OS Abstractor.
You can add some application code or target specific things such as memory allocations
such as Heap Size and Shared memory which are specific to target environments.

Target OS Selection

Based on the OS you want the application to be built, set the following pre-processor
definition in your project setting or make files

Table 6_17: Target OS Selection
Flag and Purpose Available Options

OS_TARGET The value of the OS_TARGET should be for the OS
To select the target | Abstractor Interface product that you have purchased.
operating system. For Example, if you have purchased the license for :

OS_NUCLEUS - Nucleus PLUS® from ATI
OS_THREADX - ThreadX® from Express Logic
OS_VXWORKS - VxWorks® from Wind River Systems
OS_ECOS - eCOS standards from Red Hat

OS_MQX - Precise/MQX® from ARC International
OS_UITRON - micro-ITRON standard based OS

OS_LINUX - Open-source/commercial Linux®
distributions
OS_WINDOWS - Windows 2000, Windows XP®,

Windows CE, Windows Vista, Windows 7/8 from
Microsoft. If you need to use the OS Abstractor
Interface both under Windows and Windows CE
platforms, then you will need to purchase additional
target license.

OS_TKERNEL - Japanese T-Kernel® standards based
oS

OS_LYNXOS - LynxOS® from LynuxWorks
OS_QNX - QNX operating system from QNX
OS_LYNXOS - LynxOS from LynuxWorks
OS_SOLARIS - Solaris from SUN Microsystems

OS_ANDROID - Mobile Operating System running on
Linux Kernel

OS_NETBSD - UNIX like Operating System
OS_UCOS - UCOS® from Micrium

OS_FREERTOS-- FreeRTOS® from Real Time Engineers
Ltd.

For example, if you want to develop for ThreadX, you
will define this flag as follows:

OS_TARGET = OS_THREADX
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Flag and Purpose Available Options

PROPRIETARY OS: If you are doing your own porting of
OS Abstractor Interface to your proprietary OS, you
could add your own define for your OS and include the
appropriate OS interface files within os_target.h file.
MapuSoft can also add custom support and validate the
OS Abstraction solution for your proprietary OS
platform

Running AppCOE Generated Code on your Target

NOTE: This feature requires a license and documentation.
Click http://mapusoft.com/contact/ to send a request to receive licenses and
documentation.

After Generating Optimized Target Codefor your target OS using the AppCOE Optimized
Target Code Generator,

1. Using a cross-compiler, compile, link, and download the AppCOE generated code to
your target.

2. Port low level drivers and hardware interrupt code as required (refer to OS
Abstractor Interface 1/O and device driver APIs sections in the reference manual).

3. Resolve any run time errors.
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Chapter 7.App/Platform Profiler

AppCOE provides the Profiler to collect performance data concerning your application and
the platform. You can graphically view the data with charts and graphs to find bottlenecks
system-wide or for a specific task. It enables you to generate API timing report and also do a
comparison for two timing reports.

This chapter contains the following topics:

About App/Platform Profiler

Opening App/Platform Profiler Perspective
Components on the App/Platform Profiler Window
Viewing App/Platform Profiler Data

Generating API Timing Report

Generating Timing Comparison Report
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About App/Platform Profiler

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

The App/Platform Profiler is an add-on to the established AppCOE Eclipse based code
migration and API optimization technology and is designed to enable data collection.

App/Platform Profiler offers the following:

e The data collected by the Profiler provides feedback concerning the utilization of
MapuSoft’s APIs in the project.

e The reports allow for performance impact analysis by detailing specific API execution
time during a particular time period as well as the average and total API execution
times.

e It enables you to collect data pertaining to the MapuSoft API's (Platform API
profiling) and profiling user specific functions (Application Profiling).

o Users can analyze the data with the included App/Platform Profiler graphical viewer
which offers area, bar, line, pie, and scatter charts, as shown inFigure 7_1.

e Profiler enables you to generate a Timing report to view the performance report for
each API.

e App/Platform Profiler now enables you to generate Timing Comparison Report. This
compares two different timing reports and compares the performance report for an
API at different time and different values.

NOTE 1: In the current release, Profiler feature is not supported in ThreadX and Nucleus
targets.

NOTE 2:The profiler feature does not generate profiler file XXX.PAL on Solaris target if you
do code optimization for demo_cross_os with profiler ON. As a workaround, enter the
following command at the prompt prior to running the demo:

prctl -n process.max-msg-gbytes -r -v 512KB -i process $$

The 512KB is the desired size of the queue and should be sufficient to run this example. If
the number of messages is increased in cross_os_usr.h, then obviously this value will need
to be adjusted.
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Figure 7_1: App/Platform Profiler
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Opening App/Platform Profiler Perspective
From AppCOE main menu, click App/Platform Profiler perspective button as highlighted.

Or,
1. On AppCOE main menu, select Window > Open Perspective > Other >Profileras
shown inFigure 7_2.

Figure 7_2: Opening App/Platform Profiler Perspective
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You can view App/Platform Profiler Perspective as shown in Figure 7_3.

Figure 7_3: App/Platform Profiler Perspective
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Components on the App/Platform Profiler Window

App/Platform Profiler window contains two panes. The left pane has three Profiler
components listed and on the right pane, you can view the respective details and
information in a graphical view.

The three main components of App/Platform Profiler are:

Profiler Data File-This is the generated profiler data file. You can view the performance
report of each API. A profiler data file is saved as a .pal file extension. It has the following
three components:

1. System-This displays the system details of your application as shown inFigure 7_4.

If you select System tab you have the following details which are displayed on the right
pane as shown inFigure 7_4.

e Application Info-Application property values

e Profiler Configuration—-Profiling Application values

Figure 7_4: App/Platform Profiler - System Details
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2. Functions-This displays all the functions called in the application and the time taken
to execute these functions as shown in Figure 7_5.
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the bottom of the window, as highlighted, the function properties are displayed such as:
e Average Function execution time

e Function with the longest execution time

e Function with the shortest execution time

e Number of Functions called in application
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On the left pane, expand the Functions tab. It displays the following information as shown
in Figure 7_6.

e Platform APIs

e Application Functions

Figure 7_6: Platform APIs and Application Functions
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Platform APIs-These are all the OS Abstractor Interface functions called in the
application. On the x-axis, all the functions are displayed. On the y-axis, all functions
iterations are displayed. On the bottom of the window the function properties are

displayed such as:
e Average Function execution time

Function with the longest execution time

L]
e Function with the shortest execution time
e Number of OS Abstractor Interface Functions called in application
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If you expand the Platform APIs, you can view all the platform APIs called in the application
as shown inFigure 7_7. On the bottom of the window, the function properties are displayed
such as:

e Average execution time

e Instance with the longest execution time The Task _1lin square brackets denote that
these function properties belong to the Task 1 Thread.

e Instance with the shortest execution time
e Total number of times function was called

If you click on a Platform API, you can view the number of instances of the specific function
on the x-axis and the time taken for each API on the y-axis.

NOTE: On top of the profiler view, you can view different measures of time such as:
e Seconds
¢ milli seconds
e micro seconds
e nano seconds as highlighted in the Figure 7_7

This is used to capture the time taken for each instance of the function in different time
measures. If you click on nano seconds, the time graph will be shown as Time (nano
seconds) as shown in the Figure 7_7.

Figure 7_7: Platform APIs
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Application Functions

These are all the user specific functions called in the application. On the x-axis, all the user
specific functions are displayed. On the y-axis, all functions iterations are displayed. On the
bottom of the window the function properties are displayed as shown in Figure 7_8 such as:

e Average Function execution time

e Function with the longest execution time

¢ Function with the shortest execution time

¢ Number of times Application Functions are called in application

Figure 7_8: Application — Functions

- 00— g
1 Profiler - demo_cross_os/source/_os_init_windows_host.c - Application Commen Qperating Environment EE
File Edit Source Refactor Mavigate Search Project Run Tools Window Help
il & BHE % & THrR e
T} %5 Debug (2 Projects
[ Profiler Data Explorer &% = B [ Profiler View 3 T
4 profiler_data_1210343810
ﬁ System
4 %% Functions
. 0 pPlatform APIs .
4 (B Application Functlons__ 4200000 o
@ OSA_TEST_OS_Create_FParfitic ; 3,008,762
() OSA_TESI_OS_Allocate_Parti 2200000 g
@ OSA_TEST_OS_Deallocate_P¢ o
- @ OSA_TEST_OS_Delete_Partitic < 2400000
Il > wr Threads -
£
S 2000000
@
w
© 1800000
c
2
= 1200000
e +
E
= 200000
400000
o
E
7
i}
Instances of "OSA_TEST_OS_Create_Partition_Pool' Function.
X-axis shows 'Api Iteration [Thread Name]'
T b
El Properties 2 3 = ¥ =0
Property Value
Average execution time 0,003,008,762 Manc Seconds
Instance with the longest execution time 1 [Task_3]
Instance with the shortest execution time 1 [Task_3]
Total number of times Application Function was ci 1
] 1l o *
e

MAPUSLFT -




MAPUSLDFT

Application Common Operating Environment User Manual

3. Threads-Threads are created to execute any function in an application. IN
App/Platform Profiler you can view the Thread properties by expanding the Thread tab

as shown inFigure 7_9. On the bottom of the window the thread properties are displayed
as shown in Figure 7_9such as:

e Average Function execution time

o Instance with the longest total execution time

o Instance with the shortest total execution time

e Number of Functions used by this thread

e Thread ID

Figure 7_9: App/Platform Profiler — Threads
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Tasks-These are functions called for each task. If you expand the Task tab, you have the
following as already discussed under the Functions tab:

e Platform APIs
e Application Functions
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Viewing App/Platform Profiler Data

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

1. Open the App/Platform Profiler perspective.
2. From the AppCOE main menu, select Tools >Load Profiler Data File as shown in

Figure 7_10.
Figure 7_10: Viewing AppCOE Profiler Data
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3. Browse to your saved profiler data file, and click Open as shown in Figure 7_11.

Figure 7_11: Selecting the .pal File Extension to Analyze
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Select an API to view the data and right click on Profiler Data Explorer tab to view the
different graph options as shown in

Figure 7_12.

NOTE: You can select an appropriate graphical viewer to view your profiler data. You
can view the profiler data in a line chart, bar chart, area chart, or a scatter chart.

NOTE: In case of linux, profiling requires cleaning up the system resources before
generating the pal file. Therefore profiler gives the data result for all the required
apis.
e cleanup.pl could be found in
AppCOE<installdir>/Tools/cleanup/cleanup.pl.
NOTE: You can select an appropriate graphical viewer to view your profiler data. You
can view the profiler data in a line chart, bar chart, area chart, or a scatter chart.

Figure 7_12: Selecting the API to view the Profiler Data
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Generating API Timing Report

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

AppCOE now provides you a new feature to view the performance report for each API.

To generate API Timing Report:

1. From the AppCOE main menu, go to Profiler perspective and select any Profiler
Data on your left pane to generate the report.
2. Select Tools > Generate Report. You can also click on Generate Report button

on the AppCOE Tool bar as shown inFigure 7_13.
Figure 7_13: Generate Timing Report
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A Save As window is displayed. Select the directory where you want to save the report and
enter a file name for the report and click Save as shown in

Figure 7_14.

NOTE: In Windows Vista and Windows 7 Windows 8, you cannot generate the profiler
report on c:\, if UAC is turned on. To turn off UAC, refer to the Turning Off UAC. You can
generate the Timing report to generate in any sub-folder inside C drive. For Ex:
C:\pal_report.rtf.

Figure 7_14: Saving the Timing Report
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3. Your Timing Report is successfully generated as an .rtf file extension. The
Timing Report displays the following information:

1. Timing Information—The timing information gives a detailed description of
the following:

e Best Time Value — Specifies the minimum time taken to perform the
action on each platform API
e Worst Time Value — Specifies the maximum time taken to perform the
action on each platform API
e Average Time Value — Specifies the average time taken to perform the
action on each platform API
2. Application Information—When you perform the application profiling on
AppCOE , the report displays the following application property values:

e Total system memory limit—Specifies the total system memory pool
limit of the application.

e Size of the system memory pool- Specifies the size of the system
memory pool of the application.

e Minimum memory pool segment size— Specifies the minimum size of
the memory pool segment of the application.
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e OS Changer VxWorks Interface-Specifies if you have enabled OS
Changer VxWorks Interface.

e pSOS Interface— Specifies if you have enabled pSOS Interface.

e POSIX/LINUX Interface— Specifies if you have enabled POSIX/LINUX
Interface.

e OS Abstractor Interface- Specifies if you have enabled the OS
Abstractor Interface.

e Process mode- Specifies if the OS Abstractor Interface process
feature is enabled or disabled.

o Task pooling— Specifies if the Task pooling feature is enabled for this
application.

e ANSI Memory- Specifies if you want to map ANSImalloc() and free() to
OS Abstractor Interface equivalent functions.Note: We no longer
support this feature in 1.8 AppCOE

e ANSI format IO- Specifies if you want to map ANSIprintf() and
sprintf() to OS Abstractor Interface equivalent functions.Note: We no
longer support this feature in 1.8 AppCOE

e Debug Information level- Specifies if you want to enable the debug
output.

e Error checking- Specifies if you want to enable the error checking.

e Fatal Error— Specifies if you want to enable the feature to ignore fatal
errors.

3. Profiler Configuration—When you perform profiling on AppCOE APIs, the
report displays the following profiling application values:

e File name-Specifies the name of the .pal file generated by OS
Abstractor Interface

e Project name-Specifies the name of your project
e Target name-Specifies the target OS you have selected for profiling
o File size-Specifies the size of the file to be profiled

e Profiler XML format-Specifies the version of the XML used for
profiling

e Process name and ID-Specifies the process name and the ID
e User Data—Specifies the information provided by the user

e Profiling start time—Specifies the starting time of profiling

e Profiling stop time-Specifies the end time of profiling

e Total time profiled—Specifies the total time taken for profiling.

e Number of profiling messages— Specifies the number of profiler
messages.
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Generating Timing Comparison Report

NOTE: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation/ to request an evaluation license.

AppCOE now provides you a new feature to view the comparison of two different
performance reports for the APIs. You can generate a timing comparison report only when

the following preconditions are met:
e Both the PAL files must have the same project name.
e Both the PAL files must have a profiling time less than 5 minutes.

Note:Do not generate PAL files within 60 seconds.

To generate Timing Comparison Report:

1. From the AppCOE main menu, go to Profiler perspective and select any Profiler
Data on your left pane to generate the report.
Select Tools > Generate Comparison Report. You can also click on Generate

Comparison Report button . on the AppCOE Tool bar as shown inFigure
7_15.

Figure 7_15: Generate Timing Comparison Report
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3. An Import PAL file window is displayed. Select the PAL file by clicking on the

Browse button or entering the second PAL file path in the text box. A Profiler
Categorization Dialog box is displayed. NOTE: If you comparing the two PAL files
for the first time, click OK. If you are comparing the same two files for the

second time, click Cancel. as shown in Figure 7_16.

Figure 7_16: Import PAL File
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[ OK ] [ Cancel

< Back Next > Finish Cancel
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The field descriptions for importing the PAL file are described as follows:

Table 7_1: Field descriptions for importing the PAL file

Field

Description

Your Action

Select PAL File

Specifies you to
select the PAL file
for which the

Timing Comparison

Report has to be
generated.

To select the PAL file, click Browse,
and select it from your system.

Report for

Specifies what you

are comparing.

You can do any one of the following,

and click Next:

e To compare only the differences,
select the radio button before
Differential Data.

Note: By default, this feature is
disabled.

e To compare all the data in the PAL
files, select the radio button before
All Data.

Note: By default, this feature is
disabled.

Figure 7_17,click Finish
Figure 7_17: Selecting the APIs

4. Select the APIs you want to generate the Timing Comparison Report as shown in

Comparison Report
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4. Save As windowwill bedisplayed. Select the directory where you want to save the
report.Enter a filename for the report and click Saveas shown in Figure 7_18.

Figure 7_18: Saving Timing Comparison Report
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6. Your Timing Comparison Report is successfully generated as an .rtf file

extension as shown in Figure 7_19.

Figure 7_19: Generated Timing Comparison Report
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Chapter 8. Introduction to Ada C/C++ Changer

This chapter contains the following topics:

Ada C/C++ Changer in AppCOE

Creating Ada-C Changer project
Using the Ada Source Directory

Configuration with Linked Libraries
Configuration with Multiple Source Directories
Specifying the Configuration

Program Library Options Tool (adaopts)
Source Registration Tool (adareg)

Adacgen

Adacgen Options
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Ada C/C++ Changer in AppCOE

Note: This feature requires a license. Click http://mapusoft.com/downloads/AppCOE-
evaluation to request an evaluation license.

AdaC/C++Changer-allows developers to easily convert software written in Ada code to
C/C++ utilizing AppCOE . The resultant C/C++ software can be integrated with the robust
OS Abstractor® environment to support a wide variety of host and target OS platforms. The
automatic conversion process eliminates the need for costly and tedious code rewrites,
providing extensive resource savings. Ada-C/C++ Changer generates ANSI C output as well
as certain C++ features while preserving Ada code’s comments, files, structures and
variable names to ease ongoing code maintenance.

Creating Ada C/C++ Changer Projects

Note: This feature requires a license. Click www.mapusoft.com/downloads/ to request for
an evaluation license.

Creating Ada-C Changer project

Ada-C Changer converts Ada 83 or Ada 95 Programs to C Source Code and keeps the C
Source Code in Projects.

1. From AppCOE main window, select any project under C/C++ Projects tab on the
left pane.
2. Select New > Ada-C Changer Project as shown inFigure 8_1.

Figure 8_1: Ada-C Changer project

Projects - Application Common Operating Environment (AppCOE) E@
File Edit Source Refactor Navigate Search Project Tools Run Window Help
£~ [ LR FErOv Qv 5 R
J E}fl Profiler
B C/C++ Projects 2 =g =B
a@ ~

> ¥ demo_ada_to_c

> £ demo_cross_os

> £ demo_nucleus

- L demo_posix

> ! demo_psos New » L] AppCOE C Project

> Cl demo_threadx B AppCOE C++ Project

Import...

> L demo_uitron Export..

Ada-C Changer Project

> L demo_wworks

- £ demo_windows

- [ Sample AppCOE Project
- 1 sudoku

Resource Configurations HA

I* Problems | & Console & | 2 Properties| |
CDT Build Console [NewAdaC]

9 Project.

7 Example..

i Other.

Ada-C++ Changer Project

New Ada-C Project

New Ada-C++ Project

| BRI B~5~= 18
Source Folder {

Folder

Source File

Header File

File from Template

Class

Ctrl+N

220



http://mapusoft.com/downloads/AppCOE-evaluation
http://mapusoft.com/downloads/AppCOE-evaluation
http://mapusoft.com/downloads/ospal-evaluation/

'S F.[Application Common Operating Environment User Manual

Creating Ada-C++ Changer project

Ada-C++ Changer converts Ada 83 or Ada 95 Programs to C++ Source Code and keeps
the C++ Source Code in Projects.

1. From AppCOE main window, select any project underC/C++ Projects tab on the left
pane.

2. Select New >Ada-C++ Changer Project as shown inFigure 8_2.

Figure 8_2: Ada-C++ Changer project
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New Ada-C Template (Hello World)project converts a Hello World Ada Program to C
Source Code and keeps the C Source Code in Projects.

1. From AppCOE main window, select any project underC/C++ Projects tab on the left

pane.

2. Select New >New Ada-CProject as shown inFigure 8_3.

Figure 8_3: Create Ada-C Template
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Creating Ada-C++Template project:

Ada-C++ Template (Hello World)project converts a Hello World Ada Program to C++
Source Code and keeps the C++ Source Code in Projects.

1. From AppCOE main window, select any project underC/C++ Projects tab on the left
pane.

2. Select New >New Ada-C++ Project as shown inFigure 8_4.

Figure 8_4: Create Ada-C++ Template
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Using the Ada Source Directory

The Ada Source directory contains all information needed to support the separate
compilation requirements of Ada. The primary contents of the Source directory are Ada
source files, all object modules and info files created by the compiler are stored in the
AppCOE Projects. Since no intermediate compilation form is saved, the Ada C/C++ Changer
performs a semantic analysis of the appropriate source files, as necessary, to handle any

separate compilation requirements.

Figure 8_5: Import Ada Files

Ada-C Changer Wizard B X

Ada Source Directories:

Di\Examples\ADA_App\MultiLevel TC1\MultiLevel 2
Di\Examples\ADA_App\MultiLevel TC2
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.spc + | |IRemove
sub
.bdy
.adb
.ada

m

["] Specify option file Browse...

Import Ada files A
Select the directory containing your Ada files

This source-based program library model simplifies the use of the AdaC/C++ Changer and

program builder:

e There are no compilation order requirements for compiling Ada source. As long as
the Ada source for depended-upon units is available, it is not necessary to compile

them first.

e There are no constraints on the user’s approach to file organization or configuration

management.

e There are no significant disk storage requirements for the program library beyond

that required for the source and object modules.
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Ada Source Directory

In Ada Source directory, you inform the library of the location of the Ada source for the
program. The source can be in one directory, in multiple directories, or in multiple program
libraries. Once this information is provided, the Ada C/C++ Changer and program builder
can automatically locate source files containing the required units, as needed. The following
subsections describe the program library, with details about how the Ada C/C++ Changer
and program builder use this program library.

Two tools are provided for maintaining the program library:

e The program library options tool, adaopts, can be used to display or modify the
program library parameters. This creates ADA.LIB.

e The source registration tool, adareg, establishes which units are defined in which
source files. A description of the use of these tools follows the description of the
program library. This creates UNIT.MAP.

An Ada program library is based in a directory called the program library directory. All
information about the program library and all generated files are kept in the program
library directory (or unspecified subdirectories).The main contents of the program
library are the source files and object modules. There is considerable flexibility with
regard to the actual location of the source files. This will be evident in the examples
that follow.Configuration with Multiple Source Directories

In a larger program, the source files composing the Ada program are often located in several
directories. To support this source configuration, the program library provides a source
directory list which points to the directories containing the source. In this configuration, the
source can be distributed in any convenient way among any number of source directories.

Configuration with Linked Libraries

For more complex programming efforts, it may be desirable to partition the source code into
sub systems, each of which is maintained within a separate program library. To support
this model, the Ada program library supports linking to other existing libraries. The user
need not know the location of the source for a linked library, just its program library
directory. If the linked library is itself linked to another library, that library also needs to be
added as a linked library for the current library. The source files and object modules of a
linked library may only be referenced in a read-only fashion.

Specifying the Configuration

The program library’s configuration is determined by the values of program library
parameters. The configuration described above is the default configuration created
automatically by the first invocation of the Ada C/C++ Changer. The primary difference
between the “multiple source directories” model and the “multiple linked libraries” model is
what happens when adabgen discovers that a source file needs to be [re]Jcompiled:

e If the source file is part of this program library, adabgen will recompile it.

e If the source file comes from a linked library, adabgen will refuse to recompile it, and
will give an error message.

Therefore, the “multiple source directories” model is more convenient for most projects.
ADA.LIB and UNIT.MAP

An Ada Changer tools contains two files—ADA.LIB and UNIT.MAP. These two files, which
are located in the project are automatically created the first time the Ada C/C++ Changer, is
invoked. ADA.LIB contains information describing the configuration of the library.
UNIT.MAP contains a unit-to-source mapping for use by the compiler and program builder.
When the program library is created, if a UNIT.MAP file already exists in the current
directory, it will be used for the new program library’s UNIT.MAP.
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Source Files
The Ada source files in the program library include:
e All Ada source files in the program library directory

e All Ada source files in directories specified in the program library’s source directory
list.

e Any other source files which have been registered in the UNIT.MAP.

e To be automatically recognized as Ada source files, the files in a directory must have
one of the following file extensions: .a, .ada, .adb, .ads, .bdy, .dat, .spc, .sub. You
can also use any new extensions of user choice as shown in Figure 9_2.

e There is no naming restriction for source files explicitlyregistered. Source files in the
UNIT.MAP of linked libraries are not contained in the current program library, but
they are visible for read-only reference by the compiler and program builder.
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Generated Files

The Ada C/C++ Changer output also includes files generated by the compiler or
program builder. These include:

¢ Object module files (*.0 or *.obj) and information files (*.info) for Ada source files in
the program library.

¢ Executable files (*.exe) for main units in the program library.
e Optional listing files (*.Ist).
e Optional cross reference files for use by the cross reference compiler option.
e Other intermediate files, if kept (see the -ke option).
Ada C/C++ Changer Library Interaction

The Ada C/C++ Changer uses the program library to locate the source files needed to
handle semantic dependencies during compilation of a specified source file. Some of the
situations in which this may occur are the following:

e To locate a with’ed unit or the parent unit for a separate clause or child unit
e To locate the library unit specification, if any, when a library unit body is being
compiled
e To locate the body of a generic, if any, when the generic is instantiated
e To locate the body of a subprogram in another library unit to which pragma Inline
applies
e To locate the body of a stub contained in a subprogram
This requires a method for locating a source file from a unit name during compilation. This
is only required if the needed unit is in a source file that has not yet been analyzed in the
current invocation of the compiler.
Locating the Source File
The order of the search for locating a unit during compilation is as follows:
e First, check the UNIT.MAP of the program library;
e Then, check the UNIT.MAP of each linked library in the order of the library search
list.
Ada Program Builder/Library Interaction
The Ada program builder uses the Ada program library to locate the object module file and
the information file for each unit needed in the main procedure. Since the names of these
files are based on the source file name, the unit-to-source correlation is required. The
method used to determine this is similar to that used by the compiler.
Locating the Information File and Object Module
To determine the name of the source file, the program builder checks to see if a unit is

registered in the program library or any linked library. Thus, the effective order of the
search by the program builder is:

e First, check the UNIT.MAP of the program library

e Then, check the UNIT.MAP of each linked library in the order of the library search
list

Once the source file name is found, it may be that the corresponding information and object
module files do not exist because the source was never compiled, or they are out-of-date
because the source file, or some source file on which it depends, has changed. If the
missing or out-of-date object module belongs to a source file in one of the linked libraries,
the program build will fail because linked libraries are read only. Otherwise, the program
builder implicitly invokes the Ada C/C++ Changer to create the needed object module and
information file.
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Predefined Run Time System

There is ‘C’ run-time sources that provides I/0, tasking, exception handling, and memory
management modules which are normally required by Ada 95 language for the ‘C’ converted
code base. These are called Ada run time system (RTS).

Program Library Options Tool (adaopts)

Overview

The program library options tool (adaopts) supports tailoring the program library to meet
the needs of a particular Ada project. For small Ada projects, it is unlikely that this tool will
be needed because the behavior of the compiler and builder are, by default, configured for
small projects.

For more complex programs, the user may direct the program library options tool to
distribute source to multiple directories, create links to existing program libraries, place
object modules in a separate subdirectory, etc.

The program library options tool supports the following functions:
e Creating a new program library.
e Listing all or specific values for the program library options.

e Modifying the source directory list, the library search list, the object file
subdirectory, the information file subdirectory, or the cross reference file
subdirectory.

Listing the source file names or library unit names registered in the program library.
Program Library Options Tool Outputs

The program library options tool modifies the ADA.LIB file in the project directory.
Messages
Messages and displays generated by adaopts are written to standard error.

Source Registration Tool (adareg)

Overview

The source registration tool (adareg) maintains the UNIT.MAP file. The UNIT.MAP file, which
is located in the project directory, contains the unit-to-source correlation of all source files
that have been registered in the program library. The source registration tool is used to
register additional source files in the program library.

The source registration tool provides the following function:
e Explicit registration of a specified source file(s)

Registration is performed by doing a syntax analysis of a source file to determine the name
and kind of the units in the file, and then adding that information to the UNIT.MAP. When
the source registration tool is invoked with a list of source files or directories containing
source files, registration is performed on all files specified on the command line. When the
source registration tool is invoked with a directory name, it registers all files with the
following extensions: .a, .ada, .adb, .ads, .bdy, .dat, .spc, .sub. This is stored in your newly
created Ada C/C++ Changer project

Conflicts during Registration
The following restrictions apply to source file registration:

e Two source files with the same simple file name, exclusive of the directory path,
cannot be simultaneously registered.

e Two source files containing the same library unit cannot be simultaneously
registered.

If either of these situations arises during source file registration, the source files are said to
conflict and one of the source files and its units overrides the other, depending on whether
the registration is explicit or automatic. Explicit registration of a source file, either by
compiling or by the source registration tool, overrides any previously registered source files
with which it conflicts. When a registered source file is overridden, it remains in the
UNIT.MAP, but its units are marked as Invalid.




S@ F.I:Application Common Operating Environment User Manual

Source Registration Tool Outputs

The source registration tool modifies the UNIT.MAP file in the current directory. All source
registration tool messages are written to standard

Adacgen

The Ada-Compiler translates Ada 95 source programs into relocatable object modules and
records dependency information for use by the program builder. It optionally generates
source listing, assembly listing and debugger information for use by the symbolic debugger.
The Ada C/C++ Changer consists of two phases—the front end and the back end. The front
end performs syntactic and semantic analysis. It generates C source files as input to the
back end. The back endof the Ada C/C++ Changer is an ISO/ANSIC compiler. It performs

code generation, applies optimizations, and generates a relocatable object module.

Compiler Inputs
Invocation
adacgen [option..] [file..]

The adacgen command invokes the Ada C/C++ Changer for one or more files. If the
specified source files have semantic dependencies on other units, the source files for those
units must be located either in the program library or in one of the linked libraries. If a
source file depends on a library unit not yet processed by the current invocation of the
compiler, the compiler will find and process that library unit (through the front end only)
provided that the source file containing the required library unit has been registered in the
program library or is in a linked library. This proceeds recursively, if necessary, until the
closure of all depended-upon library units have been processed.

Listing Options
For the listing options, the compiler generates the requested listing for each file specified on
the command line.

Table 8_1: Compiler Generates the Requested listing Options for Each
File

Listing Options Description

-lc* The -lc option causes the compiler to generate a
continuous source listing without pagination or
headers. Any errors or other compiler-generated
messages are interspersed in the listing. The listing
is written to file.lst.

-le* The -le option causes the compiler to generate a
source listing only if there are errors. If neither -lc, -
Ip, or -lr are specified, the listing is generated
without pagination or headers, with interspersed
error messages, as if -lc had been specified. The
listing is written to file.lIst.

-If filename When used in conjunction with the -lc, -le, -1p, or -Ir
option, the -If option causes the compiler to write
the listing to filename instead of the default file.Ist.
-lp* The -lp option causes the compiler to generate a
line-numbered listing with pagination and a header
at the top of each page. The page is 60 lines long
and 80 columns wide. Any errors or other compiler-
generated messages are interspersed in the listing,
which includes all messages generated by the
compiler. The listing is written to file.lst.
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Listing Options Description

-Ir* The -lr option causes the compiler to generate a
listing containing only those lines for which compiler
messages were generated, as well as the compiler
messages. The listing is written to file.lst.

-Ix* The -1Ix option causes the compiler to generate a
cross reference listing. This cross reference listing is
a line-numbered listing followed by a cross reference
table. This listing is written to file.xIst. A binary
cross reference file file.ref will also be generated.

-pl length* This sets the page length for the paginated source
listing to length lines. This option has no effect
unless used in conjunction with the -lp option.

-pw width* This sets the page width for the paginated source
listing to width columns. This option has no effect
unless used in conjunction with the -lp option.

-nh No headers in listings.

* The marked Adabgen options are already added in Ada-C/C++ Changer. Do not
add these in your additional options tab. If you add these options, it will break
your application.

Message Options

-m msg_kind This suppresses the display of any messages of
msg_kind.

+m msg_kind This enables the display of any messages of
msg_kind.

-mrmsg_kind This suppresses the display of any messages of

msg_kind for the current invocation of the compiler
and for any recursive invocation of the compiler.
+mrmsg_kind This enables the display of any messages of
msg kind for the current invocation of the compiler
and for any recursive invocation of the compiler. The
valid values for msg kind are:
i. a — all messages, except that “-m a” does not
suppress error messages.
ii. d— implementation-dependent messages.
iii. e— error messages.
iv. i— information messages.
v. n— not-yet-implemented messages.
vi. Ww— warning messages.
rii. r— redundant messages

By default, all messages except information and redundant messages are displayed for the
current invocation of the compiler. For recursive invocations, no messages are displayed by
default. For convenience, “-m a”, will suppress all messages except errors.

Adacgen Options
Table 8_2: adacgen Options

Options Description

-0 The -0 option identifies the version number of the
executable. (That’s a zero, not an oh)

-a If the -a option is specified, compilation will stop after
semantic analysis. No output is generated.

-C If the -c option is specified, compilation will stop after
the front end. No output is generated.

-discard_names This option has the same effect as using pragma
Discard_Names.
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Options

Description

-e count

The -e count option causes the compiler to report only
the first count errors. The default is 100.

-€0

The -eo option enables optimizations that are performed
by the front end. This is the default.

_ga

Generate Ada-oriented debugging information. The -ga
option causes the compiler to generate the appropriate
code and data for operation with the C debugger, but in
a way that should cause it to display the Ada source
code rather than the C source code.

_gC

Generate C-oriented debugging information. The -gc
option causes the compiler to generate the appropriate
code and data for operation with the C debugger. This
option also causes the intermediate C source files to be
saved for use as program source files for the debugger,
providing C-source-level debugging.

-help

or -h

The -help option shows the different options that can be
used with the adacgen command.

-late_inlines

The late-inlines option allows pragma Inline to be
specified after a specless subprogram body. This option
provides compatibility with Ada 83, and allows more
aggressive inlining.

-N check* Suppresses numeric checks. The check can be one of:
e division_check
e overflow_check
These checks are described in the RM. Using -N reduces
the size of the code and increases its speed. Note that
there is a related adacgen option, -s, to suppress all
checks for a compilation.

-noeo The -noeo option disables optimizations that are
performed by the front end.

-NOXr The -noxr option disables generation of cross reference
information by the compiler for use by a browser. This is
the default.

-Olevel The -O option (that’s an oh, not a zero) controls the
optimizations that are performed by the compiler back
end. The accepted values for level are none, all, debug, 1,
2, and 3. These have the following effect:

e None— disable all optimizer options.

e All— same as -0O3

e Debug — disable optimizations that substantially
interfere with debugging. No optimizations are
specified for the C compiler back end.

e 1— pass -O1 to C compiler back end.

e 2— pass -02 to C compiler back end.

e 3— pass -03 to C compiler back end.

If the -O option is not specified, -Olis passed to the C

compiler back end (e.g. gcc).

-of file* The -of option causes the compiler to read options and

file names from the specified file. These are processed as
though the contents of the file were on the command
line.

-pB “BE options”

The -pB option passes the specified BE options to the
back end. All text within the quotations is passed
directly to gcc. These options precede the other options
that adacgen generates and passes to gcc.

-prl

Record layout listing for packed record types.
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Options Description

-q* The -q option specifies quiet mode. It suppresses all
nonessential messages.

-rl Record layout listing for all record types.

-s The -s option suppresses all automatic runtime

checking, including numeric checking. This option is
equivalent to using pragma Suppress on all checks.

-sleh Suppress Language Exception Handlers. If this option is
specified, exception handlers that handle predefined
exceptions (Constraint_Error, Program_Error,
Tasking Error, and Storage_Error) are removed from the
program, if the exception is always propagated.

-speh Suppress Propagating Exception Handlers. Same as -
sleh, but applies to user-defined exceptions as well.

- This option has the same effect as using pragma
suppress_aggregate_temps | Suppress_Aggregate_Temps.

-T The -T option causes the compiler to report timing
information for the compilation of each source file
specified on the command line.

-V The -v option specifies verbose mode.

* The marked Adabgen options are already added in Ada-C/C++ Changer. Do not add
these in your additional options tab. If you add these options, it will break your
application.

Options for Maintainers
The following options are provided for use by maintainers of the compiler.

Table 8_3: Options For Maintainers

Options Description

-b The -b option causes the message file (created by the front
end) to be retained; normally it is deleted, as its contents are
cryptic.

-f* The -f option forces the generation of intermediate files even
if the compiler finds errors.

-ke* The -ke option specifies that intermediate files, which are
normally deleted, are to be kept.

-ki* Keep the information file generated by the compiler. The

information file is generated by default except when the —a
or -c option is used, or if the compilation terminates without
generating an object module file.

-ne The -ne option specifies that the adacgen process will not be
restarted on failure. If the -ne option is not specified, the
adacgen process will restart upon severe internal error such
as a segment violation, bus error, or assertion failure. The
process will restart with the file that was being processed
when the failure occurred. If the file causes a severe error
again, adacgen will restart with the next file to prevent
infinite reprocessing of that file.

-nl The -nl option specifies that the adacgen process will be
restarted with the next file after the file that was being
processed when the failure occurred. The default behavior
without -nl is to restart with the file that caused the failure.
(See also -ne.)

-nonr The -nonr option specifies that the compiler front end may
release any heap memory to the current heap.
-nz The -nz option initializes all heap memory used by the

compiler front end to a nonzero value. In hex, the nonzero
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Options Description
value is BAD1BAD1so it is easy to spot in the debugger, and
causes a Bus Error on a Sparc when it is dereferenced.

-pL “L options” The -pL option passes the specified L options to the lister.

-t The -t option generates a trace message as each declaration
and statement is passed to the emitter phase of the front
end.

-xB exe-path The -xB option overrides the default back end and uses exe-
path instead.

-xddir-path The -xd option overrides the default ADA_MAGIC
environment variable and uses dir-path instead.

-xL exe-path The -xL option overrides the default lister and uses exe-path
instead.

+bw This displays all warning messages generated by the Ada
C/C++ Changer back end (e.g. by GCC).

* The marked options are already added in Ada-C/C++ Changer. Do not add these in

your additional options tab. If you add these options, it will break your application.

Compiler Output Files

Files produced by compilations are:
Table 8_4: Compiler Output Files

Output Files Description

file.info Information recorded during compilation of a source file
which is used by the program builder to determine if the
object module is valid.

-file.o or file.obj Relocatable object module files, one for each source file in
the compilation.

These output files are placed according to the program library parameters. Also produced
are various intermediate files; these are usually deleted as a matter of course unless the -ke
option is specified.

Additional files that may be produced by a compilation are:

Table 8_5: Additional Compiler Output Files

Output Files Description

file.lst Source listing if any of the -lp,-lc or -Ir options are specified.

file.xlst Cross reference listing if the -1x option is specified.

file.xref Cross reference information in a binary format. This is for
use by a browser and the cross reference lister.

Compile-Time Messages

All compiler messages are written to AppCOE Console View. When error messages are
printed, processing does not proceed beyond the front end. No intermediate files or object
code files are produced. Warning and other informational messages do not prevent further
processing. The back end (i.e. C compiler) may print error messages as well; however, these
will be error messages related to problems internal to the compiler itself. The option “-m a”
can be used to suppress all warning and informational messages generated by the compiler.
If there is an internal error in the compiler, the options -v and/or -t and/or +mr a can be
used to help determine what part of the compiler contains the error; this might help you
work around the problem.

The compiler may implicitly perform semantic analysis of other source files in the program
library or in a linked library during an invocation in order to handle semantic dependencies
on other compilation units. Compile-time messages generated during implicit processing
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are displayed only if the +mr option is used. Otherwise, compile-time messages are written
only for processing of the source file(s) specified in the adacgen command.

Adabgen

The Ada program builder provides the facilities for creating a load module for an Ada
program. It finds the object modules needed to build the executable, determines the
elaboration order, and invokes the target linker to generate the load module.

In addition, the program builder implicitly invokes the compiler as needed so that all object
modules are up-to-date with respect to any source files on which they depend. In fact, it is
not necessary for the user to invoke the compiler directly at all — the entire program
building process, including compilation, can be handled by the program builder, if desired.
The load module generated by the program builder is in the format created by specified
linker.

Program Builder Processing

Program builder processing is divided into two phases — prelinking and linking. The
prelinking phase handles those Ada 95 requirements that are processed at build time and
identifies the list of object modules that make up the program. The linking phase invokes
the target linker to combine the object modules to form a load module with all references
resolved.

Prelinking

The prelinking phase performs three functions:
o [t determines the complete list of units needed for the main procedure;

e [t finds or generates all object modules for the units on this list, ensuring that they
are up-to date

e [t determines an acceptable elaboration order.

To perform these functions, the prelinker uses the information files generated by the Ada
C/C++ Changer. These files contain the names of depended-upon and needed units. For a
description of how the information files in the program library are found.

Finding the information files results in implicit invocations of the compiler for source files or
units in the current program library if:

e The source file containing a needed unit has either never been compiled
e Or has been modified since it was last compiled

e Or a source file on which a unit depends has been modified since the unit was
compiled.

The program builder uses time stamps to determine if a source file has been modified.

The prelinking phase handles all of the compilation order and completeness requirements
for building the Ada program. If a part of the program is missing, or if the Ada source code
contains incorrect dependencies, the prelinking phase will detect and report this.

Linking

The linking phase of the program builder is handled by the linker.The linking phase uses
the default C runtime library as well as the Ada run time library.

Adabgen Inputs

Invocation
adabgen [option..] [main-procedure-name..]

The adabgen command creates an absolute load module for the main procedure. The
adabgen command must be invoked in a program library directory. If the current directory
is not a program library directory, a program library is automatically created there.

The main-procedure-name must be a procedure for which the Ada source for all needed
units is located either in the program library, or in one of the linked libraries. Multiple main
procedures may be built in a single invocation of the builder.
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NOTE: Do not confuse the name of the source file containing the main unit (e.g. simple.ada)
with the main unit name (e.g. simple).

adabgen Options

In addition to the options listed below, adabgen accepts all compiler options. These are
applied to all invocations of the compiler that are made by the program builder.

Table 8_5:adabgen Options

Options

Description

-0

The -0 option identifies the version number of the
executable. (That’s a zero, not an oh)

-f

The -f option forces linking to occur even if there are
prelinker errors.

_ga

Generate Ada-oriented debugging information. The -ga
option causes the program builder to build an
executable containing Ada-oriented debugging
information. The -ga option is also applied to any
implicit invocations of the compiler during program
building.

_gc

Generate C-oriented debugging information. The -gc
option causes the program builder to build an
executable containing C-oriented debugging
information. The -gc option is also applied to any
implicit invocations of the compiler during program
building.

-h or -help

The -help option shows the options that can be used
with the adabgen command.

-ke*

The -ke option specifies that intermediate files, which
are normally deleted, are to be kept.

-11 option

The -1l switch passes option to the target linker. For
example, to pass “-map foo.map” to the target linker,
use “1l -map -llfoo.map”. Options passed via the -1l
switch follow the options to the linker that is
generated by the Ada program builder.

-nc

The -nc option prevents recompilation. Normally, the
Ada C/C++ Changer is invoked by the adabgen
command to recompile Ada programs as needed.

-nl

The -nl option prevents -calling the linker. The
prelinker is called but the target linker is not.

-no

The -no option prevents recompilations to recreate .o
files that are out of date.

-o file

The -o option specifies the name of the output file
(used instead of the default filename).

-ol file

The -ol file option passes file to the target linker

*

The -q option specifies quiet mode.

-r

Use a more “friendly” elaboration order. The default is
to use an order that is more likely to fail but which
can lead to more portable programs.

The -v option causes the program builder to print
informational messages as processing proceeds. The -
v option is also applied to any implicit invocations of
the compiler during program building.

* The marked options are already added in Ada-C/C++ Changer. Do not
add these in your additional options tab. If you add these options, it will
break your application.
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Ada C/C++ Changer Outputs

Output Files

The Ada program builder generates a corresponding load module for eg., main-procedure-
name.exe.

Messages
All program builder messages are written to console view.
Main features of Ada C/C++ Changer

The Ada run-time is written in Ada 95, and then translated to C/C++. The run-time is
layered, and is re-hostable on various operating systems. As delivered, it depends only on
C’s native setjmp/longjmp, but is structured to allow re-hosting on POSIX/LINUX-like OS’s,
or other RTOS’s that have support for threads and some kind of “mutex”.

Ada C/C++ Changerconverts 100% of the Ada source into C, with no human intervention.
Our tool is based on a fully validated Ada C/C++ Changer, which handles the full Ada 95
language. It produces efficient and readable C that exactly matches the semantics of the
original Ada program.

A single Ada source file can have any kind of code within it, though some compilers are
more restrictive than that and use specific naming conventions (such as Rational’sl.ada
and 2.ada, or AdaCore’s .ads and .adb). Ada Tool is designed to handle any organization of
code within source files. Furthermore, even though a source file might contain only a
package spec, it might still have code that needs to be executed when the package is
“elaborated.” This code will be placed in the “.c” file for the package spec. Similarly, even
though a file might contain only a package body, it might have “subunits” or “inlined”
subprograms that need access to its local declarations, and so those are placed in an “.h”
file for the body.

Ada-C/C++ Changer is very portable because the Ada Tool’s RTS relies mostly on the
standard C run-time. However, C run-time support is not truly “real time” as it uses C
“setjmp/longjmp” to accomplish multi-threading, which is not very flexible.

But by adapting the Ada Tool RTS to use the OS Abstractor POSIX/LINUX Interface
(Mapusoft) APIs, we can use “true” multithreading, and still be very portable to multiple OS
and RTOSs,
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Chapter 9.Working with Ada Changer

This chapter contains the following topics:

Working with Ada C/C++ Changer Projects
Ada C Changer Projects with Ada-C/C++ Scheduling

Ada C Changer Projects with Real-time OS Abstractor Scheduling
Select Ada-C/C++ Changer build configurations

Import Ada Source files to project

ADA C/C++ Changer Configuration Options

Building Ada C/C++ Changer Projects

Target Code Generation for Ada C/C++ Changer Projects

Ada C/C++ Changer Property Page

ADAC/C++ Changer — Additional Information’s

Additional Ada C/C++ Changer Tools
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Working with Ada C/C++ Changer Projects

Ada-CChanger converts Ada 83 or Ada 95 Programs to C Source Code and keeps the C
Source Code in Projects.

1. From AppCOE main window, select any project underC/C++ Projects tab on the left
pane.

2. Select New >Ada-C Changer Project as shown inFigure 9_1.

3. From AppCOE main window, select any project under C/C++ Projects tab on the left
pane.

Figure 9_1: Creating Ada-C Changer Project
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On Ada-C Changer Project Wizard window, type a project name and give a location next to
Project Name text box.

Note 1: The project name should not be more than 256 characters.

Note 2: Please avoid creating an eclipse workspace in a deeply nested sub-directory.

4. Under Project Types, expand the Executable menu. Select Ada-C/C++ Scheduling
or Real-time OS Abstractor Scheduling and click Next as shown inFigure 9_2 .
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Figure 9_2: Ada-C/C++ Changer Wizard

Ada-C Changer Wizard R—— =SEL X

Ada-C Changer Wizard A ’

Create Ada-C Changer Project

Project name: Sudoku

Use default location

DAMapuSoft\appcoe\AppCOE_Winx32_Beta2\workspace\Sudoku Browse...
Project type: Toolchains:
4 = Executable MinGW GCC

® Ada-C/C++ Scheduling
® Real-time OS Abstractor Scheduling

Show project types and toolchains only if they are supported on the platform

P . o

Ada C Changer Projects with Ada-C/C++ Scheduling

Ada C Changer Projects created with Ada-C/C++ Scheduling will not include OS
Abstractor Features.

Ada C Changer Projects with Real-time OS Abstractor Scheduling

Ada C Changer Projects with the Real-time OS Abstractor Scheduling, will include
OS Abstractor Features.

Note 1:If Real-time OS Abstractor Scheduling option is selected then proceed to
next step

Note 2:If Ada-C/C++ Scheduling option is selected thenskip step 5.

5. On Basic Settings window, define the basic properties of your project and click
Nextas shown in Figure 9_3.
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Figure 9_3: Basic Settings Window for Ada-C/C++ Changer Project

L2 Ada-C Changer Wizard = (3 ][5

Basic Settings
Basic properties of a project

Application Name  Sudoku

Application Prefix  /

Author Name

Copyright notice Application Copyright Notice

Greeting Message  Application Welcome Message

@ T

Select Ada-C/C++ Changer build configurations

6. On Select Configurations window, select the platforms and configurations for
deployment and click Next as shown in Figure 9_4.

Figure 9_4: Select Ada-C/C++ Changer build configurations

/2 Ada-C Changer Wizard EE
Select Configurations A }

Select platforms and configurations you wish to deploy on

Project type: Executable
Toaolchains: MinGW GCC

Configurations:

| % Debug Select all
[¥] ® Release
Deselect all

Advanced settings...

Use "Advanced settings” button to edit project's properties.

Additional configurations can be added after project creation.
Use "Manage configurations” buttons either on toolbar or on property pages.
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7. On Import Ada Files page, enter the Ada source directories using the Browse button

as shown in Figure 9_5.

Figure 9_5: Import Ada Source files to project
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The field descriptions for Import Ada Files page are as follows:

Table 9_1: Field Descriptions for Import Ada Files

Field Description Your Action
Ada Source | The Ada source | Select the Browse Button to add your
Directories directories contains Ada | Ada source directories
source files, all object | Select the Remove button to remove any
modules and info files | of the Ada Source directories
created by the Ada | Note: To add or remove the source
Changer and stored in | directories after creating the projects,
AppCOE Projects. go to Project > Properties > Ada
Changer
Main Ada Specifies the main | Select the check box to enter the main
procedure procedure name of the | Ada procedure name. For example:
project the user imports | gudoku Test.
that is converted to the . . .
. . ... | Note: To import a library project use
main C function that will the -all option for th . d
be started as thread in e -all option for the main procedure.
OS Abstractor or other
interfaces.
Enter Ada Specifies the source files | you can do any one of the following:
File that have extensions .
Extensions | other than the default | ° To add a new extension 'other than
. . . . the default ones, enter in the text
used in extensions listed in the .
your Ada drop down list. The box and click Add.
Project default extensions listed Note: By default, this is enabled.
here are: .a, .ada, .adb, | ¢ To remove an extension, select the
.ads, .bdy, .dat, .spc, .sub extension from the drop down list
and click Remove.
Notel: Default extensions already
available cannot be removed
Note 2: Ada Extensions are case
sensitive
Specify Specifies if the user wants | To specify an option file, select the
Option File | to specify any set of | check box and click Browse and select
options that are needed | the option file.
for the Ada- Note: If option file is specified then Ada
C/C++Changer. . . .
Note: This can be created cqnﬁgu ratlon. (.)pt1ons. bage will open
. « ,, with the specified options in the option
using space as | pra
delimiter.
If not specified, then Ada Configuration
options page opens with the default
options. User can select or over ride the
options in this page.

NOTE: If you create your Eclipse Workspace in a deeply nested subdirectory, you
will get an error while creating a project.
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ADA C/C++ Changer Configuration Options

On the Ada-C/C++ Changer Configuration Options page, you can set the following
configurations:

e C/C++ Output
e Ada Listings

e Ada Messages
e Ada Drivers

e Additional

NOTE 1: You can change the configuration options on the Ada-C/C++ Changer Property
Page. To go to the Ada C/C++ Changer Property Page, right click on the project and select
Properties>Ada Changer.

Ada Changer Options Configurations File: Ada Changer options are configurable via an
Option's file.
a. Once you have an AdaChanger project and you want to use the same options that
you have used.
b. Browse to the workspace directory location and into your project_name directory.
c. You will find a file called "options" file and you can save that file in a different
location (you can also rename it if you want) and use it again and again.
d. You can create new Ada Changer projects by passing the file info in the first screen.
Ada Changer reads this info and sets up the GUI configuration values accordingly.
e. This way you can create an option file and use it repeatedly as a template. However,
if you later want to modify these options after creating the project, you can select the
Ada Changer project and right click and choose Properties and select AdaChanger
Configurationpage and change. This will get stored as the new option file for that
project. This gives you the flexibility to use the template when you create the project
and also let you change if needed.
On C/C++ Output tab page, describe the C Source Options as shown in Figure 9_6.

Figure 9_6: C/C++ Output Page
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-~ Ada-C Changer Wizard

Configuration options

Set your configurations for Ada-C/C++ Changer tool

C/C++ output Ada listings Ada messages Ada drivers
Variable Naming
@ Full Unique Name
(O Simple Name is Unique

Case Sensitivity

O Asls

@ Identifier Capitalized
O All Lower

Remove Name Tables

Association
@) Place "{" and "}" on same line as associated construct

(O Place "{" and "}" on their own line

(O Generate exception handler code

Checks
Suppress language exceptions at runtime
Suppress numeric exceptions at runtime

Limit on the length of generated C source line | 80

‘/?\ < Back Next >

Additional

O =<

AP

Cancel

The field descriptions on C/C++ Output tab are as follows:
Table 9_2: Field Descriptions for C/C++ Output tab

Field Description Your Action

Specifies if you
want to select
variable naming.

Variable
Naming

You can do any one of the following:

e “Full Unique Name” means that the first
letter of each package
capitalized, as well as the first letter of
the simple identifier.

Note: By default, this is enabled.

e “Simple Name is Unique”
retains the original simple name.

name is

means it
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Specifies if you

You can do any one of the following:

o If “As Is” selected then it preserves the
original upper/lower case of the Ada
identifier.

o '"Identifier Capitalized" option means the
following depending on the “Variable
Naming” selection.

- If “Full Unique Name” option is
selected, then the first letter of the

g:::itivit want to select case names of each identifier and also the
y sensitivity. package is capitalized with rest of the
letters in lower case.
- If “Simple Name is Unique” option is
selected, then the first letter of the name
of each identifier is capitalized with rest
of the letters in lower case.
Note: By default, this is enabled.
e “All Lower" generates a C name that is
all lower case.
. ¢ "Remove name tables" means omit tables
Specifies if you ,
Remove necessary for <enum_type>'Image and
want to select \
Name <enum_type>'Value to work properly, as
remove name .
Tables tables well as full displayable names for
) exceptions and object tags.
You can do any one of the following:
e To place "{" and "}" on same line as
Specifies the associated construct, select the radio
Association | association button.
constructs. Note: By default, this is enabled.
e To place "{' and "}" on its own line, select
the radio button.
By defaultthe source code generated with
suppressed all exceptions.
fes if If the radio button ofGenerate Exception
Generate Specifies if you Handler Code is selected,then thesource
Exception v;ant to ger'le;ate code will begenerated with all exception
Handler the 00916 wit handler code.
exception handler . .
Code If not selected this option then the source

code.

code will be generated with suppressed all
exceptions.
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You can do any one of the following or both:
e If you want to do suppress language
exception at runtime, then select the
check box.
Specifies if you o If you want to do suppress numeric
want to select the exceptions checks (such as division
Checks . check and overflow  check) in
corresponding .
checks needed. generatedsource code at runtime, then
select the check box.
If you selected both then the language
exception and the numeric exceptions will
be suppressed at runtime.
Limit on Specifies the length
the length | of the line in the Enter a value to specify the length of the line
of the generated C Source | . .
‘ in the generated C Source files.
generated files. Note: The default value is 80
C Source You can change the ’ ’
Line length as required.

8. On Ada Listings tab, set your listing options as shown in the Figure 9_7.

Figure 9_7: Ada Listings Tab
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/) Ada-C Changer Wizard _ _ — Bl _X__

Configuration options A }

Set your configurations for Ada-C/C++ Changer tool

C/C++ output Ada listings Ada messages Ada drivers Additional |

Source listing

() Source listing only if errors
() Always produce source listing

Source listing format
Pagination
@ Continuous source listing
Paginated source listing

Page length | 66
Page width | 80

Cross reference listing
@) No cross reference listing

() Produce cross reference listing [l

@j MNext = [ Finish l [ Cancel l

The field descriptions on Ada Listings tab are as follows:

Table 9_3: Field Descriptions for Ada Listings tab

Field Description Your Action
Source Specifies how you You can do any one of the following:
Listing want the Ada

e To not to generate Ada source list,

source list to be select the radio button.

enerated or not.
& e To do Ada source list only if errors

are present, select the radio
button.
Note: By default, this is enabled.

e To always produce Ada source list,
select the radio button.

Source Listing Format
Pagination | Specifies the format
of the Source
Listing.

You can do any one of the following:

e For continuous source listing,
select the radio button.

Note: By default, this is enabled.

e For listing only of lines with errors
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or warnings, select the radio

button.

o For paginated source listing, select
the radio button.

Page Specifies the length | Enter a value for the length of the
Length of the page. page.

Note: By default, the value is 66.
P:-.Ege Specifies the width | Enter a value for the width of the page.
Width of the page. Note: By default, the value is 80.
Listing Specifies if you Select the check box.
only of want to list only
lines with | lines with errors or
errors or warnings
warnings
Cross Specifies if you You can do any one of the following:
Reference | want to generate a T ¢t N
Listing cross reference ¢ o no 0 generate  a  Cross

listing or not.

reference listing, select the radio
button.

Note: By default, this is enabled.

e To generate a cross reference
listing, select the radio button.
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9. On Ada Messages tab, set your message options as shown in Figure 9_8.

Figure 9_8: Ada Messages Tab

-

. Ada-C Changer Wizard

e

Configuration options

Set your configurations for Ada-C/C++ Changer tool

.

| C/C++ output Ada listings Ada messages Ada drivers

Additional |

Error messages
Error messages
Show errors in 'with-ed' files

Limit on number of error messages | 999

Warning messages

[¥] Warning messages

[] Show warnings in ‘'with-ed' files
Info messages

[ Info messages

[ ] Show infos in 'with-ed' files

Message format
(7)) Show given error message only once

@ Show message on each line it applies

<Back |  Next> | Finish

| [ e
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The field descriptions on Ada Messages tab are as follows:

Table 9_4: Field Descriptions for Ada Messages tab

Field Description Your Action
Error Specifies if you You can do any one of the following:
Messages | want to select error | T gelect error messages, select the
messages. check box.
Note: By default, this is enabled.
e To show error sin with “ed” files, select
the check box.
Limit on | Specifies the count | Enter a value to specify the limit on number
number of error messages. of error messages.
of error Note: By default, the value is 999.
messages
Warning | Specifies if you You can do any one of the following:
Messages | want to select e To select warning messages, select the
warning messages. check box.
Note: By default, this is enabled.
e To show warnings in with “ed” files,
select the check box.
Info Specifies if you You can do any one of the following:
Messages | want to select the « T lect inf lect the check
info messages. o select info messages, select the chec
box.
e To show information in with “ed” files,
select the check box.
Message | Specifies the format | you can do any one of the following:
Format of the message. .
e To show given error message only once,
select the radio button.
Note: By default, this is enabled.
e To show message on each line it applies,
select the radio button.
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10. On Ada Drivers tab, set your driver options as shown in Figure 9_9.

Figure 9_9: Ada Drivers Tab

. Ada-C Changer Wizard _ - L‘E‘é]

Configuration options A

Set your configurations for Ada-C/C++ Changer tool

C/C++ output Ada listings Ada messages Ada drivers Additional |

Mode

) Verbose
0 MNormal
) Quiet

@:l Next = [ Finish ] [ Cancel l

1]

The field descriptions for Ada driver options tab are as follows:

Table 9_5: Field Descriptions for Ada Drivers Options tab

Field Description Your Action

Mode Specifies the You can do any one of the following:
required mode for
reporting the
compiler actions.

e To select the verbose mode, select the
radio button.

e To select the normal mode, select the
radio button.
Note: By default, this is enabled.

e To select the quiet mode, select the radio
button.
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11. On Additional Options tab, set your miscellaneous options. You can also select the
multiple Ada source directories and click Next as shown inFigure 9_10.

Figure 9_10: Additional Options Tab

Ada-C Changer Wizard

Configuration options

Set your configurations for Ada-C/C++ Changer tool

(S -
Ap

| C/C++ output

Ada listings

Ada messages

Ada drivers

Additional L

[] Add GNAT Compatibility

Add POSIX Compatibility

Finish

l l Cancel ‘

The field descriptions for additional options tab are as follows:

Table 9_6: Field Descriptions for Additional Options tab

Field Description Your Action
Additional Specifies if you To specify additional options, select the
Options want to include any | check box and enter a value in the text

other additional box.

options such as

custom or optional.
Add GNAT Specifies if you To add GNAT compatibility, select the
Compatibility | want to add GNAT | check box.

Compatibility.
Add Specifies idfdyou This feature is disabled on Windows.
POSIX/LINUX | want to a On Linux, to add POSIX/LINUX
Compatibility | POSIX/LINUX S

o1 compatibility, select the check box.

Compatibility.

Note: This feature

is not supported on

Windows. It is

supported on Linux

only.
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12. On Select APIs Page, select the check box to enable the generated C Source Code
use Real-time OS Abstractor Scheduling,along with the corresponding interface
support from the available list and click Finish as shown inFigure 9_11.

NOTE 1: If Real-time OS Abstractor Scheduling is not chosen in the Ada-C/C++ Changer
Wizard,belowpage will be not be displayed

NOTE 2: Real-time OS Abstractor Scheduling allows you to migrate to multiple Operating
Systems and enable OS Abstractor Integration for this project after importing to AppCOE.

NOTE 3: If you have enabled the OS Abstractor APIs, you can any time enable the
additional development APIs after importing to AppCOE.

Figure 9_11: OS Abstractor Integration Page

Full Library Package Generator

Choose your current and/or developrment OS5 APls, Select next to continue,

<

0S5 Abstractor Interface
Linux/POSIX Interface

Nucleus Interface

Threadx Interface

VxWorks Interface

pSOS Interface

micro-ITRON Interface

Windows Interface

FreeRTOS Interface

U
U
U
U
U
U
U
U
U

uCOS-l Interface

Finish Cancel
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13. After successfully creating anAda C/C++ Changer project, a report page is displayed
as shown inFigure 9_12. Click Done to complete the process. The report gives
detailed information on the status of different activities in Ada to C source file

generation.

Figure 9_12: Ada-C Project Report Page

- e

Ada-C Project WizardProject Report

@ Displays status report regarding your Ada Project
License Check

Status:

Description:
License for Ada-C Changer is valid

Ada-C/C++ Changer
Status:

Description:
For more details see console view

@

14. You have now successfully created Ada-C/C++ Changer project.
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15. To view the C/C++ code, expand the project you have created as shown in the Figure
9_13.

Figure 9_13: Output for Ada-C/C++Changer

(7 Projects - Application Ci Operating Envi (AppCOE) Lo o e
File Edit Source Refactor Navigate Search Project Tools Run Window Help
- - 2 GOR ™S~ P . . - -

[r—
on'«u | &2 Profiler

 C/Ce » Projects
@
L demo_wtron -
C demo_vxworks
C demo_windows
C Sample_AppCOE_Project
+ 19 sudoku
& Induces
B 3dad(Cenr
nciude l
& nfo
4 (= source
< alleltabc
4 sutoku_testadb.c
L sudokuadbe =
o sudokuadsc

*. Problems © Console Properties il 2 Bvre

o xref
* Ug adaRoot
sl
sudokuadd
@2
sudokuads
« >33
. Suooky_testadb
config_pragmas.ada
w ADALIS
UNITMAP >

7 items selected
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Ada Changer project files

The Ada Changer project has the following files:

¢ Includes-This folder contains the header file paths of your project
e Ada2CC++-This folder contains all the files generated by Ada tools
= Ada Changer Project name-This folder contains the Ada Changer project
related files
¢ Include-This folder contains the Ada Include folder
¢ Info-This folder contains information file subdirectory of the program
library directory where information files for the object modules are placed.
e Source-This folder contains the converted C/C++ source files. If OS
Abstractor is integrated, then you get a folder, init, which contains the
AppCOE template files.

NOTE: For more information on the Template files, refer to AppCOE C/C++ Project
Template Files

Section in this manual

o xref-This folder contains the cross-referenced files which are generated by
the Ada tools

e adaRoot-This folder contains the Ada sources added during your project
creation. In case, you need to add or additional sources, you can do so in
Project > Property page >Ada Source tab of the respective project.

e ADA.LIB-This contains information describing the configuration of the Ada
library

e UNIT.MAP-This contains a unit-to-source mapping for use by the compiler
and program builder

e .options-This contains the list of options with which Ada ChangerProject or
executable is created. This is a hidden file. You can view this in Navigator
view. To view select Window > Show View > Other > General > Navigator.

NOTE: Host Libraries and include paths are automatically added during project creation.

For viewing this information, select Ada Changer Project > Properties > C/C++ Build >
Settings.
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Building Ada C/C++ Changer Projects

Ada C/C++ Changer enables you to build an existing project. This feature enables you to
either do an incremental full build or just a C/C++ Changer Build on your Ada 95 sources.

e The Build process will incrementally compile the Ada files that have been modified
or added since the last build.

NOTE: To do an incremental build, you should not do Clean.

o If any new Ada source files are added, removed, or modified in the project, and want
to generate the c-sources again, you can do a full build by first calling Clean and
then Build.

NOTE: Clean will delete all your info files, which will result in a full build.

e You cannot re-build if new directories are created or new files are added with
differing extension than what was provided during the project creation. If you have
new directories and new extensions, then you must recreate the Ada C/C++
Changer project.

e You will get a build error when you create an Ada C/C++ Changer project with the
default “—all” option for the Main Ada Procedure Name.

To do Ada C/C++ Changer Build do the following steps

1. To generate the corresponding executable, right click on the project you have
created on the projects pane, and select Build Project in project or from the main
menu select Projects>Build project as shown in Figure 9_14.

Figure 9_14: Build Project

File Edit Source Refactor MNavigate Saarch Project Run  Tools Window Help

B OOR DG B B 0 A it oo
5 %5 Debug (@ Profiler
B C/C++ Projects 52 = =5
=S
4 AIAdaju""'
+ ()l Incl Ll 4
4E9 Gt
4=
> | Open in New Window
>
al Tools »
Index 3
Build Configurations ,
Make Targets 3
| Build Project
4 (g ada Clean Project
s "
=| Copy
= Past:
s & aste
ADf ¥ Delete
=/ UNI Move...
Bl demoy g,
- ] demo_
. C] demo_t p45  Import..
> L] demo_| o4 Export..
[: demo_|
I demo_{ < Refresh
Ll demol  Close Project
> 7 deme
> 7 nucley Run As s
> 7 posiid Debug As 4
> C] psos_le Profile As y dle 52| I Properties | %7 Debug " @E‘ #E-rf-"8
3 it
C u\.mn_ Convert To...
> C win_Let en 4.020 i
Team 3 . N
) 19954-2010, SofCheck, Inc. B1l Rights Reserved.
Compare With * DE\Tools\Ada\windows\bin\adacgen.exe -key=89185fdal6d923abce377034e5604750 —
Restore from Local History... CE\Tools\Rda\windows\bin\adacgen.exe -key=89185fdal6dd23abce3T77034e56b4750 —
CE\Tools%\Ada\windows\bin\adacgen.exe -key=89185fdal6d9i23abce3T77034e5604750
Properties Alt+Enter e
] 1 3
o* /Ada_Sudoku
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The Ada C/C++ Changer project starts to build and generates the .exe file as shown
inFigure 9_15.

Figure 9_15: Building Ada-C/C++Changer project

Py
e Ede Souss Refectit Nevigste Sesrch Progect  Run  Took Window  Help

roe W DO ™A+ B-0-Qr 4~ v . . -
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‘ Ade_Sedoks

‘ demo_ada_to_c

i demo_cross oz

L semo_macleus

C semo_pesin

c demo_grics

r,: demo_ulron
demo_wrmoths (& Buikd Project l ig)
demog wrdowsy 20920 l—

c macleus_legacy Buikéng project

c' posic_legacy o

L pros_tegacy

[ witrom_legacy

) win_Legacy

Abwrys run o beckground |

{Run = B:&gvc\md‘ Cancel Detada »»

2 Problems B Consote 21 | [T
C-Build [Ade_Sudaku)
/windows/rtl . vindows
/vindows/rrl.vindows/sze
/windows/rtl.vindows/XIL

ce\Ada Sudoku\adalCCes\Ada Sudaku\incluode -00

h=0) -cadaCC++\Ada_Sudolna'\sot

Propertes. 35 Debug F_? IRt Brris™0O

-xn0 gned-char -fmessage-len

<« \8da2CCes\Ada Susoku\scuzce\sudoks.ads.c

/Ada Sudoku Build Preject: (16%) - |

NOTE: While running any Ada project after build, the project sometimes will again build the
project before running the application. To avoid this do the following configuration:

e Select Window > Preferences > Run/Debug >Launching.

e Under General Options, deselect the check box for Build (if required)
before launching flag.
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2. You can view the generated .exe file under the project in the Debug Folder as shown
in the Figure 9_16.

Figure 9_16: Generated .exe File
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NOTE 1: When you build Ada-C/C++ Changer project, you may get many warnings.
Target Code Generation for Ada C/C++ Changer Projects

AppCOE allows Target Code Generation for AdaC/C++ Changer Projects, when theAda-
C/C++Changer projects are created with Real-time OS Abstractor Scheduling or Ada-
C/C++Changer Scheduling.

For Ada C/C++ Changer Projects, OS Abstractor interfaces are added directly to the project
as target sources, if you have a valid and relevant Full Library Package Generator license.
If Target Code Generation is attempted on these projects, all the OS Abstractor
functionality, being part of application, is again redefined in cross_os.c. This will give re-
definition errors on compile time.

NOTE: For Ada-C/C++ changer projects along with Abstractor, if you do target code
generation, it will generate sample project files. You have to generate your own project files
to generate binaries.
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Manual Modifications to Projects files generated by Target Code Generator

The target code output produced when optimizing Ada projects via the target code
optimization process is a little different than that of the standard C/C++ AppCOE project.
In this case, the API level optimization process is skipped as the application needs to link-in
other required RTL C/C++ libraries and possible other ‘C’ interface libraries. Instead of the
OS Abstractor code being included as part of the application, it is added into the target
directory as a separate code base that should be built as libraries. There will be separate
libraries for the OS Abstractorcomponent as well as any other OS Interface components
(like VxWorks, Windows, etc.) included in the project. There will also be a separate Ada
Run Time Library(RTL) required to be linked in as well.

For example, if a converted Ada to C/C++ project that was integrated with OS Abstractor
and includes the POSIX/Linux Interface were optimized for a windows target it would look
like follows:

<target dir>
cross_os_windows
source
include
specific
posix interface
source
include
specific
include
include
rtl
XIL
src
IL
<app name>
adaz2C++
<app name>
source
include

The <target_dir> is the directory location where the generated code would be placed. The OS
Abstractor and OS AbstractorInterface directories will include project files specific to your
target. Project files for the RTL will only be included for Windows and Linux targets. On a
Windows target, you will get a project file for the Eclipse IDE and on Linux you will get both
Eclipse and make files. For all other targets and toolsets you will need to create an RTL
library project. An application project will be created for the target, but it will require some
manual modifications to build.

The modifications which need to be made to the application project are as follows:
Header Inclusion

Add include paths for the Ada RTL component.
<target dir>/rtl
<target dir>/rtl/src
<target dir>/rtl/IL

Add include path for any other 'C' library that you need for your
application

if your Ada project is integrated with OS Abstractor you will need to
add the following:
<target dir>/include/include
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<target dir>/cross_os_ <target>/include

Ada C/C++ Changer Property Page

AdaC/C++ Changer Property Page enables you to change or modify the configuration
options you have set for your project.

To go to the property page:

1. On AppCOE Projects pane, select the Ada C/C++ Changer project you have
created. Right click on it and select Properties and shown in the Figure 9_17.

Figure 9_17: Ada C/C++ Changer Properties
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2. The Ada C/C++ Changer property page is displayed as shown in the Figure
9_18, Make the necessary changes and click Apply.

3. To change the Main Procedure Name, on the AdaC/C++ Changer property page,
click on Additional tab, and make the necessary changes and click Apply.
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Figure 9_18: Ada C/C++ Changer Property Page

——— -
© Properties for NewAdaC == é
S —— W
type filter text Ada Changer S A
> Resource
Ada Changer | Ada Source C/C++ output | Ada listings | Ada messages Ada drivers | Additional L
Builders - .
C/Cor Build [] Additional options rer———
> C/C++ General
Project References
Run/Debug Settings Add GNAT C
Task Tags ompatibility
> Validation Add POSIX Compatibility
Ada Main Procedure hello_world
IRestore Defaultsl I Apply l
@J [ OK ] [ Cancel ]
4. When you do an Ada Build, you can re-import files, or import deleted files,

remove any files or change the Main procedure name on this page. You can
modify on any of the configurations on the property page.

NOTE: You cannot edit or modify the Ada Source Directory location.
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ADAC/C++ Changer — Additional Information’s

Warning messages

While importing an Ada project, you will receive 3617 warning messages. It appears that
most, if not all of them, are associated with the rtl files.

They are as follows:
e Defined but not used variables(3129)
e Return with no value, in function returning non-void (15)
e Assignment from incompatible pointer type (52)
e Comparison is always false due to limited range of data type (94)
e Cast from pointer to integer of different size (3)
e Comparison of distinct pointer types lacks a cast (8)
e Control reaches end of non-void function (71)
e Implicit declaration of function (10)
e Initialization from incompatible pointer type (5)
o Integer constant is so large that it is unsigned (1)
e Left shift count >= width type (1)
e Missing braces around initializer (2)
e Passing arg from incompatible pointer type (114)
e Statement with no effect (28)
e Unused variable (83)
e This decimal constant is unsigned only in ISO C90 (1)

NOTE: When you are working on 64bit architecture, make sure that -m32 flag is added to
both the compiler and linker options in project properties to avoid compilation errors.

\PUS Q‘ FT 263




S@ F.I:Application Common Operating Environment User Manual

Additional Ada C/C++ Changer Tools
Ada C/C++ Changer is equipped with following additional tools:

1. Ada Line Count - This feature enables you to count the Ada lines of code with a simple
program. It just takes a list of file names, and prints out the number of lines of Ada
source code, lines of comments, and blank lines, counting lines of code the same way
the license checker counts them.

The application name is: “ada_line_count.exe”. You have to run this .exe in cmd
prompt.

Command: ada_line count filel file2 file3...

2. POSIX ADA Support (For Linux only) -- Ada C/C++ Changer toolsnow give support to
POSIX. You have a separate library with POSIX Ada packages, for Linux only. To make
this "linked library" available to a given user, the adaopts command:

Command: adaopts -p /usr/local/AppCOE/Tools/Ada/linux/posix_ada
will link the posix-ada library into the "search path" for the current library.

3. Ada Support for GNAT compatibility compiler — This feature enables you to link the
"gnat compatibility” library into the search path for the currentlibrary. The following
commands are used to link:

Linux Command: adaopts -p /usr/local/AppCOE/Tools/Ada/linux/gnat_compat

Windows Command: adaopts -p
C:\Mapusoft\AppCOE\Tools\Ada\windows\gnat_compat

4. Ada Support for Win32 - This feature enables support for Ada on Win32 host. The
following command is used for the "win32ada" library:

Windows Command: adaopts -p C:\Mapusoft\AppCOE\Tools\Ada\windows\win32ada

S. For Ada C/C++Changer project, from Properties page if you change Ada Main
procedure, it will not build the project with that procedure immediately. You need to
select the project and refresh 1-2 times and clean the project and then do the build.

Note: On Linux HOST/Environment, you may need to set View/Modify permissions to the
Tools folder while creating a project. If the AppCOE installer did not set View/Modify
permissions, please follow the below steps to do this.

To set View/Modify permissions:
e Go to the Tools folder.
e Right click on the Tools folder, and select Properties>Permissions.
e Change the required permissions.

Then provide executable permissions to files under [tools/Ada/linux/bin] folder before
creating any Ada project. Otherwise it will give an AppCOE exception while trying to convert
Ada to C using Ada-C/C++Changer Options.

To change executable permissions:
e Go to Terminal/Command window.

e Go to the  respective folder location by cd  AppCOE Source
directory/Tools/Ada/Linux/bin.

e Once you are in “bin” folder, run the command like <chmod 777 *>
e Now observe files changes color from black to green.
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© Copyright 2021 MapusSoft Technologies, Inc. - All Rights Reserved

The information contained herein is subject to change without notice. The materials located on the
Mapusoft. ("MapuSoft”) web site are protected by copyright, trademark and other forms of proprietary

265




!
S@ F.I:Application Common Operating Environment User Manual

rights and are owned or controlled by MapuSoft or the party credited as the provider of the
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MapuSoft retains all copyrights and other property rights in all text, graphic images, and software
owned by MapuSoft and hereby authorizes you to electronically copy documents published herein
solely for the purpose of reviewing the information.

You may not alter any files in this document for advertisement, or print the information contained
herein, without prior written permission from MapuSoft.

MapuSoft assumes no responsibility for errors or omissions in this publication or other documents
which are referenced by or linked to this publication. This publication could include technical or other
inaccuracies, and not all products or services referenced herein are available in all areas. MapuSoft
assumes no responsibility to you or any third party for the consequences of an error or omissions.
The information on this web site is periodically updated and may change without notice.

This product includes the software with the following trademarks:

MS-DOS is a trademark of Microsoft Corporation.

UNIX is a trademark of X/Open.

IBM PC is a trademark of International Business Machines, Inc.

Nucleus PLUS and Nucleus NET are registered trademarks of Mentor Graphics Corporation.
Linux is a registered trademark of Linus Torvald.

VxWorks and pSOS are registered trademarks of Wind River Systems.

uC/OS is a registered trademark of Micrium Inc.

FreeRTOS is a registered trademark of Real Time Engineers Ltd.
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